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Preface

Preface

Thank you for purchasing your Topcon receiver, survey product or
accessory (the “Product”). The materials available in this manual (the
“Manual”) have been prepared by Topcon Positioning Systems, Inc.
(“TPS”) for owners of Topcon products. This Manual is designed to
assist owners with the use of software (the “Software”) to be used
with the Product and its use is subject to these terms and conditions
(the “Terms and Conditions”).

@ Please read these Terms and Conditions carefully.

Terms and Conditions

USE This product is designed to be used by a professional. The user
should have a good knowledge of the safe use of the product and
implement the types of safety procedures recommended by the local
government protection agency for both private use and commercial
job sites.

COPYRIGHT All information contained in this Manual is the
intellectual property of, and copyrighted material of TPS. All rights
are reserved. You may not use, access, copy, store, display, create
derivative works of, sell, modify, publish, distribute, or allow any
third party access to, any graphics, content, information or data in this
Manual without TPS’ express written consent and may only use such
information for the care and operation of your receiver. The
information and data in this Manual are a valuable asset of TPS and
are developed by the expenditure of considerable work, time and
money, and are the result of original selection, coordination and
arrangement by TPS.
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TRADEMARKS Topcon®, HiPer®, TopSURV™, Topcon Link™,
Topcon Tools™, and Topcon Positioning Systems™ are trademarks
or registered trademarks of TPS. Windows® and ActiveSync® are
registered trademarks of Microsoft Corporation. Bluetooth® is a
registered trademark owned by Bluetooth SIG, Inc. and is used by
Topcon Positioning Systems, Inc. under license. Sokkia Corporation
and the names of Sokkia Corporation products referenced herein are
either trademarks or registered trademarks of Sokkia Corporation.
Satel is a trademark of Satel, Oy. Other product and company names
mentioned herein may be trademarks of their respective owners.

DISCLAIMER OF WARRANTY EXCEPT FOR ANY
WARRANTIES IN AN APPENDIX OR A WARRANTY CARD
ACCOMPANYING THE PRODUCT, THIS MANUAL AND THE
RECEIVER ARE PROVIDED “AS-IS.” THERE ARE NO OTHER
WARRANTIES. TPS DISCLAIMS ANY IMPLIED WARRANTY
OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR
USE OR PURPOSE. TPS AND ITS DISTRIBUTORS SHALL NOT
BE LIABLE FOR TECHNICAL OR EDITORIAL ERRORS OR
OMISSIONS CONTAINED HEREIN; NOR FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES RESULTING FROM THE
FURNISHING, PERFORMANCE OR USE OF THIS MATERIAL
OR THE RECEIVER. SUCH DISCLAIMED DAMAGES
INCLUDE BUT ARE NOT LIMITED TO LOSS OF TIME, LOSS
OR DESTRUCTION OF DATA, LOSS OF PROFIT, SAVINGS OR
REVENUE, OR LOSS OF THE PRODUCT’S USE. IN ADDITION
TPS IS NOT RESPONSIBLE OR LIABLE FOR DAMAGES OR
COSTS INCURRED IN CONNECTION WITH OBTAINING
SUBSTITUTE PRODUCTS OR SOFTWARE, CLAIMS BY
OTHERS, INCONVENIENCE, OR ANY OTHER COSTS. IN ANY
EVENT, TPS SHALL HAVE NO LIABILITY FOR DAMAGES OR
OTHERWISE TO YOU OR ANY OTHER PERSON OR ENTITY
IN EXCESS OF THE PURCHASE PRICE FOR THE RECEIVER.

LICENSE AGREEMENT Use of any computer programs or software
supplied by TPS or downloaded from a TPS website (the “Software”)
in connection with the receiver constitutes acceptance of these Terms
and Conditions in this Manual and an agreement to abide by these

Terms and Conditions. The user is granted a personal, non-exclusive,

X TopSURYV User’s Manual



Terms and Conditions

non-transferable license to use such Software under the terms stated
herein and in any case only with a single receiver or single computer.
You may not assign or transfer the Software or this license without
the express written consent of TPS. This license is effective until
terminated. You may terminate the license at any time by destroying
the Software and Manual. TPS may terminate the license if you fail to
comply with any of the Terms or Conditions. You agree to destroy the
Software and manual upon termination of your use of the receiver. All
ownership, copyright and other intellectual property rights in and to
the Software belong to TPS. If these license terms are not acceptable,
return any unused software and manual.

CONFIDENTIALITY This Manual, its contents and the Software
(collectively, the “Confidential Information”) are the confidential and
proprietary information of TPS. You agree to treat TPS’ Confidential
Information with a degree of care no less stringent that the degree of
care you would use in safeguarding your own most valuable trade
secrets. Nothing in this paragraph shall restrict you from disclosing
Confidential Information to your employees as may be necessary or
appropriate to operate or care for the receiver. Such employees must
also keep the Confidentiality Information confidential. In the event you
become legally compelled to disclose any of the Confidential
Information, you shall give TPS immediate notice so that it may seek a
protective order or other appropriate remedy.

WEBSITE; OTHER STATEMENTS No statement contained at the
TPS website (or any other website) or in any other advertisements or
TPS literature or made by an employee or independent contractor of
TPS modifies these Terms and Conditions (including the Software
license, warranty and limitation of liability).

SAFETY Improper use of the receiver can lead to injury to persons or
property and/or malfunction of the product. The receiver should only
be repaired by authorized TPS warranty service centers. Users should
review and heed the safety warnings in an Appendix.

MISCELLANEOUS The above Terms and Conditions may be
amended, modified, superseded, or canceled, at any time by TPS. The
above Terms and Conditions will be governed by, and construed in
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accordance with, the laws of the State of California, without reference
to conflict of laws.

Manual Conventions

This manual uses the following conventions:

Example Description

File » Exit Tap the File menu and tap Exit.

Enter Indicates the button or key labeled Enter.

Topo Indicates the name of a dialog box or screen.
Notes Indicates a field on a dialog box or screen, or a tab

within a dialog box or screen.

Supplementary information that can help you
configure, maintain, or set up a system.

on system operation, system performance,

@ Supplementary information that can have an affect
measurements, personal safety.
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What's New

What's New with
TopSURV

The chapter briefly describes new features and functions for version 8
of TopSURV.

Connection Settings = R
Connection settings are now available on Device |
1 1 Salact davice hpe...
selecting observation mode. For GPS Py < —
mode you are able select the Base or Qs @hover
Rover receiver to work. O -
W L ——
[+ Promgpst at <tartup
| Connect
Default Code Library = — =
Default Code Library is now installed Ty [ A () -
and set to the Global Code library. e Ly e e
(2] (=) & m)
Voving Arrow on Map
Moving arrow now denotes the current Te—m -
position on the map. A _;}
=]
[®)
i) 3
€]
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What’s New with TopSURV

Sokkia Equipment
Sokkia equipment is now supported.

Recelver Model [GSR2700 15X«
Elevation Mask
RTE Format

Antenna |SOK GSR2700 15X w

AntHU [gooo usi =

Gt = |#
Peripherals| | << Hack || Next >

Canopy Environment

Setting the receiver in “forest” mode is
now supported.

Sal System  [GPSGLONASS »
|v] Mudtipath Reduction

[[] co-0p Tracking

|| Canopy Environment

RTK Position  [Fatrapulation w
Dase Station Make

[<Automatic Dutuction> o)

Automatic Start UHF Radio

Automatic start UHF radio is added to
Start Base. Selecting frequency is now
available on the status string.

Y -

H v @
200 BI0N 1.3

wtm{m)
Point.

g
w FEmesr B
P

Lon *00D0.00000"
et [from
Ant HE p.LILD viertical s

@) stet v .

Ready
LoCmode 1=
Satel PCC mode is optional now. —
Charnel R |
Fmmm
P Mo POC -
FEC Mot wee hd
(e J[wi>s ]

Xiv
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What’s New with TopSURV

Web Address

NTRIP connection can now be set up
based on web address instead of IP
address for controller-side Internet
connection.

rtiarart Info

Address: 190.232.110.132:0067
M

Dkt [ s cuRDy
ccBack || Nont 3>

Network Connections

Topcon GR-5 receiver is now supported.

Auto-connection to Network is optional, Do | HEEWSrE |
and auto-disconnection from Mount
Point on disconnecting from receiver is [ At Coreust
now added.
[ check siandl qualey
[#] it Deconnnct
GR-5 Receiver ————

Recetver Model | ETCTINNN ~
BevatonMask  [12 g
AT Format BEED =
Antenna [GRS -
ANt HL -
i fom _m
Verted = N

Perphards || << Back || Mext »>

DL-502/503 Digital Levels

Topcon digital levels DL-502 and DL-
503 are now supported.

Manufacturer | Topcon »

Modal

= vetrument FAE
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What’s New with TopSURV

Localization
Localizations based on user-selected ]
. . 100 _joc 101 0.011 2
projection/datum are now supported. ke o ME X
< >
Type [ |
[ Keep scale 1.000
Add
Dataks
SurvCE Code Library
SurvCE code library is now supported for Data
import/export. e
Ment 2
Text Size in DXF/DWG m
Text size can now be manually/ Point stye:
automatically set in exported DXF/DWG fputocaD Pors with Taa el 8
files.
[#] Use 30 coondnates
s et ot
F capumitis)
TP3 Import/Export
Topcon machine control project file is uata
now supported for import/export. e
[ropcen somc ot =iz
LRQH! Filr Urits
|| selace Types OF The Ponts
[0 e Fitiors
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What’s New with TopSURV

High/Low Positions

High/low positions can be computed now
for the Grade and Station option in
Vertical Alignment.

2 High/Low Pasitions

Alnt Name: Verl

Named Segments

B EAE
The segn.lents are stored now as Named smtp
segment instead of a Code being created
for each segment. o I
ﬁ.cﬂj m
& [ oo |
P m
rin, n rkin rridor _—
St-l g Sets and Wo 1gC0 ido
String Sets as an alternative method for | rbgrnen | St |
defining a road surface, and Working B (stomg set ) FEE
corridor are now supported. L
Wik Coricker
Left [so:u— m
e rrrr—

Stake Reports

Stake reports are now supported to be set
for stakeout.

IL:_H v -1

0201 040 L0+3
4 D Point
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What’s New with TopSURV

Lineworks From Map

Ability to stakeout Linework created
from Map, and to stop at transition points
is now supported.

]
(2] | _ln.lulln'w 1‘.—. 10 ryi

85 ﬁcm m
Ant HE W m
virtcadl s

[w] archahx Trareation Pont

e e ]

Lineworks By Code Strings
Selecting Lineworks for stakeout by
either Line or Code/String is now
supported.

55 W m
At Hi W
[ =
[i] Irchchx Trareation Pont
Stake Report . -
ok St L. ]| ne

Real-Time Stakeout of Lineworks
Ability to do Station (interval) or Real-
Time stakeout of a linework, and ability
to add horizontal and vertical offsets are
now supported.

= ttion & ottt

O [rasime |

O [Chight Offsat_|.500 m
o
Brgi Ponts Cffeant © w

Curve Points Offsat

User Definable Labels

Editing any of four labels for showing
any live value on all graphical views for
stakeout is now supported. Just click on
one of them to change.

a5~ EAEd

Shakeoul Vs

[T e Mastrmam Tt Hiight
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What’s New with TopSURV

Cross Section Segment Highlighted
The cross section segment at the rod
position is highlighted, and cut/fill and &y
offset to two segment points are reported. ;=
®

Cut 5Fa 0,924
Cut 5Fb 0,954
Offs SPa L 0.099
offs SPh R 6.0

Vertical/Perpendicular Offsets

Vertical or perpendicular offset can now
be defined for Intersect Left/Right. B suimed [oooom  (gH)

st Pt JL [ (2
o [ might offeet |2000 m Eﬁ!
o [Upom Jpmnm [

it Lot s
Te—im
ANVZE N4
| <= Back J Staka
Store Point Information =
Store point information now include Stk | Cock | ot | Data |
Stake, Code and Note for setting L—.%‘ e
properties of the staked point to be el
. . . Stake 95623
stored, and Design for setting properties stake 122
. . St Bl 1.967
of the calculated design point, when qenn s
applicable. o e
:..: U726 13 =
] acvarca
Store Catch /Offset Point =
When storing the Catch Point / Offset ['Stake | Code | Mote | Dita [Desgn |
. — =
Point, an offset can be selected on the D"‘;":u?fm l’;':g |
Data tab. Also references can be set for pEmen Rnew
I . . Eatord Gracky
additional repoting options. RO, R
P Hevation 157,000
Bl Dot 0993
R OMs to L 1.651
shwcL 1927
HO to P-CL L6340
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What’s New with TopSURV

Linework for Ar ————
ew_o -0 COGO _ea T e
Selecting Linework/Area is now sres [t i |
supported for computing Area task. Poriirt_ [Pt
PoardLEL E
Linework Ijb
Areg | —
TEraran: | Fowm
#8 DRANL
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< >
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Volumes = vk
Now two DTM files can be selected to OTM [t |
get a volume report. @ o B (8]
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Chapter 1

Introduction

TopSURY is Topcon’s survey software available for hand-held
controllers. TopSURYV is used for surveying, common layout, and GIS
purposes including:

* Field data collection with Topcon and Sokkia GPS receivers;
Topcon, Sokkia, Nikon and Leica Total Stations; and Topcon and
Sokkia Digital Levels

» Roads design to create cross section templates, horizontal, and
vertical alignments

* Stakeout designed objects
» Data conversions to a variety of file formats
COGQO calculations

TopSURY installs on hand-held controllers that run Windows® CE or
Windows Mobile operating system, such as Topcon’s FC-25,
FC-250, FC-2200, FC-2500, FC-200 and the integrated

controller of GMS-2, GMS-2 Pro and GRS-1.

Topcon Link PC software is included on CD with TopSURV
providing data integration with your current office software.

Also, TopSURV for Microsoft Windows compatible PCs with
Windows® XP OS or higher is available from Topcon website. It will
operate in a ‘demonstration’ mode, allowing 25 points to be added to
a job. To fully activate, a separate license must be purchased.

The given manual describes features of TopSURYV ver.8 installed on a
Topcon field controller using screenshots mainly obtained with the
help of FC-200 controller.
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Introduction

TopSURYV on Controller

The TopSURY setup file will first be loaded onto a computer. To
install TopSURYV onto the controller, use ActiveSync and a
connection between the computer and the controller receiving the
software download.

Microsoft® ActiveSync® must be installed on the
computer before installing TopSURV.

website. (For downloading, access the website
http://www.microsoft.com/windowsmobile/).

‘i ; i ActiveSync is available for free from the Microsoft

System Requirements

Minimum system requirements for controllers include:

1. Display 240x320 or 320x240 pixels,
2. 64 MB RAM and 50 MB flash disk space (internal),

3. Windows® CE.NET Version 4.2 or higher, or Windows®
Mobile Version 6.2 or higher.

ActiveSync

Using ActiveSync, the controller can exchange data to a computer via
USB cable.
1. Install ActiveSync in the computer and turn on the controller.
2. Connect the controller to the computer with the USB cable.
3. The controller will give the prompt, Connecting to Host.
4

The computer will prompt to set up a partnership or set up as a
guest. Select the desired type of connection.

5. Once a connection has been established, the ActiveSync
window will display on the computer.
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TopSURYV on Controller

Installing TopSURV

Use the steps below to install TopSURV onto the computer and
controller.

1. Download or copy an appropriate for your controller TopSURV
installation file to the computer.

2. Connect the controller to the computer by USB/Serial Cable
using Active Sync.

3. On the controller, move the slider bar in Control Panel/System/
Memory to the right to allow more storage memory for copied
files. Leave only about 2MB for the program memory.

4. Click TopSURY installation file on your computer.
The Welcome screen displays (Figure 1-1).

Figure 1-1. Welcome Screen

5. After detecting device information, if TopSURYV is already
installed, the Maintenance wizard prompts to remove the
previous installation of TopSURV from your computer
(Figure 1-2 on page 1-4). Click OK.

TopSURYV will NOT be removed from the
controller.
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Introduction

Figure 1-2. Confirm Uninstall

6. Once the previous TopSURY installation is removed, double
click TopSURY installation file again.

7. Review the License Agreement (Figure 1-3).

Figure 1-3. License Agreement

* To accept the terms and continue, click the “I accept...” radio
button and click Next.

* To decline the terms and quit installing TopSURY, click the “I do
not accept...” radio button and click Next. The InstallShield
Wizard will close and TopSURV will not install onto the
computer or controller.
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TopSURYV on Controller

8. Select the features to install (Figure 1-4) and click Next.

Figure 1-4. Select Features to Install

The following files can be installed on the controller during
TopSURY installation by making the appropriate file selection:

* Projection Files: UK OSTNO2, Belgium, Netherlands
RDNAPTRANS(TM), Netherlands RDNAPTRANS(TM)-2004,
Netherlands RDNAPTRANS(TM)-2008, Hungary VITEL,
Hungary VITEL 2009, Czech, Romania. These files are copied
into the Geo/TabProjections folder under the TopSURY folder on
the controller.

¢ Geoid Files: UK, Netherlands, Canada (CGG2000 East/West/
North; HT2_0), Dutch 2004, Dutch 2008, Belgium, France
(French, French Corsica), Northern Ireland, Spain
(Catalonia(WGS84), Catalonia(ED50)), Hungary, Lithuania,
Latvia, Republic of Ireland, Portugal. These files are copied into
the Geoids folder under the TopSURYV folder on the controller.

* Import/Export: Support for Import DWG2008 and for Import
Project file associated with imported Shape File.

9. Then the device information will be detected. If the controller is
disconnected from the computer, the following message
displays.
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Topcon Positioning Systems

'E Unable to connect to contraller!
L

Fleaze check it iz connected and by again

Fietry I Cancel |

Figure 1-5. Unable to connect to the controller

10. The wizard will begin the installation process. Click Install to
begin (Figure 1-6).

Figure 1-6. Select Device

During the setup process, installation files are copied to the
appropriate directories in your computer for ActiveSync to access.

Once finished, TopSURYV installation accesses ActiveSync and
launches Add/Remove Programs to install TopSURYV in the controller
(Figure 1-7).
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TopSURYV on Controller

Figure 1-7. Setup Status

ActiveSync starts the Add/Remove Programs process, which
automatically detects an available installation and attempts to install it
on the controller (Figure 1-8 on page 1-7).

Applications Already Installed

"TPS TopSURY" iz already installed. Do you want to proceed with the re-install/upgrade?

es Mo |

Figure 1-8. Data Retrieved From Mobile Device

11. Click Yes at the Installing Applications screen (Figure 1-9) to
install TopSURYV into the default directory in the controller.

Installing Applications x|

Install "TPS TopSURW" uging the default application install directary?

es Mo | Cancel |

Figure 1-9. Installing TopSURV

12. If the controller main memory does not have space available to
copy the installation file, a prompt will display to select other
destination media (Figure 1-10).
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Select Destination Media %]

Save In:

Space required: 36,2309 K
Space available: 40297 K
()8 I Cancel |

Figure 1-10. Select Destination Media

Not to change the destination media, you can try
@ moving the slider bar in Control Panel/System/

Memory to the most right position.

13. ActiveSync will copy the installation file (CAB file) from the
computer to the controller.

Installing Applications

Installing TPS TopSURY...

[

Figure 1-11. Installation Complete

14. Once the transfer completes, the PC installation program first
copies the TopSURYV program files into the controller. Follow
the steps indicated on the controller’s screen to complete
TopSURYV installation.

Application Downloading Complete

Fleaze check your mobile device screen to see if additional steps are neceszary to complete this installation.

Figure 1-12. Check Mobile Device
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TopSURYV on Controller

15. After this step, the following message is displayed on the PC
screen indicating that the selected features will be installed on
the controller (Figure 1-13).

TopSURY - InstallShield Wizard x|

.
\!‘) To Continue with inztalling the remaining files, pleaze press OK after the Program iz installed on the CE Device

Figure 1-13. Install Remaining Files

16. Click OK to this message after the progress bar on the
controller screen (Figure 1-14) disappears.

age Carch, TPS TopSURYY tpsLevel.dil

Cancel

£7 [1nstallin... |®s§> 11:52 AM |@ |‘%

Figure 1-14. Copy TopSURYV Files to Controller

The progress bar indicates that the TopSURYV program files are being
copied to the controller prior to copying the selected feature files.

17. After clicking OK to the message on the PC screen
(Figure 1-13), the installation program starts copying the
selected feature files into corresponding folders under the
TopSURYV folder on the controller.

This will take a few minutes, as the following message is displayed on
the PC indicating that the files installation is in progress.
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Copying files to Controller x|

Installing files to device, Copying file: ostnD2,prij

Cancel

Figure 1-15. Copying Feature Files onto Controller

18. The Setup Status screen displays to configure software
installation. When finished, the InstallSheild Wizard Complete
screen displays (Figure 1-16).

Click Finish to exit the install program.

Figure 1-16. Install Finish

19. Once the installation completes, the TopSURYV icon will display
on the controller screen to start TopSURV.

Before starting TopSURYV, move the slider bar in

@ Control Panel/System/Memory to the most left
position to allow more program memory for
TopSURV to work properly.
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Starting TopSURV

Uninstalling TopSURV

The Remove Programs tool in Windows CE or through the Add/
Remove Programs tool in ActiveSync both uninstall (remove)
TopSURYV from the controller.

recommended before installing a software upgrade.

‘i ; i Removing TopSURYV from the controller is
Be sure to save all necessary job files first.

Starting TopSURV

To start TopSURY, tap the TopSURYV icon on the controller screen
and then press the Enter button. Upon initial startup, TopSURV
requires an access code to run (Figure 1-17). Contact a Topcon
representative to acquire the necessary codes.

* Key Value — the identification number of the device; record to give
to a Topcon representative.

* Activation IDs — the fields in which to enter the security codes
received from a Topcon representative to activate either one or
more of the following purchased modes: TS, Contractor, Robotic,
GPS+, GIS (RT DGPS and PP DGPS), Roads, and mmGPS.

ey EAER
Key Value I322l]6l]2745

Activation IDs

Optical I—
Robotic
GP5+

GIs [
Roads I—
mmGPS [

Figure 1-17. Security
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Once entered, the access codes are stored in the secstore file in the
hidden tsv_setup folder in the internal storage of the controller where
TPS folder resides. To view existing codes or add a new code, tap the
Topcon Logo Help Icon in the top-left corner of the screen and
select the Activate Modules option.

to TopSURYV 7, the updated security key is required
to complete the installation of this upgrade.

For help in acquiring this security key, contact
topsurv_updates @topcon.com.

@ If upgrading existing TopSURYV of previous version

Demo Mode

Upon initial startup, a Demo version of TopSURYV is accessible after
tapping either the ok [./ ] button or the cancel button on the
Security screen. To run the demo version, tap Close on the warning
message that displays

(Figure 1-18).

! Security not enabled for

% GPS Mode! The contraller
will run in Derno Mode with
limited functionality!

Close

Figure 1-18. Access to Demo

A full-featured demo version of TopSURYV will be available with
operational data limited. This demo version can store up to 25
surveyed points and roads of 100 meters in length.
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Chapter 2

Getting Started

TopSURY initially creates a Default job upon program installation.
By default, all jobs are stored in the Job folder of the TopSURV
directory (Figure 2-1).

E Cpen Job

v
Created:  02§25f2010 12:08
Modified:  09f06f2010 08:53
3 \.. ATPS\TopSURV 1obs

[t | [ new ] owse ][ open |

Figure 2-1. Open Job

* Open - makes the selected job current, and after performing
appropriate connections (see “Connections” on page 2-2) opens
the main screen (see Figure 2-9 on page 2-7).

* Pressing the ok [./ ] button after selecting a job is analogous to
using the Open button.

* New — press to create a new job (see Chapter 4 on page 4-1).
 Exit — quits the program.

* Browse — press to display browse directories to navigate to a

desired job. Highlight the file and press the ok [ ./ ] button to
open the job from a remote directory (Figure 2-2 on page 2-2).
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Getting Started

Type |Jl:lb Files (*.tsj) »
\Storage Card\TPS

5

[[:ISukkia GRX Utility

((1TopSURV
eworks.tsj

Name |Iinewc|rks.tsj

Figure 2-2. Open Existing Job

Connections

When opening a job, the Connections dialog displays by default
(Figure 2-3 on page 2-3).

1.

On the Device tab:

Select either the GPS or Optical type of device and the job style
to work at the site.

Select either Base or Rover when working with the base receiver
or the rover receiver in RTK surveys, respectively.

Check mark the Bluetooth box to enable Bluetooth connection
with the device on the selected communication port.

The Prompt at startup box is checked by default. Uncheck the
box if you want to enable auto-connection with the device and not
to display the Connections dialog again.

Press the Connect button to establish the connection selected.
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Connections

E Connections

Device

Select device type...

@ ars

(OBase (@) Raver
(O optical IMy Corvertional
[]Bluetooth |cor~f|5

Prompt: at startup
| Connect ]

Figure 2-3. Prompt for Connection at Startup

2. On the Network tab that displays for job configurations to work
in a network (Figure 2-4):

Auto-Connect

[]check signal quality

Auto-Disconnect

Figure 2-4. Network Connection

¢ Check mark the Auto-Connect box to enable automatic
connection with the modem.

* Check mark the Check signal quality box to enable checking
quality of the signal.

* Check mark the Auto-Disconnect box to enable disconnecting
from the modem on exiting TopSURV.
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Getting Started

Transfering Job Files

Starting from version 7, TopSURYV job’s files are made universal for
using on controllers and personal computers. They have the tsj
extension and need no conversion. You can transfer the *.tsj files
between Windows CE and Windows PC databases directly without
format changes using:

* A flash memory card and the PC card reader.

» Copy/paste procedure and ActiveSync connection.

to copy these folders from the directory where the
job resides. The copied job will work correctly but
the previous job history will be lost.

% If the job has photo notes and the job history, be sure

* Topcon Link conversion utility installed on the PC and
ActiveSync connection.

» Topcon Tools data processing software installed on the PC and
ActiveSync connection.

TopSURYV PC installed on the PC through import/export
procedure from/to the Device and ActiveSync connection.

Opening Old Jobs

To open a job created in TopSURYV version 6.11.03 and earlier, click
Job » Open Job and tap the Browse button in the Open Job screen
(Figure 2-2 on page 2-2). Then select the Ts6 Job Files (*.tsv) type,
navigate to the desired tsv job, highlight it, and press the ok [/ ]
button (Figure 2-5).
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Job

w [

Opening Old Jobs

Type |T56 Job Files (*.ts¥) »
Open Job \Storage Card\Archive

A || T | 5

KRISHA.tsv
ROAD.tsy

Name |3r|:|a|:|.tsv

Figure 2-5. Open Old Job

Tapping the ok [/ ] button starts upgrading the job. Tap the Cancel
button to abort upgrading (Figure 2-6).

Elub Upgrade Progress |

Preparing to Upgrade...

Cancel

Figure 2-6. Job Upgrade Progress

When the process is complete, the Cancel button turns into the Done
button, which opens the main screen for the upgraded job.

After pressing the Done button, the *.tsv file turns into the *.tsj file
and the Archive folder is created in the directory where the *.tsv file
was located. This folder stores the .£sv jobs. If the job had a job
history, a directory using the same name as the job, is also created to

store the *.xml file with the job history (Figure 2-7).
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Fle Edit View Go | |l§? X
4 9 T mR=0

arne | Size | Type
Ciarad | File Foidler
) Archive File Folder

# Jroad.ts) 885KE  TopSury Job
F Default.ts) S86KE  TopSury Job
< >

Figure 2-7. Upgraded Jobs

Automatic Job Backups

To increase the reliability of work with jobs in TopSURY, a backup
copy is automatically created of the current job. This automatic
renewal occurs about every ten minutes and is safely stored with a
new name, i.e., file_name!YYY-MM-DD!.tsj.bak in a folder where the
original *.tsj file is located.

TopSURYV will create a separate *.bak file for the current job every
time the user opens the *.tsj file during the day with another date, but
there cannot be more than three such files. If the *.tsj file is opened in
subsequent days, the *.bak files previously formed will be overwritten
to the ones with the newer dates.

You can change the folder for saving backup copies:

¢ Tap the Configure » Backup icons. The Job Backups screen
displays.

* Check mark the Use custom box to activate a field below. Either
type in a backup target folder or select it.

» The History box shows how many last copies will be daily
created (three copies by default).
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Main Screen

Backup target

g — [T

Backu
a E Use custom

[Storage Card/TPS/TopSUR] |7

History EI

Figure 2-8. Job Backups

If, for any reason, there is a problem with opening the original *.tsj
file in TopSURY, Topcon Tools, or Topcon Link, you can rename the
latest *.bak file to the *.tsj file and try to open the renamed file.

Main Screen

TopSURYV main screen opens to work in the current job (Figure 2-9).

Ewsn 56 E
['_}==‘ -5 Lef
Gl i -0
Job Configure Import
ri’j g
£% &\’ Y = ?
Export Edit Job Edit Roads
Setup Survey Stake
= {
et v .
a4 v
o v T
OGO Map Connections
Job

Figure 2-9. TopSURV Main Screen
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Getting Started

user interface: Icon-based and List-based. By
default, the Icon-based interface is open.

To toggle between the Icon and List Menus, tap the
Topcon Logo Help Icon in the top-left corner of
the screen and select the Switch Menus option.

@ TopSURYV has two implementations of graphical

T d @

Open
MNew
Delete
Config »
Irnport »
Expart »
Info
Mode

Exit

EE=E@=p

1080

Figure 2-10. List Menu

Title Bar

The title bar of the main menu screen shows the name of the job that
is open and the following icons (Table 2-1).
Table 2-1. Title Bar Icons

Icon Description

Topcon Logo Help Icon — opens a pop-up menu giving access to the
help files (mandatory), and some options specific to the current screen.

Controller Power Status Icon — shows status of the controller battery.

Connection Status Icon — shows connection status (green stands for an
established connection with the device). Pressing the icon opens the
Connections dialog to reconnect (Figure 2-3 on page 2-3).

B =

Exit Icon — closes TopSURV. When in a submenu, the Exit Icon turns
into the Back Icon to return to the main menu.
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Main Screen

When within a menu option, the title bar displays the Topcon Logo
Help Icon, the name of the open screen, and any system buttons (the
green tick [/ ] ok button and the red “x” cancel button) used
to save settings or not (Figure 2-2 on page 2-2).

Main Icons

The TopSURYV Icon Menu on the main screen contains the following
icons to provide access to job configuration, setup, display, and other
jobsite functions, and to control data (Table 2-2):

Table 2-2. Main Menu Icons

Icon

Description

Job — opens a submenu to create, open, delete a job or get information
about an active job.

Configure — opens a submenu to create or change a configuration for a
job. The icon changes its appearance and reflects the instrument set for
use in the current job.

Export — opens a submenu to export job data to a new job, controller
or afile.

Import — opens a submenu to import data from a job, controller or a
file.

Edit Job

Edit Job — opens a submenu to edit the job data.

2

Edit Roads

Edit Roads — opens a submenu to edit roads.

i

Setup

Setup — opens a submenu to set up surveying.

»

Suryey

Survey — opens a submenu to conduct a survey.
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Table 2-2. Main Menu Icons (Continued)

Icon Description

J Stake — opens a submenu to stake out objects.

Stake

COGO - opens a submenu to calculate cogo tasks.

-\I U‘I
“o
COGO

v

Map

Map - opens the map for the current job.

m Connections — switches between GPS and Optical instruments and
TE sets a connection with the instrument for a survey.
B

Connections

Viewing Port Traffic

To view or save to a file incoming and outgoing traffic information of
a controller port connected with TopSURY, tap the Topcon Logo Help

Icon in the top-left corner of the Icon Menu screen and select
the Port Data Logging option.

1. The Port Logging screen (Figure 2-11 on page 2-11) initially
shows no data. Tap the Help Icon in the upper-left corner of the
screen to open a pop-up menu and select one of the following
options:

» Show incoming port data — check mark to view incoming
data.
* Show outgoing port data — check mark to view outgoing data.

* Pause logging to screen — check mark to freeze the show of
port traffic.
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F—d Port Logging [ 7 | b 4

Port traffic

parameter ) ~
o005, C].E

CLOOC,DLIME, 0@ 12

||001F

=== WFILEIMFO%print, fpar fdev blk fa@33
S50 _EXTSprint, pur fext@FD

S0 _BATTASpriNEpwr bat f2@21

364 _BATTEprint,pwr bat/b@21

364 _SOURCEprint pur fourmaode @46
SLH 1%6set, fpar fout Jogh/period G0@3C
SLIMTERMETSTATUSC%print, fpar ppp,fstat
@59

%5 IMTERMETSPEEDc%print, fpar ppp fspes
d@ED
[S5FILEIMFOSsprint, fpar fdew fblk f2@33

O

Append

Figure 2-11. Port Logging

Type |Text Files (*.txt) »
\Storage Card\TPS\TopSURV

i

[_1Beacons IHelp
[C1Camera [CIEFiles
(C1CustomDevices l:llmages
CIDTM (J3obs
[CIFileSettings [y
(C1Geo [CJRamFiles
(1Geoids CJsqL

< >

Name

P/N 7010-0493

Figure 2-12. Save File

Viewing Port Traffic

2. Check mark the Log to file box to save the data to a file. When
the Save File screen (Figure 2-12) displays, assign a name and
select a desired directory in the controller to save the file.

Tap the ok [./] icon to return to the Port Logging screen to
view the data being saved to the file. The file name is also
shown on the screen (Figure 2-13).

Check mark the Append box to add new data to the existing file
on every start of TopSURV. Press the ok [ ./ ] icon to confirm.
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Port traffic

||001F

=== %IMNTERNETSPEEDCprint, /par fppp/f
speed@ED
[S5FILEIMFOSsprint, fpar fdew fblk f2@33

S CIIR LGS print, four lag@ss

S ABCIUT_SHYprint, jpar frovid@27

== amm G|,

CLOOC,DLIME, 0@ 12

||001F

=== WFILEIMFO%print, fpar fdev blk fa@33
S50 _EXTSprint, pur fext@FD

S0 _BATTASpriNEpwr bat f2@21

364 _BATTEprint,pwr bat/b@21

364 _SOURCEprint pur fourmaode @46
SLH 1%6set, fpar fout Jogh/period G0@3C

Log to file comm.log.txt
[] Append

Figure 2-13. Logging to File

Accessing Help Files

Tap the Topcon Logo Help Icon [£2] in the top-left corner of any
screen and select the Help option to open the general TopSURYV Help
topics or a specific option for the current screen (Figure 2-14).

2-12

L =200 A

s

| TopSURV |
| Help :

Job

Edit

Wiew

o Help —
TS Survey

GPS+ Survey

TS Stakeaut hd

Figure 2-14. TopSURV General Help Topics
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Before Surveying

Before Surveying

To start surveying with TopSURYV, make several preparations of the
available equipment (see “Preparation” on page 3-1), and create a job
to perform specific tasks on the jobsite (see “Creating a New Job” on
page 4-1).

The following sections describe the various TopSURYV functions to
assist in getting started with the software.

Data corruption may occur during data collection if

@ the controller is low on power. If a warning about
low power level displays, save and close the current

job.
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Notes:
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Chapter 3

Preparation

GPS Receiver Setup

1. Plumb the survey antenna over the mark and switch on the
receiver and the controller.

2. If the receiver and the controller are Bluetooth® enabled, set
the Instrument type to GPS and check the Bluetooth option in
TopSURYV (you can change this setting later in the Connections
screen).

To change the Bluetooth device that the controller is connected
to, click the Connection icon [@] in the upper-right corner of
the main screen.

3. [If the receiver or the controller are not Bluetooth enabled, or the
Bluetooth option is unchecked, connect the receiver to the
controller with the cable and set the device type to GPS in
TopSURY (you can change this setting later in the Connections
screen) (Figure 3-1).

E Connections
Device
Select device type...

GPS

(O Base Rover

(O optical |My Corvertional

[]Bluetooth |cor~f|5

Prampt at startup
[ Connect ]

Figure 3-1. GPS Mode
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Total Station (TS) Setup

Set up a tripod and then center the instrument over the mark.

By adjusting the tripod legs, center the cross hairs on the
ground mark. Complete the process by using the leveling
screws of the instrument so that the bubble indicates a level
position. Switch on the total station and the controller.

If the total station and the controller are Bluetooth enabled,
perform the following operations:
* In the total station — select Bluetooth option and set PIN code.

* In TopSURYV - set the device type to Optical in the
Connections screen; select the TS model and set the
Connection mode to Bluetooth TS; enable the Bluetooth
option in the Connections screen.

E Connections
Device
Select device type...

(Oars IMy RTK

Optical

Bluetooth

Wy Conventional

Prarmpt at startup
[ Connect

Figure 3-2. Optical Mode

* Select the TS from the list of devices and set the Passkey
value to PIN code (use the same code used in the total
station).

To change the Bluetooth device that the controller is

connected to, click the Connection icon [@ in the upper right
corner of the main screen.
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Level Setup

If the total station or the controller are not Bluetooth enabled, or
the Bluetooth option is not check marked, connect the
controller to the total station with the cable and set the
Instrument type to Total Station in TopSURV. Make sure the
data transfer parameters in the total station correspond to those
in the controller.

Level Setup

1.

Set up the instrument in a desired location, with the tripod legs
well spread and tapped into the ground.

By adjusting the tripod legs, roughly level the instrument.
Complete the process by turning the level screws of the
instrument to center the bubble within the circle. Switch on the
instrument and the controller. Make sure that in the level the
Out Module is set to RS-232C and the Measure option is
selected from the Menu.

Connect the controller to the instrument with the cable and set
the device type to Optical in TopSURV.

E Connections
Device

Select device type...

(Oars IMy RTK

Optical

Bluetooth

Prarmpt at startup
Connect

Figure 3-3. Level Mode
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Chapter 4

Creating a New Job

Follow the procedure below to begin working with TopSURYV and to
create a New Job file.

1. Tap Job » New Job or tap the New button on the Open Job
screen during initial startup (see Figure 2-1 on page 2-1). The
New Job screen displays (Figure 4-1). Enter the Name of the
job (mandatory) and any other informations. The date is stored
automatically.

NI

i \...\TPS\TopSURVJobs

Job New Job

Name kited]
Created By I

Comments |

Current Date
4/6f2010 15:26 PM

Browse Next >

Figure 4-1. New Job

The job name is considered invalid if it contains:
@ ¢ more than 63 characters

e any of symbols ! ,? % * @#$ %" &' "\/|~;
[I{}O<>"+=

@ Tap the ok [7] button to make the new job current
and use the settings from the previously open job.
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Creating a New Job

2. Tap Next to move to the next screen. At any stage, you can

select the ok [ /] button to create a new job. See the following
sections to create a new job for your mode of survey.

A Job file contains all the pertinent data for the work being done:

settings of the performed work and information on the Survey
Configuration.

A Survey Configuration is a set of settings, such as instrument
parameters or radio settings, which are independent of the job
(one configuration can be used on several jobs).

Survey configurations are stored in the Styles.ztsstyles file in the
TopSURY directory.

3. By default all job files are stored in the Job folder of the
TopSURY directory. To change the location of the job being

created, tap Browse on the New Job screen. The last specified
file path is retained.

4. On the Survey Style screen (Figure 4-2), select the Survey
Configuration, for both the GPS+ and Optical and tap Next. A
Survey Configuration is a set of parameters that describe work
conditions and depend upon the instrument used for the survey.
The last open configuration will initially display.

Select the Configuration for the
Job or create a New
Configuration.
GPS+ Config

Name IMy RTK v E

Optical Config

Name IMy Conventiona + E

I << Back ] I Next >3 ]

Figure 4-2. Select Survey Configuration

See the following sections for procedures to create and edit survey
configurations.
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Creating a GPS+ Configuration

* “Creating a GPS+ Configuration” on page 4-3
* “Creating Optical Configuration” on page 4-56

@ A user-friendly Wizard interface guides you
through the steps to create a job configuration.

Configuration settings are applied to the equipment
@ only after opening a screen that measures and stores

data in the job file.

Creating a GPS+ Configuration

A new configuration is performed with the help of a Wizard.

When creating a GPS+ configuration, use pre-defined configurations
or create new ones. The pre-defined configurations are listed in drop-
down menus in the corresponding fields. In the GPS+ Configuration

field, choose one of the pre-defined configurations or tap the [ ... |
button to create a new style or edit the parameters of an existing one.

The Configurations screen displays. The Configurations screen
contains a list of available GPS+ configurations (Figure 4-3).

P-4 configuratio 2E3
Configuration Name
My Network RTK
My Network DGPS
My RT DGPS
My PP Static
My PP Kinematic
My PP DGPS
[ Delete H Edit ] [ Add ]

Figure 4-3. Create/Edit a Configuration

1. To create a new configuration, tap the Add button (Figure 4-3).
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Creating a New Job

2. On the Survey Configuration screen, choose the configuration

type (either RTK, Network RTK, Real Time DGPS, Network
DGPS, PP Static, PP Kinematic, or PP DGPS) and enter the
name of the configuration (Figure 4-4). Tap Next.

ESurvey Configur... [ b 4
Name IMy RTK

Type RTK v

[ ] Post Processing

Figure 4-4. Configure an RTK Survey

For Network RTK, Network DGPS and RT DGPS survey modes,
select the corrections type (Figure 4-5):

Marne IMy Metwork RTE
Type INetwork RTE v

Corrections

[]Past Prace

4-4

E Survey Configuration -

MHame IMy RT DGPS
Type IReaI Time DEPS v

Corrections User Base
W
Eeacon

SBAS
[[]Post Procel-pcps

OmniSTAR-WBS

OmniSTAR-HP

Figure 4-5. Configure a Network RTK, Network DGPS, and RT DGPS

* VRS, MAC, FKP, Single Base or External Config for Network
RTK and Network DGPS (except MAC).

e User Base, Beacon, SBAS, CDGPS, OmniSTAR-VBS or
OmniSTAR-HP for RT and Network DGPS surveys.
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Creating a GPS+ Configuration

* Post Processing — check mark and enable to configure a post
processing survey type in either RTK, Network RTK, Network
DGPS, RT DGPS mode.

3. On the Receiver Make screen (Figure 4-6 on page 4-5) you can:

* Select a Manufacture for the rover and/or base; either Topcon or
Sokkia.

* Run TopSURYV GPS mode in a Simulation Mode for practicing or
demonstration purposes. Use the Set Simulator icon appear on
the Edit Job menu to change the current position for simulation.

4. Depending on the mode, continue creating the configuration:
* For RTK see page 4-6.

For Network RTK and Network DGPS see page 4-31.

For RT DGPS see page 4-43.

For PP Static survey mode see page 4-52.

For PP Kinematic and PP DGPS see page 4-49.

Evecovorvae  EAED

[] simulation Mode
Rover
Manufacturer

|T|:|p|:|:|n v

Base
Manufacturer

|T|:|p|:|:|n v

Figure 4-6. Receiver Make
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RTK Survey Configuration

Real time kinematic (RTK) surveying is used for topographic survey
and stakeout, and is the most precise method of real-time surveying.

RTK requires at least two receivers (Base and Rover) collecting
navigation data simultaneously and being linked via a communication
system. The Base receiver is usually at a known location and serves as
a reference station. The Base receiver collects carrier phase
measurements, generates RTK corrections, and transmits this data to
the Rover. The Rover receiver processes its carrier phase observations
with the received corrections, computing its relative position. The
closer the Rover is to the Base, the higher the probability of
determining the integer values of ambiguities.

To enable logging Base and Rover data for post processing in RTK
survey, check and enable the Post Processing box in the Survey
screen.

To configure a mmGPS+ aided RTK survey, check and enable the
mmGPS+ box on the Survey screen.

After naming the configuration, selecting its type and instrument
manufacturer, tap Next on the Receiver Make screen (Figure 4-6 on
page 4-5) and continue below to finish the configuration for an RTK.

1. Set the parameters for the Base Receiver (Figure 4-7), and tap
Next:

* Select Receiver Model of the Topcon or Sokkia receiver being
used for survey. You can select Hiper II, GR-3, GR-5, GMS-2/
GMS-2 Pro, GRS-1, NET G3, or Topcon Generic for any other
Topcon receiver. For Sokkia, either GRX-1, GSR2700 ISX,
GSR1700 CSX, GSR2700 1S, GSR2600 or Radian IS.

¢ Set Elevation Mask not to use data from satellites below this
elevation.

e Select RTK Format of the Base receiver corrections transmitted
to the Rover: CMR, CMR+, RTCM 2.1, RTCM 2.2, RTCM 2.3,
or RTCM 3.x
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Creating a GPS+ Configuration

* Select the Antenna type from the list and set the height and its
type (either Vertical measured to the antenna reference point or
Slant measured to the antenna edge).

* Press the Peripherals button to enable the Multiple Ports option
if needed to transmit data from different ports of the base receiver
to use for peripherals (see Figure 4-8 on page 4-8).

EFeereer  EAED

Receiver Model |Topcon Generic

Elevation Mask |13 deg

RTK Format IRTCM 3.x -

Antenna |GR—3 v

Ant Ht |0.000 m
Slant v

Figure 4-7. Configure Base Receiver

* Select the Receiver Settings option from the Help Icon menu in
the upper left corner of the Base Receiver screen to turn charging
mode of the receiver battery off as needed.

* If it is necessary to use relative parameters at the base with
CMR+ data transmission, select the Use Relative Calibrations
option from the Help Icon menu. By default, TopSURYV uses
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Creating a New Job

Absolute calibration offsets for antennas. Note: You can select
this option when editing the base.

|2 v

Figure 4-8. Peripherals

2. Set the Base Radio — choose the modem to be used and its
parameters, and tap Next (Figure 4-9).

Radio Modem
|Int. HiPer Lite v
Receiver Port Connected to Radio
Port C
Baud 38400 v
Data 8 v
Parity None v
Stop 1 w

Defaults

<< Back

Figure 4-9. Configure Base Radio

If Multiple Ports are set for peripherals (see Figure 4-8), depending
on the number of ports selected, there can be several radios for
correction data output.
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Creating a GPS+ Configuration

3. Custom modems use a standard set of parameters: port, parity,
the number of data bits, the baud rate and the number of stop
bits. Tap the Default button to set default settings for the port.

¢ AirLink GPRS, CDMA, CDPDI, CDMAZ2000, Generic, Sierra
Wireless MP200 CDPD modem types do not require additional
parameters.
Other modems require additional parameters to be set. These

parameters are available for setting in the Base Radio Parameters
screen.

* For Digital UHF modems (Internal GR-3 Digital UHF, Internal
HiPer Digital UHF, TRL-2 and TRL-35 External Digital UHF,
and RH-1 Digital UHF), set the operation protocol, modulation
type and channel spacing (Figure 4-10).

E Base Radio Param

Protocol ISimpIex v
Modulation IDEIPSK v

Spacing 12,5 kHz »

Co not set
16.25 kHz
12,5 kHz

20 kHz '
25 ke

Figure 4-10. Parameters for Digital UHF Modems

— Simplex: ArWest’s proprietary protocol. Only works with
other ArWest (Digital UHF) radios.

— TRMB: works with Trimble Trim Talk and Trim Mark
Radios.

1. CDPD stands for “Cellular Digital Packet Data”. CDPD is an open
packet data service, defined as an autonomous overlay network,
specified for the cellular TDMA network.

P/N 7010-0493 4-9



Creating a New Job

— PDL: works with existing PDL radios and Hiper XTs set in
PDL mode.

— select either DBPSK (Differential Binary Phase Shift Keying)
modulation type if using the Simplex protocol or GMSK
(Gaussian Minimum Shift Keying) if using Trimble or PDL.

* For HiPerXT UHF modem, set the protocol, channel, and power
(Figure 4-11).

— select the protocol for data transmission: either TPS, Topcon
FSCS mode to scan for the best channel on which to
communicate or PDL to communicate with the Rover PDK
radio.

— select a dedicated channel for the PDL protocol.

— select the level of power for RF transmissions: /W or 2W.

Protocol POL v
Channel ID v
Power 2% v

Figure 4-11. UHF Modem

¢ For FH915Plus modem (Internal HiPer Lite+ FH915Plus,
Internal GR-3 FH915Plus, RE-S1 radio, and RH-1 FH915Plus),
in addition to the operating channel, select the territory and the
operating protocol to communicate with different types of FH915
modem at the base/rover side (see Figure 4-13 on page 4-12).
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Creating a GPS+ Configuration

— select the territory (North America, Australia, or New
Zealand) to adjust the frequency range and RF power level
for the modem.

— select the operation protocol: either FH915 Ext,
recommended if all receivers on the jobsite are equipped with
FH915Plus radios only,
or FH915, recommended if there is a mixture of receivers
with FH915 and FH915Plus radios on the jobsite.

— select the operating channel.

Location INurth America
Protocol IFH915 Ext v
Channel I 1 v

Figure 4-12. Parameters for FH915+ Modems
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Creating a New Job

* For FH915 modem (Internal Hiper® Lite), set the operating
channel of the modem (Figure 4-13).

EBase Radio Param [I¥ b 4
Channel |1 v

Figure 4-13. Parameters for the FH915 Modem

¢ Pacific Crest and Internal HiPer (Pacific Crest) modems need a
channel and sensitivity (either low, moderate, high, or off) to be
chosen (Figure 4-14).

Channel IIII v
Sensitivity Low v

Figure 4-14. Pacific Crest Radio Parameters
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Creating a GPS+ Configuration

* For external Satel modem, set the model, channel, frequency,
PCC (Pacific Crest Corporation) protocol and using FEC
(Forward Error Correction) if necessary (Figure 4-15).

Model

Channel IB hd

Frequency I469.SDDD MHz
PCC IND PCC v

FEC INDt Lize v

Figure 4-15. Satel Radio Parameters

¢ For internal Satel modem (Internal HiPer Pro, Internal GR-3
Satel, and RH-1 Satel), you can enable the Free Channel Scan
mode for the base radio (Figure 4-16).

= e 7 1=

Enable Free Channel Scan

Figure 4-16. Internal Satel Parameters
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Creating a New Job

e For AirLink CDMA (Multicast UDP), set IP addresses for data
transmission from the Base Station to more than one Rover
Receiver using CDMA modems (Figure 4-17).

Address to Add I

IP Addresses list

222.0.055

<< Back

Figure 4-17. Base Multicast Parameters

¢ For the Internal HiPer GSM, Internal HiPerXT GSM, Internal
CR-3(GSM), Internal CR-3Satel(GSM), Motorola V60, Motorola
V710, MultiTech GSM/GPRS, Siemens TC35, Siemens M20,
Wavecom Fastrack GSM or Nextel 158sr Cell Phone modem
types, set the Base PIN (see Figure 4-18).

Base PIN L111]

Figure 4-18. Base Cell Phone Parameters

4-14 TopSURYV User’s Manual



Creating a GPS+ Configuration

4. Set parameters for the Rover Receiver, and tap Next.

o reor  EAED

Receiver Model |Topcon Generic

Elevation Mask |13 deg

RTK Format IRTCM 3.x -

Antenna |GR—3 v

Ant Ht [2.000 m
—  ARP
Vertical v H

Figure 4-19. Configure RTK Rover Receiver

* Select Receiver Model of the Topcon or Sokkia receiver being
used for survey, either Hiper II, GR-3,GR-5, GMS-2/GMS-2 Pro,
GRS-1, NET G3, or Topcon Generic. For Sokkia, GSR2700 ISX,
GSRI1700 CSX, GSR2700 IS, GSR2600, GRX-1 or Radian IS.

e Set Elevation Mask not to use data from satellites below.

¢ Select RTK Format of the which needs to coincide with this set
for the Base station.

* Select the Antenna type from the list and set the height and its
type, either Vertical (measured to the antenna reference point) or
Slant (measured to the antenna edge).

5. Press the Peripherals button if peripherals are used.

To output NMEA messages, check mark the NMEA Ports box and
select the number of ports for output.

* To input data from peripherals, check mark the Multiple Ports
box and set the number of ports.

* To enable a mmGPS aided RTK survey, check mark the mmGPS+
box. The Parameters button opens the mmGPS+ Parameters
screen to set the rover port and general parameters for the
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Creating a New Job

mmGPS+ unit. For this configuration see “mmGPS+
Configuration” on page 4-27.

include the height of the PZS-1 sensor with a 5/8

i : i When measuring the height of the rover antenna,
inch plug.

* To use a hand held laser measurement system, check mark the
External Laser box and select the device the laser is connected to.

Press the Parameters button to configure the laser device. For
this configuration, see “Laser Configuration” on page 4-26.

NMEA Ports [
Multiple Ports Iﬁ
mmGPS+

IRecewer v Parameters

Figure 4-20. Rover Receiver Options

6. Select the Receiver Settings option from the Help Icon menu in
the upper left corner of the Rover Receiver screen, to turn
charging mode of the receiver battery off as needed.

7. Ifitis necessary to use Relative antenna model at the base
station that transmits CMR+ data, check mark the Relative
calibrations on Base box from the Help Icon menu. By default,
TopSURYV uses Absolute calibration offsets for antennas. Also,
you can select this option when editing the Base.

8. To use the CSD form of data transmission for receiving RTK
corrections through a cellular phone used as a modem, select
the RTK protocol option from the Help Icon menu in the upper
left corner of the screen (Figure 4-20 on page 4-16).
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Creating a GPS+ Configuration

9. Set the Rover Radio in a manner similar to the Base Radio
setting (see Figure 4-9 on page 4-8) and tap Next.

If Multiple Ports are set for peripherals (see Figure 4-20 on

page 4-16), depending on the number of ports selected, there can
be up to two Rover Radio screens to configure radios for data
input.

Use only one radio to receive correction from the
Base.

If NMEA Ports are set (see Figure 4-20 on page 4-16), depending
on the number of output ports selected, there can be up to two
Config: Output Radio screens to configure radios for NMEA data
output.

10. On the Survey Parms screen, enter Survey parameters and tap
Next (Figure 4-21). These parameters can be changed by

pressing the settings button from any Survey screen in
GPS+ mode.

* Select the Solution Type filter to be used for data logging (Fix
Only; Fix and Float; Fix, Float, DGPS; or All).

* Set the Auto Accept conditions for a simple Topo survey: number
of measurements to be averaged and acceptable horizontal and
vertical precision.
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Creating a New Job

* Set Auto Topo survey parameters: method of automatic data
logging and the interval in corresponding units.

Solution Type
|Fixed Only »

Auto Accept

Num Meas to Avg |3

[] Precision (m)

Hz [0.0150  Vert [0.0300

Auto Topo
Method IBV Hz Dist v
Interval 15.00 m

Figure 4-21. Survey Parameters (RTK)

11. To define the incremental value for the numbering of survey
points, select the Point Increment by number from the drop-
down list (Figure 4-22) on the Point Properties screen. This
screen is opened from the Help Icon menu in the upper left
corner of the Srv Parms screen.

Epuint Properties f m
Point Increment by Iw v

Figure 4-22. Set the Point Properties Option
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12. On the Stk Parms screen, enter parameters and tap Next
(Figure 4-23). These parameters can be changed by pressing

the settings button from any Stakeout screen in GPS+
mode.

¢ Set the horizontal distance tolerance and the reference direction.
* Select the Solution Type filter to be used for data logging.

* Set the Auto Accept settings for Stakeout which are separate from
the Survey auto-accept settings: number of measurements to be
averaged and acceptable horizontal and vertical precision.

Hz Dist Tolerance IIJ.IZISIII m

Reference Direction
|Mmring Direction v

Solution Type
|Fixed Only »

Auto Accept

Num Meas to Avg |3

[] Precision (m)

Hz [0.0150  vert [0.0300

Figure 4-23. Stakeout Parameters

13. To display the icon for the staked point on the map, select the
Display option from the menu in the upper left corner of the Stk
Parms screen. On the Staked Point Icon screen (Figure 4-24),
set appropriate parameters for the icon.
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Use icon for staked point

Staked Point

Icon ITriangIe Flag v
Color E

p

Figure 4-24. Staked Point Icon

14. In the next Stk Parms screen, if necessary, set the rule for
generating the point name and Note of the staked point
(Figure 4-25 on page 4-21).

* Set the rule for defining names for the staked points: like a design
point name, or the next point name, or a design point name with a
pre-defined prefix, or a design point name with a pre-defined
suffix.

The choice of the prefix or suffix appears only when the
corresponding item is chosen from the drop-down menu. Also, a
specified numerical constant can be added to automatically
generate the staked point name.

* Set the rule for setting Notes for staked points. If the Station &
Offset option is selected, an edit box for entering an alphanumeric
prefix appears (Figure 4-25 on page 4-21). For the United States,
this prefix is “Sta”, for the international markets the prefix is
“Cha”, and for the Korean/Japanese markets the prefix is “No”.
With this option activated, depending on the choice for the prefix,
TopSURYV automatically generates one note for each stakeout
point: either Sta5+5.5R5.0, Cha505.5R5.0, or No.5+5.5R5.0
respectively.
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Store Staked Point As

Point IDESign Pt Suffix

stk

Note IDesign Point v

<< Back

Figure 4-25. Storing Staked Points

15. You may set advanced parameters for the survey on the
Advanced screen (Figure 4-26 on page 4-22). Tap Next.

Multipath Reduction — check and enable this field during the
survey to use when a signal received represents multiple
reflections from nearby objects. The box is checked by default to
use this mode during a standard RTK survey or GIS data
collection in standalone or DGPS mode.

* Co-Op Tracking — check and enable to allow a higher efficiency
of multipath reduction.

* Canopy Environment — enable to set less rigid thresholds for the
RTK engine to filter out measurement outliers. Use this mode
when working under tree canopy and in other cases of high
multipath.

* Define the Satellite system to be used.

» Set the RTK Position computation mode that determines whether
or not to Extrapolate the Base carrier phase measurements when
computing the rover's current RTK position. If Matched Epoch is
selected, the RTK engine will compute either a delayed RTK
position (for the epoch to which the newly received RTCM/CMR
message corresponds) or the current standalone position (while
waiting for new messages coming from the base).
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* When the GPS+GLONASS satellite system is selected for the
rover, select a manufacture of the Base receiver to accommodate
differences in processing GLONASS by different companies. You
can select from Topcon Positioning Systems, Sokkia, Ashtech,
Javad, Leica, Magellan, Novatel, Septentrio, Trimble, Other (for
the base receiver of other class included in the IGS list) or
Unknown (for the base receiver’s class not included in the IGS
list). By default, <Automatic Detection> is set.

A 7 | % ]
Sat System IGPS+GLONASS v

Multipath Reduction
[] €o-Op Tracking

|:| Canopy Environment

RTK Position IExtrapuIatiun -

Base Station Make

< Automatic Detection: v

Figure 4-26. Advanced Parameters

16. To set ambiguity resolution parameters for RTK engine, select
the RTK Settings option from the menu in the upper left corner
of the Advanced screen. In the RTK Settings screen, set
appropriate parameters (see Figure 4-27 on page 4-23).

o Select the Ambiguity Level: governs the RTK engine when
determining whether or not to fix ambiguities. Low, Medium and
High correspond to the indicator's 95%, 99.5% and 99.9% states,
respectively. The higher the specified confidence level, the longer
the ambiguity search time.

* Set the Resolution Period that defines the differential correction
update interval. Before entering a value, know the exact rate at
which the reference station broadcasts differential correction
data. This interval will only be used if the receiver is ran in Delay
mode. The interval also provides more reliable synchronization
between the Base station and Rover receiver.
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* Set Expected Correction: differential correction update interval
for base station, effective only in the RTK Matched Epoch mode.
The value should be set to the exact rate at which the base station
transmits its differential correction data. This parameter will
instruct the rover receiver to output the RTK position at the same
rate at which differential corrections are updated.

Ambiguity
Level Im v
Resolution Period
IT sec
Expected Correction
IT sec

Figure 4-27. RTK Settings

17. On the Miscellaneous screen (Figure 4-28), select the
necessary options to customize the user interface during GPS
measurements: display of computed coordinates, prompts for
antenna height, and beeps upon storing points.

E Miscellaneous - m

Display coordinates after meas.
Prompt for antenna height
v Beep on storing points

Figure 4-28. Miscellaneous
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18. Tap the ok [./ ] button to store the settings and to return to the

Survey Config screen. The name of the created configuration
will display in the drop-down menu in the GPS+ Config field.
This configuration can be used on several jobs.

@ Configurations are stored in a file called
Styles.tsstyles located in the TopSURYV directory.

NMEA Output Configuration

To enable outputting NMEA messages (Figure 4-29 on page 4-25),
take the following steps:

1.

Press the Peripherals button on the Rover Receiver screen (see
Figure 4-19 on page 4-15).

Check and enable the NMEA Ports box on the Peripherals
screen (Figure 4-20 on page 4-16) and select the number of
ports for output of NMEA messages.

Configure all output radios in the Qutput Radio screens
available depending on the number of output ports selected.

Select the types of sentences to issue via the specified receiver
port at the interval set in seconds (up to 0.1 sec).

* GSA - outputs the operation mode of the GNSS receiver, the
satellite used for positioning, and DOP.

* GLL - outputs data on the current latitude/longitude and
positioning mode.

* VTG — outputs the traveling direction and velocity.

* GRS - outputs the residual error of distance for each satellite,
is used to support RAIM.

* ZDA - outputs UTC, day, month, year, and local time zone.
* GST - outputs the statistics of position errors.

* GNS - outputs data on time, position, and positioning of
GPS+GLONASS (GNSS).

* GGA - outputs data on time, position and positioning.
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* GSV - outputs the number of satellites, satellite number,
elevation angle, azimuthal angle, and SNR.

* HDT - outputs the direction (heading).
* P_ATT - outputs attitude parameters.

* RMC - outputs time, date, position, course and speed data
provided by a GNSS navigation receiver.

* ROT - outputs rate of turn.

* GMP — outputs GNSS map projection fix data.

5. Set the Interval in seconds (up to 0.1 sec) at which the
messages will be issued.

6. If needed, check mark the Set GP as Receiver Talker ID box to
instruct the receiver to use "GP" as Talker ID in appropriate
NMEA sentences generated. Check mark and enable to support
Goggle Maps that cannot recognize default "GN" or "GL" as
Talker IDs in these sentences.

# 0 g: Outp y u
NMEA Messages -~
¥/ GSA

GLL

VTG

GRS

ZDA

G5T

GNS v
< b

Interval ILUU Sec

[]set GP as Receiver Talker ID

Figure 4-29. Config: Output NMEA

P/N 7010-0493 4-25



Creating a New Job

Laser Configuration

To use a hand held laser measurement system, take the following

steps:

1. Press the Peripherals button on the Rover Receiver screen (see

Figure 4-19 on page 4-15).

2. Check and enable the External Laser box on the Peripherals

screen (Figure 4-20 on page 4-16) and select the device (either

Receiver or Controller) the laser is connected to.

3. Press the Parameters button to configure the laser device.

4. In the Config: Laser screen, set the properties for the laser
device: a laser manufacturer, the instrument model and type,

and laser port settings (see Figure 4-30). Tap the ok [./]

button.

Manufacturer v

Model ILaserAce 300 v
Type IRange Finder On +

Laser Port Setting

Port IC e
Parity Iﬁ
Data IB et
Baud  [9600 ]
Stop ﬁ

Figure 4-30. Laser Configuration

Table 4-1 lists the supported manufacturers and models of laser

devices.
Table 4-1. Laser Device Manufacturer and Model
Manufacturer Model Type of Laser measurement
system
MDL LaserAce 300 Range Finder Only
Range Finder with Encoder
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Table 4-1. Laser Device Manufacturer and Model

Type of Laser measurement

Manufacturer Model
system

Laser Technology, Inc. Impulse 200 Impulse Only
Impulse with Compass

Laser Technology, Inc. TruPulse 200 TruPulse Only
TruPulse with Encoder

Laser Technology, Inc. TruPulse 360 TruPulse Only
TruPulse with Compass

mmGPS+ Configuration

An RTK mmGPS+ survey system uses a wireless PZS-1 sensor at the
Rover and the PZL-1 transmitter to obtain accurate (millimeter)
elevations.

1. Press the Peripherals button on the Rover Receiver screen.

2. Check and enable the mmGPS+ box on the Peripherals screen
to configure the mmGPS+.

3. Tap the Parameters button and select the options in the
mmGPS+ Parameters screen (Figure 4-31). Tap the ok [ /]
button.

* Select a port from the Receiver port drop-down list used for
communication between receiver and PZS-1 sensor (typically
port D).

* Select Auto from the Sensor Gain drop-down list to
automatically control the mmGPS receiver's detection level of
the transmitter's signal.
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¢ Enter the threshold for the difference between GPS and

mmGPS+ height measurements in the Height Difference
Limit field.

EmmGPS+ Parms - m
Receiver Port IW v
Sensor Gain IAutl:l v

Height Difference Limit

ID.BDD m

Figure 4-31. mmGPS+ Parameters Screen Options

PP Enabled RTK Survey Configuration

In RTK survey with enabled post processing, the collected Base and
Rover data are written to files for further post processing.

1. Enable logging the Base and Rover data by selecting the Post
Processing check box in the Survey screen (Figure 4-4 on
page 4-4).

2. On the Receiver Make screen (Figure 4-6 on page 4-5) select a
Manufacture for the rover and/or base; either Topcon or Sokkia,
and tap Next.

3. Set the parameters for the Base Receiver (see Figure 4-7 on
page 4-7), and tap Next.
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4. Set the logging parameters for the Base receiver: the file name,
logging rate and the device in which raw data is logged to
(currently only the Receiver is available). Tap the Next button.

EBase PP Setup - m
Raw Data Logaging
File Name IDefauIt v

Log To IReceiver v
Logging Rate |5-UU secs

Figure 4-32. Config: Base PP Setup

5. Configure the Base Radio (see Figure 4-9 on page 4-8) and tap
Next.

6. Set the parameters for the Rover Receiver (see Figure 4-19 on
page 4-15), and tap Next.

7. On the Rover PP Setup screen (Figure 4-33 on page 4-30), set
the logging parameters for the Rover receiver: the file name,
logging rate, and the device in which raw data is logged to
(currently only the Receiver is available).
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10.

11.

Select whether to start logging manually or automatically as
data is being collected. Tap the Next button.

ERuver PP Setup - m
Raw Data Logging
File Name IDefauIt v

Log To IReceiver v
Logging Rate |5-UU secs

Figure 4-33. Rover PP Setup

Configure the Rover Radio, and the mmGPS+ system if used,
then tap Next.

On the Init Times screen (see Figure 4-34 on page 4-31), set
the Initialization Times parameters, the times required for
ambiguity resolution in the specific operating environment.
These are used during automatic mode of the survey and
depends upon the number of satellites available and the number
of frequencies being used. For example, the default for six
GPS/GLONASS (6+) dual frequency satellites is ten minutes.
This means that the complete Rover file should be at least this
long. Then tap Next.

On the Survey Parameters screen, be sure to set the Auto Topo
Interval multiple to the logging rate in the receiver.

Complete the configuration of the PP enabled RTK in a manner
similar to RTK.
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3 it Times FE3

Occupation times in minutes:

Num S¥s Single Freq Dual Freq

<< Back

Figure 4-34. Initialization Times

Network RTK Survey Configuration

Network Real Time Kinematic (Network RTK) surveying is similar to
RTK surveying but the correction data for the Rover is derived from
the reference station network solution. Today’s operating reference
station networks are creating either Virtual Reference Station (VRS)
data, Master-Auxiliary Concept (MAC) data, or network area
corrections (FKP parameters).

1. After naming the configuration and selecting its type in the
Survey screen, select the desired correction type (Figure 4-5 on
page 4-4) and tap Next.

* VRS —to receive RTK corrections from a VRS base station.
* MAC —to use a set of MAC corrections

* FKP —to use a set of FKP corrections.

* Single Base — to receive RTK corrections from a single base.

» External Config — when the receiver uses an External
program to configure RTK corrections.

2. On the Rover Recvr screen, select the Receiver Model, set the
Elevation Mask and antenna parameters for the Rover Receiver.
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Then select one of the following protocols from the Protocol
drop-down list (Figure 4-35). Tap Next.

* NTRIP — (default) Networked Transport of RTCM via
Internet Protocol to receive RTK corrections from a NTRIP
Caster.

e TCP/IP — select to receive RTK corrections through the
Internet.

e CSD Data — select to use the CSD form of data transmission
to receive RTK corrections through a cellular phone used as a
modem.

o reor  EAED

Receiver Model |Topcon Generic

Elevation Mask |13 deg
Protocol INTRIP v
Antenna |GR—3 v

Ant Ht [2.000 m
—  ARP
Vertical v H

Figure 4-35. Rover Receiver

3. On the Config: Modem screen (Figure 4-36 on page 4-33)
select Controller if the modem is connected to the controller or
Receiver if the modem is internal or external, but connected
directly to the receiver.

4. 1If connecting to the Controller, use the Dialup Network
Connection for connecting to the Internet to get correction data.
Tapping Next displays the Modem Internet Info screen
(Figure 4-38 on page 4-34).
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ECDnﬁg: Modem ... -m
Modem Connect IReceiver v

Figure 4-36. Modem Connect

If connecting to the Receiver, configure the connection
parameters for External AirLink Modem SW, External CDMA
Modem FW, External GPRS Modem FW, Internal CDMA,
Internal GPRS and Generic modems and tap Next.

NTRIP Internet Configuration

First contact the network administrator to gain access to the system.
You will need the IP address and Port to connect to, the user name and
password for NTRIP. Use the following methods to connect to the
network:

1.

If the receiver currently being used has an internal GSM/GPRS/
CDMA modem, use the Internal Modem along with a SIM
Card obtained from a service provider. Note that the receiver
must have the appropriate firmware version.

If an external modem is connected to the receiver, use either
Firmware or Software dialup, depending on the modem type
supported by the firmware.

If using a cellular phone that is data enabled and connected to
the controller, use Dialup Networking Connection in TopSURV
to connect to the network.
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The following setup is an example of a GPRS connection

(Figure 4-37). However, any generic method for connecting to the
Internet can be used. Note that a Network RTK setup requires two-
way communication links (like GSM and GPRS setups).

Radio Modem
internal GPRS

Part Connected to Mademn

Port C

Baud 28400 v
Data g v
Parity Mone v
Stop 1 v

Figure 4-37. Rover Radio

4. Select a base Internet address and port from the list and tap
Next. For Internet connection from the controller side, you can
set up NTRIP connection using a web address. New IP/Web
addresses/ports can be deleted or added to the list. If needed,
check mark the Use GPUID box to turn on the method of
GPUID authorization.

E Config: Modem Int... - m

Internet Info

Address: |193.232. 110,132:8067
MNarme: I

Add new ] [ Update ]
Address list: @ (Oweb

Figure 4-38. Modem Internet Info
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5. Tapping Next displays the Config: Login Info screen
(Figure 4-39) only if NTRIP was selected as the protocol to
receive RTK corrections via the Internet.

6. Enter the NTRIP user name and password provided by the VRS
service provider and tap Next.

Credentials

User ID

Password

Figure 4-39. NTRIP Login Info

7. Use the Config: Modem Dialup Info screen (Figure 4-40) to
input Internet User ID, Password, PIN number, and APN
(Access Point Name). Select the type of modem.

3 - EAE3
Pravicer IOther v
Disiup Num rgg R

User 1D mts

Password rnts

PIN fpooo—
PN frtemetmtsry
[Frotsmis &)

Figure 4-40. Config: Modem Dialup Info
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8. Clicking the Defaults button will reset all settings to default
values of the selected provider.

9. Select a port for Advance Input Mode from the Virtual Radio
Port field. Only a port currently not in use can be selected as a
Virtual Radio Port.

Receiver Info

Wirtual Radio Part

[E—

Figure 4-41. Modem Receiver Info

An appropriate Virtual radio port is selected
automatically, basing on the receiver model used.

10. Continue configuring the Network RTK survey type in a
manner similar to RTK.
11. After completing the survey configuration, and tapping the ok

[/ ] button, if it is enabled in the Connections dialog (see
Figure 2-4 on page 2-3), automatic connection to the NTRIP
server is performed for Internal CDMA and GPRS modem:s.
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* First TopSURYV queries information from the modem.

Device | Network

Querying Signal Quality
Connecting to Internet
Querying Mount Paints
Connecting to NTRIP Server

Mount PT: Sighal I

Querying Modem Info

Disconnect Connect

Figure 4-42. Querying Modem Info

* Then the signal quality is checked if it is enabled in the
Connections dialog (see Figure 2-4 on page 2-3).

Device | Network

v Querying Signal Quality
Connecting to Internet
Querying Mount Paints
Connecting to NTRIP Server

Mount PT: Sighal "I

Daisy Chain Closed

Disconnect Connect

Figure 4-43. Querying Signal Quality
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* Daisy Chain is closed, and connecting to the Internet starts.

-Dewce Network -De e | Network
¥ Querying Signal Quality v Querying Signal Quality
Connecting to Internet |v|Connecting to Internet
Querying Mount Points Querying Mount Paints
Connecting to NTRIP Server || Connecting to MTRIP Server
Mount PT: Signal FEER Mount PT: Signal FRRR
PPP: Connecting Speed 38400 > MNTRIP: Off
Disconnect Connect Discannect Connect

Figure 4-44. Connecting to the Internet

* After making PPP connection, querying Mount Points is
performed, and the Radio port starts to connect with the NTRIP

server (Figure 4-45).

-D o | Metwork

v Querying Signal Quality
| Connecting to Internet
1w Querying Mount Points
~/ Connecting to NTRIP Server

Device | Network

v Querying Signal Quality
| Connecting to Internet
1w Querying Mount Points
Connecting to NTRIP Server

Mount PT: Signal T Mount PT: Signal T
IKLIM_RTCMSD;KLIM_RTCMSD:R

|KLIM_RTCMSD;KLIM_RTCMSD:R
Starting Radio Port _> MTRIF: Try to connect

Disconnect Connect Disconnect Connect

Figure 4-45. Starting Radio Port
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* NTRIP connection is established, and the modem is successfully
set to receive correctional data from the NTRIP server.

Device | Network

v Querying Signal Quality
v Connecting to Internet
¥ Querying Mount Points
~/ Connecting to NTRIP Server

Mount PT: Sighal "I
IKLIM_RTCMSD,‘KLIM_RTCMSEI:R

NTRIP: Connection is established

Disconnect Connect

Figure 4-46. Modem is Set Successfully

12. If automatic connection is disabled in the Connections dialog

(see Figure 2-4 on page 2-3), you can configure the modem
from the Status or Topo screens.

13. Tap Setup GPS » Status. Select Config Modem from the Help

Icon menu in the upper-left corner of the Status screen to make
a connection (Figure 4-47).

[#]

Type Internal GPRS Type Internal GPRS

Connected |C0ntr0ller Connected |C0ntr0ller

Port [ Port 8

Address Address |193.232. 110.132:8087 »
MrtPts | v MrtPts | v

g Stream Info Stream Info

‘ Starting Radio Port 2 ‘ PPP: Connecting Speed 33400

Update Disconnect l Update l l Connect l

Figure 4-47. Starting Radio Port
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14. Tapping the red icon [] will open the Internet Connect screen
that displays all of the parameters you will need for PPP
connection. Make sure all values are correct and tap the
Connect button to make the PPP connection.

E Internet Connect

Pravider IOther v
Dialup Murn I*QQ***l#

Lzer I riits
Password riits
FIN IDDDD

APN Iinternet.mts.ru
I FHI15Plus v

l Disconnect H Connect

Figure 4-48. Internet Connect

15. When doing the connection, PPP connection starts to cycle
through the baud rates: it should connect at 38400. It can take a
few minutes to do so. Once connected the red icon will turn to

4-40

green .

Type Internal GPRS
Connected ]CDnLrDIIe;

Part 8
address  [193.232.110.132:8067
MrtPts | v

Stream Info

‘ PPP: Connected Speed 38400

l Update l l Connect l

Figure 4-49. Internet Connection
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16. After the PPP connection is established, tap the Update button
to retrieve Mount Points from the NTRIP Caster at the specified
IP address and Port. Select the correct Mount Point.

|# Config Modern E

Type Internal GPRS Type Internal GPRS

Connected !Controller Connected !Controller

Port !C Port !C

Address I193.232.110.132:806? bt Address I193.232.110.132:EIDE|? bt

Mnt Pts I v Mnt Pts IKLIM_RTCMSD;KLIM_R' bt

g Stream Info Stream Info

‘ Starting Radio Port —_—) ‘ PPP: Connected Speed 38400

Update Connect l Update l l Connect l

Figure 4-50. Update Mount Points

17. Tap the Connect button to start getting corrections from the

selected Mount Point. A successful message will displays
(Figure 4-51).

Type Internal GPRS
Connected !Controller

Type Internal GPRS

Connected !Controller

Part 8 Part 8
address  [193.232.110.132:8087 address  [193.232.110.132:8087
MntPts  [KLIM_RTCM30KLIM R MntPts  [KLIM_RTCM30KLIM R

‘ Cormmands sent Successfully, —} ‘ PPP: Connected Speed 23400

l Update l lDisconnectl Update

Figure 4-51. Network Connection Started

18. Tapping the Disconnect button disconnects from the current
Mount Point.
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19. Tapping the Stream Info button displays information on the
selected Mount Point.

Figld Wallie i

type TR

rmountpoint KLIM_RTCMI0
identifier KLIM_RTCM30

forrnat RTCM 3.0
format-details 1004(13,1012(1),1C
carrier 2 -
nav-system GPS+GLOMNASS
network NTRIP

country RUS

latitude 55.36

lonaitude 37.52 b
< >

Figure 4-52. Mount Point Information

PP Enabled Network RTK Survey Configuration

In Network RTK survey with enabled post processing, the correction
data at the reference station and the collected Rover data are written
to files for further post processing.

1. Enable logging Rover data by selecting the Post Processing
checkbox in the Survey screen (Figure 4-4 on page 4-4).

2. Set the logging parameters for the Rover receiver: the file
name, logging rate and the device in which raw data is logged
to (currently only “Receiver” is available). Select whether to
start logging manually or automatically as data are being
collected (Figure 4-33 on page 4-30). Tap the Next button.

3. Continue configuring the PP enabled Network RTK in a
manner similar to Network RTK until the Init Times screen.

4. On the Init Times screen (Figure 4-34 on page 4-31), set the
Initialization Times parameters, the times required for
ambiguity resolution in the specific operating environment.
These are used during automatic mode of the survey and
depend upon the number of satellites available and the number
of frequencies being used. Then tap Next.
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5. Complete configuring the PP enabled Network RTK in a
manner similar to Network RTK.

Network DGPS

The configuring of the Network DGPS survey type is the same as for
Network RTK. For details on configuring Network survey, see
“Network RTK Survey Configuration” on page 4-31. The difference
is that the Solution type is set to DGPS. The same applies to the PP
enabled Network DGPS configuration. For details on configuring a
PP enabled Network survey, see “PP Enabled Network RTK Survey
Configuration” on page 4-42.

RT DGPS Survey Configuration

Real time differential (DGPS) surveying is used for topographic
survey and stakeout. RT DGPS typically uses the measurements from
two or more remote receivers to calculate the difference between
measurements, providing more accurate position solutions.

One or more Base receivers are placed at known locations and serves
as reference stations. These reference stations collect the range
measurements from each GPS satellite in view and forms the
differences (corrections) between the calculated distances to the
satellites and the measured pseudo-ranges to the satellites. These
corrections are then built up to the industry standard (RTCM or
various proprietary standards) established for transmitting differential
corrections and broadcast to the rover receiver(s) using a data
communication link. The Rover receiver applies the transmitted
DGPS corrections to its range measurements of the same satellites.

A number of differential services exist to transmit differential
correctional data, including maritime radio beacons, geostationary
satellites (as with the OmniSTAR service), and SBAS (Satellite-
Based Augmentation Systems) service.

To enable logging rover data for post-processing in RT DGPS survey,
select and enable the Post Processing box in the Survey screen.
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After naming the configuration, selecting a type and correction type,
(see Figure 4-5 on page 4-4), and continue below to finish the
configuration for a RT DGPS Survey configuration.

In user-based mode, the Base and Rover receivers are set in a manner
similar to setting RTK receivers.

1. Set the parameters for the Rover Receiver: DGPS Format ((Full
(RTCM 1,31,3) and Partial (RTCM 9,34,3) or from a Beacon
station (RTCM 2.1, 2.2, or 2.3 can be selected)) and/or
Elevation Mask and Antenna parameters in the same way as for
RTK survey (see Figure 4-19 on page 4-15), then tap Next.

2. Set appropriate parameters to use differential correction data
from a differential service enabled for the Rover, and tap Next.

» For Radio Beacons, select the country and the name of the beacon
station (Figure 4-53).

Country |USA v

Station |ACUSHNET, MA v

[]Beacon Corrections from BR1

Figure 4-53. Config: Beacon

* To use the beacon receiver BR-1 as a source of differential
corrections for the rover, select Beacon Corrections from
BR-1 option on the Config: Beacon screen (Figure 4-54 on
page 4-45).
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ECDnﬁg: Beacon [ b 4

Country |USA

Station [ACUSHNET, MA

Beacon Corrections from BR1

I << Back ” Next >3 ]

Figure 4-54. Use BR-1

— To get the Beacon signal automatically, check and enable the

Automatic Scan Mode option to search broadcasting

frequencies and output RTCM corrections from the best
signal. Tap Next.

— Set the port for connection to the receiver or the controller
and the baud rate for data transfer. Other options are not
available for this device. Tap Next.
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ECDnﬁg: BR1 Rec... .

Connected to

|C0ntr0ller v
Part Connected to BR1
Part ComM1 v
Baud 38400 v
Data =1

Parity MHone

Stop 1

Defaults

Figure 4-55. Configure BR-1
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— Select a port from the Virtual Radio Port drop-down list, the
receiver port on which the receiver will receive the RTCM
messages from the controller (Figure 4-56). Tap Next.

ECDnﬁg: BR1 Rec...

Receiver Info

Virtual Radio Port

C—

Figure 4-56. Virtual Radio Port

* For SBAS (Satellite-Based Augmentation Systems), select
satellites of a satellite-based augmentation system (WAAS/
EGNOS/MSAS) to improve accuracy of DGPS solutions
(Figure 4-57 on page 4-47):

— Check the boxes near the PRN numbers of the satellites. All
satellites can be selected. The satellite most available from
those selected will be used in Code DGPS solution.

— Enable use of ionospheric corrections from the selected
satellites when computing positions.

None: ionospheric corrections are not used
Apply if avail: use ionospheric corrections if available

Use sat only if avail: use only the satellites for which
ionospheric corrections are available.
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3 sBas setup [/ | 8¢

PRN Name GPS# | ~
v|120 AOR-E 2

121
v|122  AOR-W 4

123

124  Artemis
125

< 4

Iono Corr

Apply if avail »

Figure 4-57. SBAS Setup

¢ For OmniSTAR-VBS and OmniSTAR-HP (a wide-area, satellite
delivered, differential Virtual Base Station and High Performance
GPS services), select the name of the satellite to be used
(Figure 4-58).

Satellite

AF Sat v

EA_SAT Lon 25E
AP _SAT:AM_SAT Lon 108E;

MSY_East
MSY_Center
MSY_West

User Defined

I << Back ” Next >3 ]

Figure 4-58. Config: OmniSTAR
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¢ For CDGPS (Canadian nation-wide DGPS service), set the

parameters for the receiver port connected to the CDGPS radio
(Figure 4-59).

Radio Modem
|coaps
Receiver Port Connected to Radio

Port A v
Baud 38400 v
Data 8 v
Parity None v
Stop 1 w

Defaults

Figure 4-59. CDGPS Radio

3. The remaining steps are similar to those for an RTK survey.

PP Enabled RT DGPS Survey Configuration

In RT DGPS surveys with enabled post processing, the differential
correction data and the collected rover data are written to files for
further post processing.

1.

Enable logging the rover data for post processing in the DGPS
survey by checking the Post Processing box in the Survey
screen (Figure 4-4 on page 4-4).

Configure the Rover Receiver. Then tap Next.

Set the logging parameters for the Rover receiver: the file
name, logging rate, and the device in which raw data is logged
to (currently only “Receiver” is available). Select whether to
start logging manually or automatically as data are being
collected (Figure 4-33 on page 4-30). Tap the Next button.

Set appropriate parameters to use differential correction data
from a differential service enabled for the Rover (for details
refer to “RT DGPS Survey Configuration” on page 4-43), and
tap Next.
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5. On the Init Times screen (Figure 4-34 on page 4-31), set the
Initialization Times parameters, the times required for
ambiguity resolution in the specific operating environment.

The parameters are used during automatic mode of the survey and
depend upon the number of satellites available and the number of
frequencies being used. Then tap Next.

6. Complete the configuration of the PP enabled Real Time DGPS
in a manner similar to Real Time DGPS.

PP Kinematic and PP DGPS Survey
Configurations

After naming the configuration, selecting its type and correction type,
continue below to finish the configuration for a PP Kinematic and PP
DGPS Survey configuration.

1. Set the parameters for the Base Receiver: Receiver Model,
Elevation Mask and Base antenna parameters (Figure 4-60),
then tap Next.

EFeereer  EAED

Receiver Model |Topcon Generic

Elevation Mask |13 deg

Antenna [GR-3 v
Ant Ht |0.000 m
Slant v

Figure 4-60. Base Receiver (PP Kinematic or PP DGPS)

2. Set Raw Data Logging parameters: select a file name, device
where raw data is logged, and the logging rate (Figure 4-61 on
page 4-50). Tap Next.
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Raw Data Logging

File Name IDefauIt v
Log To IReceiver v
Logging Rate |5-UU secs

Figure 4-61. Base PP Setup

@ Raw data always records into the receiver memory.

TopSURYV allows the logging to the controller when
in PP DGPS mode of survey only.

3. Set the parameters for the Rover Receiver: Receiver Model,
Elevation Mask, and Rover antenna parameters (Figure 4-62),
then tap Next.

Receiver Model |Topcon Generic

Elevation Mask |13 deg

Antenna |Map Ant B v

Ant Ht |0.000 m
—  ARP
Vertical v H

Figure 4-62. Rover Receiver (PP Kinematic or PP DGPS)
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4. Set the Raw Data Logging parameters for the Rover Receiver.

o vosowr EAED

Raw Data Logging

File Name IDefauIt v
Log To IReceiver v
Logging Rate |5-UU secs

Figure 4-63. Rover Receiver (PP Kinematic and PP DGPS)

5. In PP Kinematic mode, set Initialization times for a given
number of satellites and frequency modes on the Init Times
screen (Figure 4-64), and tap Next. Initialization Times are the
times required to estimate fixed ambiguity positions, which
depend upon the number of satellites available and the number
of frequencies being used.

e EAED
Occupation times in minutes:

Num S¥s Single Freq Dual Freq

Figure 4-64. Initialization Times
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6. On the Srv Parms screen, set the Number of Epochs for the
Topo survey (Figure 4-65 on page 4-52).

[~ I | %

Topo

Number of Epochs |3

Auto Topo

Method IB‘J" Time
Interval IS.DD sec

Figure 4-65. Survey Parms (PP Kinematic and PP DGPS)

7. For an Auto Topo survey, select the Method from the drop-
down list and set the Interval multiple to the logging rate in the
Receiver.

8. Complete configuring the PP Kinematic and PP DGPS survey
type in a manner similar to RTK.

9. Tap the ok [/ ] icon to store the settings and to return to the
Survey Config screen.

PP Static Survey Configuration

After naming the configuration and selecting its type, continue below
to finish the configuration.

1. Set the Receiver Model, Elevation Mask, and the static antenna
parameters (Figure 4-66 on page 4-53), then tap Next.
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Receiver Model |Topcon Generic

Elevation Mask |13 deg

Antenna [GR-3 v
Ant Ht |0.000

Slant

Figure 4-66. Static Receiver

2. Set the Raw Data Logging parameters: File Name, device
where raw data is logged to, and logging rate (Figure 4-67).

EBase PP Setup -m
Raw Data Logging
File Name IDefauIt v

Log To IReceiver v
Logging Rate |5-UU secs

Figure 4-67. Base PP Setup

3. Set the Occupation Times parameters, the times required for
ambiguity resolution in the common operating environment
(Figure 4-68). These are used during automatic mode of a PP
Static Survey and depend upon the number of satellites
available and the number of frequencies being used.
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E Occup Times - m

Initialization time in minutes:

Num S¥s Single Freq Dual Freq

Figure 4-68. Occupation Times

4. Set Stakeout Parameters in the Stk Parms screens
(Figure 4-69), then tap Next.

Store Staked Point As
Hz Dist Tolerance I1.DDD m
Reference Direction Point IDesign Pt Suffix v
Maoving Direction » stk

Note IDesign Point v

Auto Accept

Murn Meas to svg |3

[]Precision {m}

Hz  J00150  vert |0.0300

Figure 4-69. Stakeout Parameters Screens

For details on stakeout parameters, refer to the description on
page 4-19.

5. Set the advanced parameters for the survey (Figure 4-70) and
tap Next.
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* Multipath reduction is used when a signal received represents
multiple reflections from nearby objects. Enable this field to use
this mode during a survey.

* To use the Co-Op Tracking mode, allowing higher efficiency of
multipath reduction, check and enable this field and select the
satellite system to be used.

E Advanced - m
Sat System IGPS+GLONASS A

Multipath Reduction
[]co-op Tracking

Figure 4-70. Config: Advanced
6. Select needed options in the Miscellaneous screen (see
Figure 4-28 on page 4-23).

7. Tap the ok [/ ] icon to store the settings, return to the Survey
Style screen and continue with the configuration setup. The
name of the created configuration displays in the GPS+ Config
field drop-down menu.
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Creating Optical Configuration

Optical configuration includes Total Stations and Level instruments.
Use pre-defined configurations or create new ones. The pre-defined
configurations are listed in the drop-down menus in the
corresponding fields in the Survey Configurations screen (Figure 4-2
on page 4-2). In the Optical Configuration field choose one of the pre-
defined configurations or tap the List [ ... ] button to create a new
configuration or to edit an existing one. The Configurations screen
displays (Figure 4-71) which contains a list of available Optical
configurations. Either edit the existing configuration or create a new
one. To simulate a real survey, select Manual Mode. In this mode, no
measurements are performed, all the data is entered manually.

#ll.l AR

Configuration Name
) = ) d

My Reflectorless
My Robotic

My Level
Manual Mode

| Delete || Edt || add |

Figure 4-71. Configurations

1. To create a new configuration, tap the Add button. To edit an
existing configuration, select it from the list and tap Edit.

2. On the Survey screen, enter a name for the Configuration and
select its type, then tap Next (Figure 4-72 on page 4-57).

» Use the Robotic type if the survey can be performed by one
person and the instrument is motorized.

* If areflector is not used, choose the Reflectorless type.
* In all other cases of TS survey, use the Conventional type.

» Use the Level type to perform Levelling with digital level.
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Marne IMy Conventional

Type

Figure 4-72. Survey

3. In the Instrument screen, select the manufacturer (Topcon or
Sokkia) and the model of the device, then tap Next (Figure 4-73
on page 4-57). For Conventional surveys Nikon and Leica
instruments can be also defined. Leica instruments are also
supported in the Reflectorless survey type. Note that the models
shown in the list correspond to the chosen type of survey.

P Instrument - m
Manufacturer ITDpl:l:ln v
Model IGTS—B2DA v

Figure 4-73. Instrument

For the Monitor survey with robotic total stations, select Monitor
from the context menu in the upper-left corner of the screen to set the
format and destination of the output file.
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4. On the Conn Mode screen, select the connection mode (the
Initial TS Connection parameter from the drop-down list) and
tap the Next button (Figure 4-74).
Selections depend on the instrument type: Cable; Radios, RC2
Only, RC3 Only, and Bluetooth TS; for IS and IS2 Robot, RC3
is available for configuration.

Initial TS Connection

|Ra|:|i|:|s v
Optical
|N|:|ne v

Figure 4-74. Conn Mode

5. On the Cable screen, select the communication settings for the
cable connection: Baud (baud rate), Parity, Data (number of the
data bits), and Stop (number of the stop bits) and tap the Next
button (Figure 4-75).

4-58

Default

Cable Comm Settings

Baud Im
Parity IEven v
Data ﬁ
Stop I 1 v

Figure 4-75. Cable
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The Radio screen displays (for a Robotic survey): select either
Mode (for motorized Conventional or Reflectorless surveys), or
Survey Parameters (for Conventional, Reflectorless, or Level
SUIveys).
6. For a Robotic Survey, choose the modem to be used and its
parameters, then tap Next (Figure 4-76 on page 4-59).

* Generic modems use a standard set of parameters: port, parity, the
number of data bits, the baud rate, and the number of stop bits.

* Pacific Crest modems also need a channel and sensitivity to be
chosen (these parameters are selected by pressing the Configure
Radio button).

* The Satel modem also requires the model, the channel number,
and the frequency to be set. If necessary, use PCC protocol and
FEC mode. These parameters are selected on the Radio
Parameters screen opened by pressing the Configure Radio
button.

Type ISateI »

Radio Comm Settings

Baud IQEIIIIZI v
Parity INune v

Data IB v
Stop I 1 v

Configure Radio

Figure 4-76. TS Radio

7. For the motorized instruments in the Conventional mode of
operation, check and enable the Enable Motor Turning box on
the Mode screen to turn the motor.
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&  EAE

Enable Motor Turning

Auto Tracking

No AimingfNo Tracking »

Auto Tracking

Figure 4-77. Mode

Also, the instrument can be set with auto tracking or auto aiming
tasks from the Auto Tracking drop-down list:

* The Auto Tracking mode causes the total station to track the
reflector while the surveyor moves from point to point.

* The Auto Tracking/Auto Aiming mode causes the instrument to
find the prism in the predefined region.

* The No Aiming/No Tracking mode disables the total station
operation program.

8. On the Search/Track screen (Figure 4-78), set the search
parameters for a Robotic Survey: the range of search along the
vertical and horizontal axes, pattern, track speed, sensitivity,
delay between the loss of signal and a new search start, turning
speed (measured in revolutions per minute) and the scan range
(the width of the signal), then tap Next.

4-60 TopSURYV User’s Manual



Creating Optical Configuration

Turning Speed 10 ~| rpm
Start Search After |2 | sec

Pattern IPattem 1

Trk Speed |Survey

Sensitivity  |High

v
v
v
Track Light |Off v

Scan Range |wide

Search Area
Hz  [5°00'0 vert [5°00°0

Figure 4-78. Search/Track

9. On the Survey Parms screen, set the method for performing
measurements and tap Next (Figure 4-79 on page 4-62).

* For the Angle/Dist - Dir/Rev method, select the sequence for
measuring angles: F'S is foresight point (the next occupation
point), BS is backsight point (the previous occupation point), and
Plunge is a rotation of the total station telescope and body by 180
degrees. These are used for reduction of angular errors. Also,
select the number measurement sets for the angles.

¢ To enable the reverse distance measurements, check the
corresponding field. These are used for the reduction of the
distance measurement errors.

* The Automatic Repetition of the measurements is available only
in the Robotic mode (for the motorized instrument).

* Insert the allowable tolerances for the measurements and enable
distance averaging (indicates if distance is measured using one
signal or computed as the average of several signals), if desired.

P/N 7010-0493 4-61



Creating a New Job

Meas Method

langlefDist Sets-DirfRey »

Angle Sequence
|BS/FS Plunge FS/BS 5
Num Sets Tolerances
l— Hz 5.0 sec
1 w mb—
Dist. |0.006 m
VA 5.0 sec
Auto Aim and Turn
Auto Accept Meas

Measure Reverse Dist
|| Num Meas to Avg |1|:|

Figure 4-79. Survey Parms

10. In the next Survey Parms screen, set the following parameters
(Figure 4-80 on page 4-63):

* Meas Type — the order and the type of the measurements in one
set.

* EDM mode — determines the sensitivity of the distance
measurements; coarse or fine. Select Fine for a normal mode or
Coarse mode to measure in a shorter time. For a Sokkia
instrument the Coarse setting changes to Rapid.

* Backsight/Foresight PC (Prism Constant) — the parameter of the
prism, characterizing the difference between the reflection plane
and the center of the prism for backsight and foresight,
respectively.

* Point Guide — operates the tracking lights. Select the appropriate
prism mode: either Prism or Non-Prism. For a Sokkia instrument,
you can select from Prism, 360 Prism, Sheet and Non-Prism.

* AutoTopo (only for the Robotic survey) — the parameters of the
automatic survey.

* If necessary, use the List [ button to edit the prism.
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Meas Type IW
EDM Mode IFine imm v
Backsight P.C Im

Foresight P.C IWE]
[JPoint Guid [Prism  +|

Auto Topo

Method IB‘J" Time hd
Interval |1.IIIIII sec

Figure 4-80. Survey Parms. Second Screen.

11. If needed, set the point increment value for Survey points. To
do this, select the Point Properties option from the Help Icon
menu in the upper-left corner of the Survey Parameters screen
(see Figure 4-22 on page 4-18).

12. Set the Stakeout Parameters in two Stk Params screens: the
Horizontal distance tolerance, reference direction, the rule for
generating the name and Note of the staked point (if necessary),
and the way the total station is to be turned towards the design
point. Tap Next (Figure 4-81).

Hz Dist Tolerance W m Store Staked Point As
Reference Direction Point IDesign Pt Suffix v
|Instrument Reference » stk

Turn TS to Design Pt Note IW
|HA only »

[]search After Turn

[[]Num Meas to Avg |1lII

Figure 4-81. Stakeout Parms
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coincides with the total station and for a Robotic

; The reference point for a Conventional Survey

survey, with the point where the controller is
located.

13. To display an icon for the staked point on the map, select the
Display option from the Help Icon menu in the upper-left
corner of the Stakeout Parameters screen. In the Staked Point
Icon screen, select the desired parameters for the icon (see
Figure 4-24 on page 4-20).

14. Select additional customizing parameters in the Miscellaneous
screen (Figure 4-82).

E Miscellaneous - m

Display Coordinates after Meas.
Apply Earth Curvature and Refr
Prompt for Rod Height
¥|Stakeout Sound
Manual Stakeout Update {Robo
v Beep on Storing Points
VA Zero at Level
Use Horizontal Angle Left
v| Automatically display BS Setup
¥/ Hold Offset Measurement
Remember OccfBS if set
< >

Figure 4-82. Miscellaneous

15. Tap the ok [/ | button to store the settings, return to the
Survey Style screen and continue with the configuration setup.
The name of the created configuration displays in the drop-
down menu in the Optical Config field.
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Once the survey configuration has been saved, other job settings can
be selected by tapping Next on the Survey Style screen (Figure 4-83).

tyle

Select the Configuration for the Job

% |

ar
create a Mew Configuration.
GPS+ Config
Nare v . ]

Optical Config

Marme I =Default= v E

l =< Back H Mext == l

Figure 4-83. Select Survey Configuration

Coordinate System

1. On the Coordinate System screen, set the parameters of the

coordinate system used: the projection, the Datum, and/or
Geoid, then tap Next (Figure 4-84).

Projection

| [5PC27-Alabama(East) vl ...
[Juse Grid § Ground

Datum INAD27
[]use NADCON

Geoid |4nune>

e

Figure 4-84. Coordinate System
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The NADS83 datum has three independent realizations in TopSURV
with respect to the WGS84 datum: NADS83, NAD83(ITRF96) and
NADS83_NO_TRANS to reflect the updates to these datums.

The original intent was for WGS 84 and NAD 83 to be identical. The
mathematical definition of the ellipsoids (WGS 84 and GRS 80)
differs slightly due to the choice of defining constants and number of
significant figures. The maximum discrepancy between a Cartesian
X.,Y,Z coordinate projected onto both ellipsoids is 0.1 mm at 45
degrees latitude. So, for all intents and purposes the ellipsoids can be
considered to be identical.

Confusion arises when we start to talk about the realization of the
WGS 84 and NAD 83 datums. When NAD 83 was first realized in
1986 it used the same control stations as WGS 84, some of which
were Doppler stations, which were accurate to about one meter. At
this time you could consider the datums to be identical.

Since this time there have been several realizations of WGS 84, the
latest being WGS 84 (G1150), which was performed using data from
IGS tracking stations collected during GPS Week 1150. Recent
studies have shown that WGS 84 (G1150) is essentially identical to
the International Terrestrial Reference Frame of 2000 (ITRF0O0).
Also, during this time there have been no new realization of NAD 83.
What this means is that WGS 84 and NAD 83 can no longer be
considered identical and are in fact different by more than one meter.
This is because the WGS 84 datum has been updated over time using
GPS and the NAD 83 datum has remained constant since 1986.
However, most software manufacturers still consider WGS 84 to be
identical with NAD 83.

To be compatible with other manufacturers, Topcon provides
transformation parameters from WGS 84 to NAD 83 where all the
parameters are zero. This means WGS 84 equals NAD 83. This set of
datum transformation parameters is called NAD 83 No_Trans.

Topcon also provides another set of datum transformation parameters
called NAD 83 which reflects the updates to WGS 84. These
parameters are taken from the National Geodetic Survey.

Topcon only uses the first seven parameters, three translations, three
rotations, and scale.
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2. To manipulate projections/datums/geoids, tap the List [ ]
button (Figure 4-84 on page 4-65) in the corresponding field
(for these operations, see the sections below). For SPC27
projection, select the Use NADCON box to make coordinates
match the same in Corpscon if necessary.

3. [If necessary, perform the Grid-to-Ground coordinate
transformation to produce near ground distance values by
checking and enabling the Use Grid to Ground check box (for
this operation, see the section below).

Adding a Projection

From the Coordinate System screen (Figure 4-84 on page 4-65),
select a projection from the drop-down list in the Projection field or

add a projection by tapping the List [ ...} button next to the
Projection field.

1. On the Projections screen, highlight the desired projection
from the Predefined list (Figure 4-85).

Predefined
- _Global ~
&I Africa

[l Asia

(- Australia and New Zealand

- Canada

(- Europe

hd
Active E]

SPC27-Alabama(East)

Figure 4-85. Projections

2. Hit the Down Arrow [g]button to insert the projection into the
Active list of projections (to delete the projection from the list,
use the Cross button).

3. Tap the ok [/ ] button to see the added projection in the
Projections drop-down list of the Coord System screen.
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4. To manipulate the custom projections, tap the Custom button.

To create a custom projection , tap the Custom button in the
Projections screen (Figure 4-85 on page 4-67). The Custom
Projections screen displays and contains a list of custom grid
projections. Initially, this list is empty.

E Custom Projections \/J—“q

I Projection

< 4

| pelete | [ eat || add |

Figure 4-86. Custom Projections

* Tap the Add button. On the Custom Projection screen, enter the
name for the new custom grid system and select a sample
projection and datum from the lists of available types, enter the
region and any additional information (Figure 4-87). Tap Next.

ECustum PrDjECtiDn. 4 b 4

Name |TM Local

Type |Transverse Mercato
Datum  |[WGS84 v
Region |0hi|:|

Note Ohio TM projection

Figure 4-87. Custom Projection
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* On the next Custom Projection screen, enter the new projection
specifications depending on the selected sample projection.

The projection types available for selection are as follows:
» Albers Equal Area (orthembadic): conic projection.
* Cassini-Soldner: cylindrical projection.
* Double Stereographic: conformal azimuthal projection.
* Lambert: conformal conic projection.
* Oblique Mercator: conformal cylindrical projection.
* Stereographic: conformal azimuthal projection.
* Transverse Mercator: conformal cylindrical projection.

If the Transverse Mercator projection is selected for example, enter
the following parameters and tap the ok [/ ] icon (see Figure 4-88):

* Central Meridian — longitude of the central meridian of a zone.
* Scale — scale factor on the central meridian.
* Lat0 — latitude of the origin of the projection.

* East0 — false Easting of the origin of the projection.

North0 — false Northing of the origin of the projection.

Central |= 0°00.000007
Scale Il.l]l]l]l] 15000

LatD 40°07'00.000
East0 10000.000 m

Northo Ill]l]l]l].l]l]l] m

Figure 4-88. New Projection Specifications
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the Northern Hemisphere, and as a negative number
in the Southern Hemisphere. The Longitudes are
positive for Eastern directions and negative for
Western directions relative to the GMT line.

; The Latitudes are entered as a positive number in

Adding a Custom Datum

1.

To add a datum, tap the List [ ... ] button from the drop-down

list in the Datum field on the Coord System screen (Figure 4-84
on page 4-65). The Custom Datums screen displays

(Figure 4-89 on page 4-70).

On the Custom Datums screen, which is initially empty, press

the Add button (Figure 4-89).

E Custom Datums

I Datum

< 4

| pelete | [ eat || add |

Figure 4-89. Custom Datums List

On the next Custom Datums screen (see Figure 4-90 on

page 4-71), enter the name of the new custom datum and select
the ellipsoid for the datum from the drop-down list of the
Ellipsoid field. Tap Next.
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Ellipsoid [AIRY 3
Note

[~ T~

Figure 4-90. Custom Datum Name

Configuration Setup

4. On the next Custom Datums screen (Figure 4-91), set offsets,
rotations, and scale for the new datum. Tap the ok [/ ] button

when done.

P/N 7010-0493

[~ T~

Offsets{m)
dx
dv [o.o00000
dz [0.000000

Rotations (secs)

rX ID.DDDDDDDD
Y Il].l]l]l]l]l]l]l]l]
rZ Il].l]l]l]l]l]l]l]l]

Scale IIII.IIIIIIIIIIIIIIIIZI ppm

Figure 4-91. Custom Datum Parameters
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Adding a Geoid File

Geoid is a physical reference surface. Its shape reflects the
distribution of mass inside the earth. Geoid undulations are important
for converting GPS-derived ellipsoidal height differences to
orthometric height differences.

Install the geoid file on the controller prior to adding it to the list.
Global geoid files can be opened and truncated in Topcon Link to fit
the file to the job area.

Some geoid files can be installed on the controller during TopSURV
installation. They are provided to the user with the TopSURV
installation program as ‘.gff” files.

To add a geoid file to the drop-down list in the Geoids field of the
Coordinate System screen, tap the List [ ... | button next to this field.

1. On the Geoid List screen, which is initially is empty, press the
Add button (Figure 4-92).

Hame |FuII Path
0sg... \Storage Card\TPS\Top!

< 4

[Remuve] [ Edit ] | Add |

Figure 4-92. Geoid List
2. On the Add Geoid screen (Figure 4-93 on page 4-73):

* select the corresponding file format from Geoid 99/2003/2009,
Australian, Canadian 2000, Canadian 95, Geoid File Format,
Mexico 97, Sweden, Denmark, Dutch2004 Files, or Norwegian
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* tap Browse and select the Geoid file from a controller directory
(downloaded beforehand), then view the boundaries of the geoid
application.

3. Press the ok [/ ] button to return to the Geoid List screen
(Figure 4-92 on page 4-72) with the geoid file added. This list
corresponds to the Geoids drop-down list in the Coord System
screen.

Format |Ge|:|i|:| File Format  +

IS\TDpSUR\.“\Geuids\Dsng2.gff

Geoid Boundary
?_ Lat |61°l31'03.936l]9'

Lor [|-7°33'21.25301"

_L Lat |49°45'53.D7755'
Lor |3 °33'16.02734"

Figure 4-93. Geoid Parameters

Grid / Ground Transformation

If necessary, perform the Grid / Ground coordinate transformation. A
ground projection is a grid mapping projection rescaled to convert
point coordinates to another reference surface (up to the average
project elevation or a point elevation) to produce near ground distance
values. The ground system can be rotated and shifted relative to the
grid system. The ground coordinates can be converted back to the grid
projection.

1. Check and enable the Use Grid/Ground box on the Coordinate
System screen, then tap the [} button.
The Grid/Ground Parameters screen displays (see Figure 4-94
on page 4-74). Select either Scale Factor, Average Job Height,
or Origin Point mode from the Parameters field to set up a
desired set of grid/ground parameters.
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2. In Scale Factor mode, set the following parameters:

e Combined Scale Factor for Grid to Ground or Ground to Grid
coordinate transformation direction.

» Azimuth Rotation, the angle that defines the reference direction
for ground azimuths. To compute the Azimuth Rotation value
using points in the job, tap the 7] button.

* Offsets values of the grid origin along the North and East axes to
reduce ground coordinates to manageable values.

Parameters v
Combined SF Im
Direction IGrid to Ground v
Az Rotation M E]

Offsets (m)
HNorth 0.000
East 0.000

Combined SF (Grid to Ground):
1.000000000000

Figure 4-94. Grid to/from Ground - Scale Factor

The reference information at the bottom of the dialog goes about the
combined scale factor and the direction of transformation.

3. In Average Job Height mode, set the following parameters (see
Figure 4-95 on page 4-75):

* Average Job Height of the project for Grid to Ground coordinate
transformation to compute the elevation scale factor. An elevation
factor is determined by using a constant value for the mean radius
of the earth. An approximation of the earth’s radius used in
TopSURY is 6,371,000 meters.

* Map Scale Factor that defines how many Grid distance units
correspond to one distance unit on the Ellipsoid.

» Azimuth Rotation, angle between the axes of the grid and the
ground coordinate systems. This angle defines the reference
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direction for ground. This value either has to be known for the

user or computed using points in the job (for this, tap the E]
button).

* Offsets values of the origin along the North and East axes to
reduce ground coordinates to manageable values.

The reference information at the bottom of the dialog goes about the
combined scale factor computed using the map scale factor and
elevation factor (computed using the average job height).

Parameters v

Map SF [toooooooo

Direction IEIIipsuid to Grid

Az Rotation M E]
AvgJobHt [ooo0 0 0m

Offsets (m)
HNorth 0.000
East 0.000

Combined SF (Grid to Ground):
1.000000000000

Figure 4-95. Grid to Ground - Average Job Height

4. In Origin Point mode, set the following parameters (see
Figure 4-96 on page 4-76):

* Azimuth Rotation, the angle between the axes of the grid and the
ground coordinate systems. This angle defines the reference
direction for ground. To compute the Azimuth Rotation value
using points in the job, tap the List [ ] button.

* Origin Point, a desired grid point from the job as the origin of the
ground coordinates for the Grid to Ground coordinate
transformation. It can be selected from the map or the list of
points in the job.

* Ground Point coordinates for the origin point.

* Combined Scale Factor for this mode is a calculated value. The
value (not equal to “1”’) depends on the height of the origin point.
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The additional reference information at the bottom of the dialog goes
about the combined scale factor computed and the direction of
distance transformation.

Units

EGrld,‘Gmund Para - m
Parameters IOngln Pt
Combined SF Il.l]l]l3329444946
Direction IGrid to Ground

Az Rotation [0°00°00.0 (]
Origin Pt IPlIIIlII_CL

Ground Pt {m)

North 6174067.917
East 409248.298

Combined SF (Grid to Ground):
1.000329444946

Figure 4-96. Grid to Ground - Origin Point

Set the distance and angle units of the job on the Units screen and tap
Next (Figure 4-97). For Optical mode, also select the temperature and

pressure units.

4-76

Distance

|Meters v
Angle

|DMs v
Temperature

|Celsius (=C) »
Pressure

|mmHg v

Figure 4-97. Set Distance and Angle Units
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1. Select either Meters, IFeet (International Feet, 1 Ifoot = 0.3048
Meters), US Feet (1 USFt = 1200/3937 Meters); IFeet and
Inches, or US Feet and Inches (the latter two are calculated
taking into account that 1 Foot = 12 Inches).

be entered as meters, or international feet by

, If the selected units are US Feet, linear values can
N,
% appending “m” or “if” to the entered value.

If the selected units are in meters, then a linear
value in US Feet or International Feet is entered by
appending “f”or “if” to the end of the entered value.

If the selected units are in International Feet, enter
linear values in meters or USfeet by appending
“m”or “f” to the entered value. The appended
characters “m”, “f”, or “if”” are not case insensitive.
You can also enter “M”, “F”, or “IF”.

If the selected units are US or International Feet and
Inches, you can enter feet and inches in the
following formats:

- feet.inches.fracNumerator.fracDenominator
(displays as the next format)

- feet’inches” fracNumerator/fracDenominator

(where the fracDenominator can be either 2, 4, 8, or
16)

2. Select either DMS (degrees, minutes, seconds), Grads (Gons),
Radians (for Cogo use only), or Mils (for Cogo use only). (360
degrees = 400 grads = 2r radians = 6400 mils.)

T3 ENTR L]

separated by “-”, “)” or *;”. Certain angles can be
entered as three points separated by “-”, “)” or *;”.
For instance, a value of 100-101 indicates the

Azimuth or Distance from Point 100 to Point 101.

; Azimuth and distances can be entered as two points
~,

3. For raw measurements in Optical mode only, select either
Celsius (C), or Fahrenheit (F) units of temperature.
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4. For raw measurements in Optical mode only, select either
mmHg, hPa, inHg, or bbar units of atmosphere pressure.

Display

On the Display screen (Figure 4-98), select the Display parameters:
the type of Coordinates displayed, the plane coordinates order, the
reference direction for Azimuth and representation type and the
method for displaying position on the CenterLine (Station or
Chainage). If the Station is selected as representation type to display
position on the CL, set the Full Station value. Then tap Next.

Coord Type

|Gr|:|un|:| v

Coord Order

|Nurthing,Easting,EIevatiun »

Azimuth Origin INurth v
Disp Dir s |Bearing v
Disp CL Pos As v
Full Station  [100.000

I << Back " Next >3 ]

Figure 4-98. Display

Alarms

On the Alarms screen, set alerts for various situations.

1. Check and enable the Audible Alarm field to enable a sound for
alarms in the Controller, Receiver, or Total Station
(Figure 4-99 on page 4-79).

2. Place the check marks, where necessary on the Controller,
GPS+ and Optical tabs to select alerts for various instruments
and situations: low power, memory limited, loosing/gaining
radio link, or fixed solution with GPS receiver, or tracking with
Robotic Total Station.
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G EAEY

Main | Controller | GPS+ | Optical |

Figure 4-99. Alarms

3. Tap the ok [/ ] button to save the settings for the newly
created job. The Connections screen displays (Figure 4-100) if
Prompt at startup is default.

Connections

1. Select the device type GPS (either base or rover) or Optical,
then tap Connect (Figure 4-100).

E Connections " .'
Device

Select device type...

@ ars

(OBase (@) Raver
(O optical IMy Corvertional
[]Bluetooth |cor~f|5

Prarmpt at startup
Connect ]

Figure 4-100. Connections
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Setting Automatic Import of
Localization and Code Library

1. To set parameters for automatic import of global code library
and localization data from the previous job, tap the
Configure » New Jobs icons. The New Jobs screen displays
(Figure 4-101 on page 4-80).

2. Onthe New Jobs screen, select the desired parameters from the

drop-down lists:

* For Import localization from previous job, select from Never
import localization data from the previous job, Always import,
and Prompt to import.

 For Import global code library to job, select from Never import
global code library to job, Always import, and Prompt to import.

il >

Configure

4-80

o

Mew Jobs

Import localization from previous jol
fNever import v

Import global code library to job

|Never import v

Figure 4-101. New Jobs
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Code Settings and Prompts

To set global parameters and prompts for codes, tap the icons
Configure » Codes.

1. On the Code Settings tab select settings for codes and control
codes:

* Select Default New Type for code entry, either Point, Line, or
Area, or select Prompt to receive a prompt for creating a new
code upon saving points.

» Select either Codes or Notes for Data Entry in the field during
survey in the main Topo dialog (Figure 8-18 on page 8-20).

» Set a Code File to use the file’s codes and layers with the
currently selected job.

When using a Code File, the codes immediately
@ become available for selection from the Code drop

down list.

The layers from the Code File display in the Layer

list of the current job only as points are saved with

the file’s codes selected.

» Tap the Browse button to select an XML file to use for the Code
File above. Default code library (TopSURVDefCodeLib.xml) is
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installed automatically on TopSURY installation and can be set to
the Global Code Library.

Type |}(ML Files {*.xml) »
3 ...ard\TPS\TopSURWV\tpsdatal

MNarme |TupSURVDefCudeLib.xml

Figure 4-102. Default Code Library File

* Check mark the Code with Description box to display
descriptions along with code names in the drop-down menu for
Code selection during survey.

* Check mark the Allow Custom box to disable using TopSURV
linework package. In this case, the user can enter any string to
mark it as a control code. TopSURV will not interpret these
control codes.

* Check mark the Allow Persistent box to allow the control codes to
be persistent between recorded points and not cleared when
surveying. This option available, only if the Allow Custom
Control Code option is turned on above.
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* When surveying, if the selected mode is either Line or Area, then
this option selects a Delimiter for entering control codes, along
with codes in a single field, separated by the delimiter.

Configure

T

—>

Codes

Fona coio oo EAED

Codes Settings | Code Prompts

Codes

Default New Type I A
Data Entry Iches v
Code File I—

Code with Description

Control Codes

[] Allow Custom

Allow Persistent

Delimiter ISpal:e b

Figure 4-103. Code Options

2. On the Code Prompts tab, set global prompts for code while
performing TS and GPS Surveys, Stakeout and COGO tasks.
Check mark a corresponding box to enable prompts for codes
(Figure 4-104 on page 4-83).

P/N 7010-0493

EGIDbaI Code Op... [ l b 4 ]
Codes Settings | Code Prompts | |

Prompt for Code in:

[] GPS Survey

[] stakeout
[]coGo

Figure 4-104. Code Prompts
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Customizing Menus

1. Some rarely used functions are not displayed, but can be
enabled. To do this, tap the Configure » Menus icons. The
Config Menus screen displays.

T.E e
- 2 Menu 2
Configure Menus Job

Import v
< >

Sub Menu to Display ~
¥/ Alarms

v|Backup

¥|Codes

v|Coord Sys

v |Display b
< >

Figure 4-105. Config Menus

2. On the Config Menus screen (Figure 4-105), select the desired
menu from the Menu list and choose the necessary options
from the Sub Menu to Display list.

Setting Background Images

To position a geographic image under observed data on the map, use
the Background Images function.

1. To load an image, tap Edit Job » Images.

2. On the Background Images screen (Figure 4-106) select the
image. It is possible to select multiple background images.
Using multiple background images is limited by the amount of
free space in the controller memory.
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3. Tap Add to add the appropriate file to the list.

==
\ﬂ, For... |Filename |Units |
Edit Jof Images v[1... orto12 m

l Prop l lDeIete ” Add l

Figure 4-106. Select Background Images

To be imported into TopSURYV correctly, any images need to be
geo-referenced. GeoTIFF images have their own geo-referenced
data while other images need a separate World file that references
the geographic location of the image. The World file must have
the filename extension associated with the image format (TFW,
JGW or BPW) and should be located in the same directory as the
image file.

(it’s geo-reference point) should be in the job’s
current coordinate system or at least in a very
similar one (e.g., in a corresponding UTM zone).

@ To map a Background Image correctly, the image

If the selected image uses a World File, tap Properties to select
the projection in which the coordinates in the World File are
given.

4. To use a file once it is added, make sure the file is checked in
the list. Tap the ok [/ ] button to open the selected file. If no
world file exists for the background image file selected, a
warning displays, and the Background Images screen will
appear again to select another file.

P/N 7010-0493 4-85



Creating a New Job

Global Settings

Set general settings in TopSURYV if needed to use with the currently
selected job. Tap the Config » Global icons.

1
Configure l:‘ History
Prompt for Connection

Figure 4-107. Global Settings

1. Check and enable the Use Bold Font box to use the bold font on
the controller display to see more clearly.

2. Check and enable the Enable Job History box to save every
surveyor’s operation on the job in a history file.

3. The Prompt for Connection box is checked by default to
display the Connections dialog (Figure 4-100 on page 4-79);
uncheck the box if you want to enable auto connection with the
device.

Backup Jobs

To increase the reliability of work with jobs in TopSURY, a backup
copy is automatically created for the current job. This automatic
renewal occurs about every ten minutes (the corresponding message
appears, see Figure 4-108).

And it is safely stored with a new name, i.e., file_name!YYY-MM-
DD!.tsj.bak in a folder where the original *.tsj file is located.

TopSURYV will create a separate *.bak file for the current job every
time the user opens the *.tsj file during the day with another date.
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But there cannot be more than three such files. If the *.tsj file is
opened in subsequent days, the *.bak files previously formed will be
overwritten to the ones with the newer dates.

Current Job: p0104b

Flease WAIT! The job-backup is in progress

: |I Cancel

l3) \Storage Card

Figure 4-108. Job Backup in Progress

To change the folder for backup copies, tap the Config » Backup
icons. The Backup Config screen displays (Figure 4-109).

* Check mark the Use custom box to activate a field below: either
type in a backup target folder or select it.

* The History field shows how many last copies will be daily
created (three copies by default).
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| 7S [ Tx]

Backup target

Configure Backup

E Use custom

[Storage Card/TPS/TopSUR] |7

History EI

Figure 4-109. Use Custom Destination

Configuring Stake Reports

If necessary, you can configure reports for staking.

1. Tap the Config » Stake Reports icons. The Stake Report
Configurations screen displays a list of default styles of reports
(Figure 4-110).

Y A

Configure Stake Reports

My Point Config Point
My Road Config Road
My Slope Config Slope
My Surface Config  Surface

| oelete | [ edt | [ aon |

Figure 4-110. Stake Report Configuration
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2. You can edit an existing configuration or create a new one.
Select the desired type of configuration and tap Edit or Add,

respectively. The Report Configuration screen displays

(Figure 4-111).

E Report config

Marne Iy Line-Arc Config

Report Type N ArC

Item -
| Design Reference

v oo, Pt

v|Inst, Ht.

v |ES

v Design Pt

v | Design Mote

v|Design Code

v Design M

v Design E

| Design Eley
A DA LIt

(8] () [Edt |

Figure 4-111. Edit Stake Report

3. On the Report Configuration screen:

Edit the Name of the report and select the Report Type on staking
lines, points, roads, slopes, or surfaces from the drop-down list.

Check corresponding boxes near the Items to show appropriate
information in the report.

Use the up and down arrow buttons to move the items.

Tap the Edit button if you want to edit the name of the

highlighted item. Alternatively you can just tap the item to open

the editable field.
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4-90

E Report config

Marne Iy Line-Arc Config

Report Type

Item

| Design Reference
v oo, Pt
v|Inst, Ht.

v |ES

v Design Pt
v | Design Mote
v|Design Code
v Design M

v Design E

| Design Eley

A0 Lt

CoEm

Figure 4-112. Edit Item of Stake Report
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Importing and
Exporting Data

Chapter 5

TopSURYV can import/export data from/to jobs, devices and different
formats. TopSURYV supports all major file formats.

Importing Data

TopSURYV can import points, codes and attributes, Code Libraries,
Roads, Cross Section Templates, Point Lists and Localization data

from another job, from a file, or from another controller device.

Import from Job

1. Tap Import » From Job. The Select Job screen (Figure 5-1)
displays. Highlight the name of the job file in the Job List and
tap Select; or tap Browse to select the Job file from the disk.

;E__‘:_—_" ¥ Select Job
'\) Current Job: p0104b

Fram Job

Created: 02§25f2010
Modified: 04f05f2010
i) \Storage Card

12:08
10:17

Figure 5-1. Select Job
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2. Inthe From <Job> screen (Figure 5-2) select whether points
are to be imported, and if necessary, filter the imported points
either by type, by range and code, or by type, range, and code.
Place appropriate check marks to import along with points
Code Library, Localization, Point Lists, Horizontal Alignments,
Vertical Alignments, X-Section Sets, or Roads.

_

Points
jall Points v

[] code Library
Localization
[]Point Lists
[]Horizontal Aligments
[] vertical Aligments
[]x-Section Sets

[]Roads

Settings MNext ==

Figure 5-2. Import from Job

3. Tap Settings to import points as either Design or Control.

e EAED

Import Points As

Design Points v
[esig PO
Control Points

Figure 5-3. Settings
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4. 1If By Type or By Type, Range and Code is selected in the Points
drop-down menu of the From <Job> screen (Figure 5-2), select
the types of points to be imported on the Point Type(s) to
Import screen (Figure 5-4).

Point Types -
Design Points
% _ontrol Points
Cogo Paints
Ease Station
Topo Paints
Offset Topo Points
Auta Topo Points
Sideshat A
< >

[Select Al l l Check ” Uncheck l

Figure 5-4. Select Point Type(s) to Import

5. If By Range and Code is selected in the Points drop-down list of
the From <Job> screen (Figure 5-2 on page 5-2), on the Points
to Import screen, select the codes and/or the range of points to
be imported (Figure 5-5 on page 5-4).

To select codes, tap the Select button, check the codes

associated with the points to be imported in the Code screen,
and tap the ok [ ./ ] button. The Range of Points sets a range of
point names that should be imported. The symbols ‘), ‘" or “;’

can be used to differentiate individual point names, whereas the
symbol ‘-’ is to be used for specifying a range.
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_

Filter by Codes

ik3

Filter by Range

MName Separator I, v

Use *-* for Range Separator

Figure 5-5. Points to Import

If All or None is selected in the Points drop-down list of the
From <Job> screen, based on the other selections in this
screen, tapping the Next button on subsequent pages will result
in appropriate screens being displayed.

On the Pt List to Imp screen (Figure 5-6) select the point lists to

import.

et List to 1mp

Point Lists |

v|PointList1
PointList2

Check

Select All Uncheck

Figure 5-6. Select Point List(s) to Import

8. Tap Next if other data is chosen to import into the From <Job>
screen. The next screen opens to select other objects (horizontal

5-4
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alignments, vertical alignments, roads or x-section sets) which
are similar to the Pt List to Im screen (Figure 5-6 on page 5-4).
9. In the final screen for importing from a job, the Next button
will disappear. Tap the ok [./ ] button to start the Import
process.
10. When names of these imported objects coincide with existing
ones in the current job, the Duplicate Objects screen

(Figure 5-7) issues a warning that prevents the loss of points,
roads, or point lists.

E Duplicate Points

Warning: Point already exists!

Name: POD2
dN: 6170000.000
dE: 400000.000
dH: 0. 000

O ?
Start Mam
() Prefix? () suffix?
| |
’ Yes ] ’ Yes To All ]
[ skip | [ skipal |

Figure 5-7. Duplicate <Objects>

Select either to overwrite, or to rename, or to save with prefix/suffix.
Then press Yes to accept the decision for one or for all similar cases.
Pressing Skip leaves such objects not imported.

The import process cannot skip duplicate templates.
These objects must be renamed.
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Import from Device

1. Tap Import » From Device to import a job (or any other file)
from one controller to another.
On the Settings screen, select the means of communication,
then tap Next (Figure 5-8).

Com Port [COM1 v

Figure 5-8. Import/Export Settings

2. Choose the location for the imported file, then tap the ok [/ ]
button. The Select directory screen displays (Figure 5-9 on
page 5-6).

\...\TPS\TopSURV\IEFiles}

IZ] A.txt A_POLYGO
A_POINTS.cIf A_POLYGO
A_POINTS.dbf I_POINTS.(
A_POINTS.shp I_POINTS.(

A_POINTS.shx I_POINTS.<
A_POLYGONS.clf I_POINTS.<
A_POLYGONS.dbf [#]I_POLYLINI|

< 4

Figure 5-9. Select Directory
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3. Prepare the other controller device for the export process as
described in the “Export to Device” on page 5-19. Tap the ok
[/ ] button on the Select File screen.

Import from File

1. Tap Import » From File. On the From File screen select the

type of data to be imported, the type of file from which to

import data (Figure 5-10). If needed, check mark a box to set
distance/angle units. Then tap Next.

_' ] (& R |

Fram File

Farmat
|Land}(ML (*.xml)

[ select File Units

Figure 5-10. From File

2. Using the standard Windows® CE interface, browse for the file

to import from or type the name of the file, and tap the ok [ ./ ]
button.

Points from Text File Formats

1. If data type is Points or Point Lists, select the point type to

import from the Data drop-down list (Figure 5-11). If the Text
file type is chosen, check the ASCII File Properties field

buttons, if necessary. These conditions use the same type
attributes and quotes for the text values.
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ronre B3
Data

|P|:|ints
Format

Topcon Text Custom (*.txt) %
[] select File Units

v

ASCII File Properties
Use Type for Attributes
Use Quotes for Text Values

Figure 5-11. From Text File

2. Specify the format in which data is stored in the file
(Figure 5-12).

EText File Format [ b 4

Delimiter

() Space (@)
() Tabs () other II v

[]Header in First Row
File Style

|Name,N(Lat ),E{Lon),Elev,Cod +

[ pelete | [ Edit || add |

Figure 5-12. Text File Format
¢ Choose the delimiter between different fields.

e If a header is provided in the first row of the file, check the
appropriate field.

* Select the File Format (the order of the fields), using the

drop-down menu. Or create a new file format using the
procedure below.

5-8 TopSURYV User’s Manual



3.

4.

Importing Data

Tap Next to select the coordinate system of the data in the
imported file.

Tap the ok [./ ] button to start the import process.

To customize the format, enter the order of data using the Custom
Style screen (Figure 5-13).

1.
2.

Tap Add Format on the Text File Format screen.

Select parameters from the Available list and tap the right arrow
button to move them to the Order list.

To arrange the options in sequence, use the up and down arrow
buttons. The order of items in the Order list should correspond
to that in the selected file.

Tap Save (Figure 5-13). The combination will display in the
Select File Format drop-down list on the Text File Format
screen.

E Custom Style
Available -~

Ell ht

Notes

Codes&Descriptions
Codes&5trings
Codes&Attributes v

(s](e]

Order |

NdLa0) o
E(Lon)

E::?dves E]

Figure 5-13. Custom Style
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Points from AutoCAD DXF and AutoCAD 2000
Drawing Files

1. If the AutoCAD DXF or AutoCAD 2000 Drawing format is
selected, select the Point Type on the From File screen
(Figure 5-14).

Data

|P|:|ints v
Format
[AutoCAD DXF (*.dxf) »

[] select File Units

Figure 5-14. From AutoCAD DXF

TopSURYV only imports AutoCAD 2000 format
@ DWG files. Support for DWG 2008 is optional and

selected during TopSURY installation.

TopSURYV imports layers from DWG/DXF files,

along with the appropriate data types.

2. Tap the Settings button. On the Settings screen, select the
following drawing styles to represent points and lines
(Figure 5-15 on page 5-11).

* Check and enable the Import block base points box to import
central points in blocks as points.

* Check and enable the Load as background image box to load
data as background.
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E Settings - m

Import Points As
v

[] 1mport block base points

Load as background

Figure 5-15. Settings

Points from ESRI Shape

A shapefile is actually a set of several files: mandatory four files
(*.shp, *.shx, *.dbf, *.cIf) and some optional files. A set is created for
forms lying on one layer and having the same code.

If the ESRI Shape format is selected for points import, TopSURV will
prompt to select only the file with “.shp” extension, other files are
picked up automatically.

~ ~ When importing shapefiles you need to repeat the
import process for every desired code.

In addition TopSURYV can optionally import a *.prj file associated
with the shapefile (*.shp) being imported.

files, available for selection during install. They
require 4MB of storage and should not be used
where memory is limited. The additional support
files will be installed as a separate process after the
initial install of the program is completed.

@ The SHP support libraries are optional installation
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Points from TDS Format

Import points from the TDS format allows choosing to import points
as either Design or Control (Figure 5-16).

Data

|P|:|ints v
Format
TDS (*.crs) »

[] select File Units

Figure 5-16. From TDS Coordinates

Tap Next to follow next screens with the help of the import wizard.

Importing Lines

TopSURY linework consists of lines and points, whereas imported
linework contains no points; it includes positions only (names start
with a question mark). Figure 5-17 on page 5-13 illustrates the
contents of the imported linework.

If the AutoCAD DXF or AutoCAD 200 Drawing format is selected for
lines import, the Settings button on the From File screen allows
choosing styles to represent points and lines.

* Import block base points — enable to import central points in
blocks as points.

* Load as background — enable to load data as background.

TopSURYV only imports AutoCAD 2000 format
DWG files. Support for DWG 2008 is optional and
selected during TopSURY installation.
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G EAE3
Linework I
(#][List of Po ~ [ 1

7 #0000!
7 #00001

@ 7 #00001
7 #00001
7 #00001

7 #0000!
? #00001™

(#]]< .5 |osm )

[Puint Infcll Sl Pts v]

Figure 5-17. Edit Imported Linework
Importing Areas
For Area data, you can import data from ESRI Shape (*.shp).

@ Line and Area shape files are imported into the Line
and Area layers.

Importing Localization

Control Points are imported together with Localization data.

Importing Multiple Data Types
1. On the Data selection screen, select specific data type from the
appropriate file (Figure 5-18 on page 5-14).
2. Select an object to import and tap Next to start the import
process.

TopSURYV imports layers to DWG/DXF files, along
with the appropriate data types.
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File contents

Lines LR
Parcels {Areas) [0

Alignments ’17

X-Sections e
Surfaces

[ ] Point Lists 2
Codes [T

Figure 5-18. Import From LandXML

Importing Code Library

Code Library is a set of codes with attributes used in the job. You can
import code libraries from the formats: Topcon XML (*.xml), Topcon
Text (*.tdd), DBF (*.dbf), Topcon Text Custom (*.txt), or Carlson
(*.FCL).

All layers are automatically imported whether they are with codes or
not.

Topcon Text Custom format allows importing code library from a
comma delimited file.

Importing Roads

The header of the TopSURV Road format contains the starting
azimuth if the Road is not a straight line.

TopSURYV can import data, refer to the TopSURV

@ For details on the formats of the files from which
Reference Manual.
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Exporting Data

TopSURYV can export Points, Lines, Areas, Point Lists, Code Library,
Raw Data, Horizontal Alignments, Vertical Alignments, X-Section
Sets, Roads, X-Section Templates, Localization, Scanning Data, Road
Survey, Job History, TINs, Layer States, Stakeout Reports, and
Multiple Data to another job, to a file, and to another controller
device. Sessions can be exported to receivers (in GPS+ mode).

Export to Job

1. Select the Export » To Job icons. On the Select Job screen,
highlight the destination job to export to and tap Select. If there
is no job in the Job List that you want, press the Browse button
to select a job from the disk (Figure 5-19).

Created: 02§25f2010 12:08
Modified: 04f13f2010 13:03
l3) \Storage Card

[ Exit || New |[Browse | select |

Figure 5-19. Select Job

2. Inthe To <Job> screen select whether points are to be exported,
and if necessary, filter the exported points either by type, by
range and code, or by type, range, and code (Figure 5-20 on
page 5-16). Also, place appropriate check marks, if the
following data should be exported along with points: Code
Library, Localization, Point Lists, Horizontal Alignment,
Vertical Alignment, X-Section Sets or Roads.

3. Tap the Next button.
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3 1o kRisHaA [/ | 8¢

Points
|l Points v

Code Library
Localization

Point Lists

Horizontal Aligments

vertical Aligments

X-Section Sets
Road String Sets

l Settings l l <« Back l lNext 53 l

Figure 5-20. Export to Job

4. Use the Settings button to export points as either Design or
Control.

5. If By Type or By Type, Range and Code was selected in the
Points drop-down list, on the Point Type(s) to Export screen,
select the types of points to be exported (Figure 5-21).

Ept Type(s) To Exp b 4

Point Types -~
Design Points
¥ Control Points
Cogo Points
Base Station
Topo Points
Offset Topo Points
Auto Topo Points

Sideshot A
< >

Select All Check Uncheck

Figure 5-21. Select Point Type(s) to Export

6. If By Range and Code was selected in the Points drop-down
menu, on the Points to Export screen, select the codes and/or
the range of points to be exported (Figure 5-22 on page 5-17).
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¥ —dPoints to Export m
Filter by Codes

2

Filter by Range
100-110

MName Separator I, v

Use *-* for Range Separator

Figure 5-22. Points to Export

7. To select codes, tap the Select button. Check mark the codes
associated with the points to be exported in the Code screen,

and tap he ok [./ ] button. The Range of Points sets a range of

[} )

point names that should be exported. The symbols *,’, “.” or *;
can be used to differentiate individual point names, whereas the
symbol ‘-’ is to be used for specifying a range.

[EE T~

Select Codes
1
v 2
jk3
p
pd
ep
SW
ws
pa

[ uncheck || check || select |

Figure 5-23. Select Code
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8.

10.

11.

12.

If All or None is selected in the Points drop-down list of the
To<Job> screen, based on the other selections in this screen,
tapping the Next button on the subsequent pages will result in
appropriate screens being displayed.

In the Point List(s) to Export screen select the point lists to
export (Figure 5-24).

Point Lists |
v|PointList1
PointList2

Select All Check Uncheck

Figure 5-24. Select Point List(s) to Export

Tap Next (if available) to choose other data to export
(horizontal alignments, vertical alignments, roads or x-section
sets) that is similar to the point lists selection. Once the button
becomes grayed out, tap he ok [/ ] button to start the export
process.

When names of these exported objects coincide with existing
ones in the job, the Duplicate Objects screen issues a warning
that prevents the loss of points, roads, or point lists (Figure 5-25
on page 5-19).

Select either to overwrite, or to rename, or to save with prefix/
suffix. Then press Yes to accept the decision for one or for all
similar cases. Pressing SKip leave such objects not exported.
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E Duplicate Points

Warning: Point already exists!

Name:

A,

P110_CL
dN:  4089.715
dE: 9150.744

%

Rename?

Start Mam g

() Prefix? () suffix?

| |

’ Yes ] ’ Yes To All ]
[ skip | [ skipal |

Figure 5-25. Duplicate <Objects>

Export to Dev

ice

1. Tap Export » To Device.

2. On the (Import/Export) Settings screen (Figure 5-26), select
the means of connection using the Com Port drop-down list,
then tap Next. The Select file screen displays (Figure 5-26).

Expar

FE % |
Com Port [COM1 v

Figure 5

P/N 7010-0493

-26. Import/Export Settings

Exporting Data
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3. Choose the files to be exported.

Type |AII Files (*.*) v

\Storage Card

5

ROAD. tsj-journal

< 4

Name  [KRISHA.tsj

Figure 5-27. Select File to Export

4. Prepare the other controller device for the export process as
described above in the Import section.

5. Taphe ok [/ ] button to start the export process of the selected
file and to return to the main screen if it is successful.

Export to File

1. Tap Export » To File icons.
In the To File screen, select the type of data to be exported and
the type of file to which to export the data (see Figure 5-28 on
page 5-21). Tap the Next button.

TopSURYV can export data to DWG files only in
AutoCAD 2000 format.

2. For Points and Point Lists data types, if desired, check mark the
appropriate fields to choose the data being exported:

— Check and enable the Select Types of the Points box if not all
types of points should be exported. In this case the Point
Types to Export screen first displays.

— Check and enable the Use Filters box if filters (by code and
by range) should be used for exported points.
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— Check and enable the Select File Units box to set units.

N

Export To File

Data

Format

[ ~ |

[Points v

|Lan|:|)(ML (*.xml)

[ select File Units

[]use Filters

[ ] select Types Of The Points

v

Figure 5-28. Export to File

Points to Topcon Text Custom

1. If data type is Points or Point Lists, select the point type to

export.

2. Check and enable the ASCII File Properties field boxes, if
necessary (Figure 5-29). These conditions use the same type for

the attributes and quotes for the text values.

[ T |

Data

|P|:|ints v
Format

Topcon Text Custom (*.txt) %
[ select File Units

[ ] select Types Of The Points
[]use Filters

ASCII File Properties
Use Type for Attributes
Use Quotes for Text Values

P/N 7010-0493

Figure 5-29. To File
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3. Tapping the Next button opens the Point Type(s) to Export
(page 5-16) and the Point To Export (page 5-16) screens if the
respective fields have been checked.

4. When all data export conditions have been specified, a screen to
choose the file opens (Figure 5-30). Using the Windows CE
interface, browse for the file to export to or type the name of the
file, and tap the ok [./ ] button.

Type |Text Files (*.txt) »
\...\TPS\TopSURV\IEFiles

5

Name |A.txt

Figure 5-30. Select the File

5. On the Text File Format screen, (Figure 5-31), specify data
format parameters in the file:

Delimiter

() Space (@)
() Tabs () other II v

[]Header in First Row
File Style

|Name,N(Lat ),E{Lon),Elev,Cod +

[ pelete | [ Edit || add |

Figure 5-31. Text File Format
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* Select the delimiting symbol (Delimiter) between the data in
the exported file; select either Space, Comma, Tabs, or Other
from the list.

* Check and enable the Header in First Row box, if a header is
provided in the first row of the file, check the appropriate
field.

* Select the File Style (the order of the fields), using the drop-
down list below, or create a new file format using the
procedure below.

Tap Next to select the coordinate system of the data in the
imported file.

Tap the ok [/ ] button to start the export process.

To customize the file format, enter the order of data using the
Custom Style screen (Figure 5-32 on page 5-24).

1.

Tap Add (Edit) Format on the Text File Format screen
(Figure 5-31 on page 5-22).

Select items from the Available list and tap the right arrow
button to move them to the Order list (Figure 5-32 on page 5-
24).

To arrange the options in sequence, use the up and down arrow

buttons. The order of items in the Order list should correspond
to that in the selected file.

Tap Save. The combination will display in the Select File
Format drop-down list on the Text File Format screen
(Figure 5-31 on page 5-22).
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Points to Text Custom Report, Sokkia SDR and

[Fosinse KN
Available -~

Ell ht

Notes

Codes&Descriptions
Codes&5trings
Codes&Attributes v

(s](e]

Order |

Name

H{Lat) E]
E(Lon)

Elev

Codes E]

Save

Figure 5-32. Custom Style

Topcon 3DMC Project

Note that text custom report files cannot be imported back to
TopSURV. If one of these formats is selected, the To File screen

contains the Code Style button (Figure 5-33).

[ I * |
Data
|P0ints v

Farmat
Topcon 30MC Project (*.t03)

[ select File Units
[ ]select Types Of The Points
[Juse Fiters

Figure 5-33. To Text Custom Report

1. Tap the Code Style button to select or create a desired format
for information on every point to arrange it on one line in the

exported file.

9-24
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2. Tap the Next button to follow next screens which are similar to
those for the Topcon Text Custom format.

Points to AutoCAD DXF and AutoCAD 2000
Drawing

1. When exporting points to the AutoCAD DXF or AutoCAD
Drawing format, you can select an option not to export code
attributes on the To File screen (Figure 5-34).

(& BT * |

Data

|P|:|ints v
Format
[AutoCAD DXF (*.dxf) »

[ select File Units
[ ] select Types Of The Points
[]use Filters

Code Style " Settings l l Next >> l

Figure 5-34. AutoCAD DXF

2. Tap the Code Style button on the To File screen to set a format
for point properties (codes, control codes, strings, and notes) to
export to the file.

3. Tap the Settings button to select the desired drawing point style
to represent points in AutoCAD:

— select AutoCAD Points to represent points as positions
without icons and descriptions such as names, elevations,
codes and attributes.

— select AutoCAD Points with Text Fields to represent points
with descriptions such as names, elevations, codes and
attributes. Each description is given in text format and on a
separate layer.

Note that for this point style AutoCAD does not decode
descriptions for points, it only provides text fields for them.
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— select Carlson Point Blocks to represent points and
descriptions for them as block references.

— select TopSURYV Point Blocks to represent points with the
names as block references.

4. If necessary, uncheck the Use 3D coordinates box not to use 3D
coordinates.

5. You may want to set the height of text fonts to show the text in
AutoCAD. For this, check mark the Use text font height box to
open a field to manually/automatically enter the desired value
in CAD units. Then tap the ok [ ./ ] button (Figure 5-35).

Point style:

|Aut0CAD Paints with Text Fields v

Use 30 coordinates

ID CAD unit(s)

Figure 5-35. Settings
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Points to ESRI Shape Format

When exporting points to the ESRI Shape format, check and enable
the Store Description as Attribute box on the To File screen to save
point descriptions as attributes in the file (Figure 5-36).

Data
|P|:|ints v

Format
IESRI Shape (*.shp) »

[ select File Units
[ ] select Types Of The Points
[]use Filters

|:| Store Description as Attribu

Figure 5-36. ESRI Shape

A shapefile is actually a set of several files: mandatory four files
(*.shp, *.shx, *.dbf, *.clf) and some optional files. A set is created for
forms lying on one layer and having the same code.

While exporting, TopSURYV creates a set of four mandatory files for
every code and named by the given code in the same selected
directory. Also in this directory, a folder that contains all photo notes
exported with the points is created.

In addition TopSURYV can optionally create a *.prj file associated with
the shapefile (*.shp) being exported. If this file is required, select the
corresponding option while installing TopSURV.

The SHP support libraries are optional installation

@ files, available for selection during install. They
require 4MB of storage and should not be used
where memory is limited. The additional support
files will be installed as a separate process after the
initial install of the program is completed.
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Points to TDS

When selected, the TDS Coordinate format demands points have only
numerical names. The 7o File screen (Figure 5-37) displays a number
at which TopSURYV will start renaming points with alphanumeric
names.

Data

|P|:|ints v
Format
TDS (*.crs) »

[ select File Units
[ ] select Types Of The Points
[]use Filters

Alphanumeric Points will |09
be Renumbered Starting

Figure 5-37. To TDS

Exporting Lines

TopSURYV supports export of lines to the formats: Topcon Text
Custom (*.txt), Topcon 3D (*.In3), AutoCAD DXF (*.dxf), AutoCAD
Drawing (*.dwg), ESRI Shape (*.shp), LandXML (*.xml), KOF
(*.kof), Topcon 3D Linework (*.In3), Microstation 95/ISFF (*.dgn),
MX GENIO (*.txt), SBG Pxy (*.PXY) or SBG Geo (*.Geo).

The options on the To File screen depend on the format selected for
export of lines from the current job. These options are much similar to
those available for export of Points data.

For most formats you can:

* check and enable the Select File Units option to select units for
the data exported. Depending on the data and format selected,
you can set only distance, or distance and angle units if they are
available for setting.
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* check and enable the Export Areas as Lines option if areas should
be exported as lines.

[ R |

Data
|Lines v

Farmat

Topcan 30MC (*.In3)

[ select File Units

Export Areas as Lines

Figure 5-38. Lines to File

When exporting Lines to AutoCAD DXF or AutoCAD 2000 Drawing
files:

» Use the Code Style button to set a format for line properties
(codes, control codes, strings and notes) to export to the file.

 Use the Settings button to select drawing styles to represent lines
in AutoCAD:

— select AutoCAD Lines to represent lines without names.

—select AutoCAD Lines with Text Fields to represent lines, lines
names, and vertex elevations.

— select TopSURYV Line Blocks to represent lines with the lines
names as block references.
6. If necessary, uncheck the Use 3D coordinates box not to use 3D
coordinates.

* You may want to set the height of text fonts to show the text in
AutoCAD. For this, check mark the Use text font height box to
open a field to manually/automatically enter the desired value in

CAD units. Then tap the ok [./ ] button (Figure 5-39).
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E Settings

Line style:

JBULOCAD Lines v

Use 30 coordinates

ID CAD unit(s)

Figure 5-39. Settings for Lines

Exporting Raw Data

TopSURYV supports export of raw data to the formats:

LandXML (*.xml), Topcon FC-5 (*.fc5), Topcon GTS210/310/10
(*.raw), Topcon GTS-6 (*.gts6), Topcon FC-6/GTS-7 (*.gts7), Topcon
GTS-7 +(*.gts7), SurvCE (*.RW5), TDS (*.RAW), MOSS Survey
(*.txt), Field Book (*.fbk), TVF (*.tvf), TVF with Code Style (*.tvf),
KOF (*kof), Berlin GNSS-Messprotocoll (*.txt) or Berlin GNSS-
Mittelwerte (*.txt), Sokkia SDR33 (*.sdr).

When choosing LandXML, Topcon FC-6/GTS-7, Topcon GTS-7 +,
SurvCE, TDS Raw Data, Field Book, KOF or Sokkia SDR33 format
files, select the type of raw data to export: either Export TS Raw Data
and/or Export GPS Raw Data.

In addition, being exported to TDS Raw Data file, raw data can be
saved in a format compatible with the FBK format. Selection of the
FBK Compatible option is available if control codes are saved as
notes. When selected, the FBK Compatible option demands points
have only numerical names. The screen displays a number at which
TopSURYV will start renaming points with alphanumeric names
(Figure 5-40).
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(& BT * |

Data

|Raw Data v
Format
TDS (*.RAW) v

[ select File Units
Export TS Raw Data
Export GPS Raw Data
Select additional Point Types
[] Control Codes as Notes
FBK Compatible

Figure 5-40. Export Raw Data To TDS Raw Data

Code, Attributes, String, Note, Control Code, Photo
@ Name and Control flag are also exported with GPS
and TS raw data into LandXML.

The formats Topcon FC-5, Topcon GTS210/310/10, Topcon GTS-6,
and MOSS Survey are allowed for only TS raw data export.

The formats TVFE, TVF with Code Style, Berlin GNSS-Messprotocoll
or Berlin GNSS- Mittelwerte provide the export of only GPS data.

Raw Data To Topcon FC-6/GTS-7 and GTS-7+

When using Topcon FC-6/GTS-7 (*.gts7), Topcon GTS-7 +(*.gts7)
format, you are able to automatically replace all alphanumeric names
with numeric ones during GPS Raw data export.

Check mark the Rename alphanumeric point option to enable
renaming points with alphanumeric names for numeric ones. Putting
a tick in this box will show the Alphanumeric Points will be
Renumbered Starting field with a starting figure for numbering (see
Figure 5-41 on page 5-32).

P/N 7010-0493 5-31



Importing and Exporting Data

R

Data

Data

|Raw Data v |Raw Data v
Format Format

Topcon FC-6fGTS-7 (*.gts7) 1% |Tl:lpl:l:ln FC-6f/GTS-7 (*.gts7)
[ select File Units [] select File units

Export TS Raw Data Export TS Raw Data

Export GP5 Raw Data Export GPS Raw Data
|:| Rename alphanumeric point —P fename alphanumeric point

Alphanumeric Points will |09
be Renumbered Starting

Figure 5-41. To Topcon FC-6/GTS-7

Raw Data To SurvCE

When using SurvCE (* RWS5) format, two additional options are
available for selection (see Figure 5-42).

Data

|Raw Data
Format

3
[ select File Units

Export TS Raw Data

Export GPS Raw Data

[ ] select additional Point Types
[ ] Export GPS points as SP po

v

Figure 5-42. To SurvCE

1. Check mark the Select Additional Point Types box to enable

storing Design, Control, COGO and/or Manually entered points
during export of raw data (Figure 5-43).
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2. Export GPS points as SP points — check mark this box to save

GPS points as manually entered points (Store Points in the
Carlson SurvCE RWS5 format).

Ept Type(s) To Exp b 4

Point Types |
Design Points

¥ Control Points
Cogo Points
Manually Typed

Select All Check || Uncheck

Figure 5-43. Points Types To Export

Raw Data To Sokkia SDR33

When using Sokkia SDR33 (*.sdr) format, you are able to choose TS
and DL data, and/or GPS raw data to export (Figure 5-44). You can
set file units and export points as manually entered:

[~ I |

Data

|Raw Data
Format
[5okkia SDR33 (*.sdr) v

v

[ select File Units

Export TS and DL Raw Data
Export GPS Raw Data

[ ] select additional Point Types

Figure 5-44. To Sokkia SDR33

Resection, Stakeout and Topography data are exported to this format.
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Exporting Localization

You can export Localization data to the following formats:
Topcon 3DMC (*.gc3), Topcon 3DMC Project (*.tp3), TDS (*.RAW)
and Carlson (*.loc).

These formats allow only WGS84 -> Local type of localization (for
details, see “Localization” on page 8-2).

Control Points are exported together with Localization data.

Export of Localization data to these formats is also
available through the Localization screen.

Exporting Job History

You can export Job History data to CSV (Comma delimited) (*.csv),
and Text report (*.txt) files.

The CSV file contains information on all operations performed in the
job and the Text Report contains data about total station points and
resection.

The Job History file is formed if the Enable Job History box is check
marked on the Global Settings screen.

Exporting TINs

TopSURY stores surfaces in TN3 files in the DTM directory. Select a
desired TN3 file to export AutoCAD DXF (*.dxf), AutoCAD Drawing
(*.dwg), or LandXML (*.xml) files.

Exporting Multiple Data

For Multiple data, you can export to the following formats:

Topcon Text Custom (*.txt), AutoCAD DXF (*.dxf), AutoCAD
Drawing (*.dwg), ESRI Shape (*.shp), LandXML (*.xml), KOF
(*.kof), Microstation 95/ISFF (*.dgn), MX GENIO (*.txt), SBG Pxy
(*.PXY), or SBG Geo (*.Geo).

Each format is intended for storing a certain data group. Options
specific for every data type in this group will be presented for
Multiple data on the To File screen.
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For details on the formats of the files to which TopSURV can export
data, refer to TopSURV Reference Manual.

Exporting GPS Sessions to the
Receiver

1. This function is available in PP Static survey mode.
To export the GPS session to the receiver, establish a
connection between the controller and the applicable receiver,
then tap Export » Sessions (Figure 5-45).

E Sessions 4
up n

3 | Receivers Go to sleep mode
Expor GPS Session E-Hiper+

Active Sessions E] >

1D Type Start Day o
Sitel Static Sun 4

>

Figure 5-45. Job Session

2. On the Sessions screen (Figure 5-45), select the sessions to
export in the left panel and tap the [#] button. The sessions to
be exported are displayed in the right panel.

3. Check and enable the Goto sleep mode box to put the receiver
into sleep mode.

4. If it is necessary to edit the sessions, select the Edit Session
option from the Help Icon menu in the upper-left corner of the
screen.

5. Tap the Export button. The session will be transmitted to the
receiver.
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Notes:
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Chapter 6

Storing Data

All the data used in the TopSURYV application is stored in a database.
The types of data stored include points, codes, layers, roads, linework,
raw data, and survey sessions for post-processing.

 To edit any object properties, double-click on the
object or select the object and tap the Edit button.

Editing Points

To edit the job points, tap Edit Job » Points. The Points screen
displays (Figure 6-1).

_ |~

Edit Job Paints

woT2
¢ DRAN

&4 DRAN1

&4 DRANZ2 I{1)

Fra LT TFAY -

< >

l Find Code l l Find Point l
Find Next

[ edt | [ add |

Figure 6-1. Points

1. To edit a point, either double-tap the point or select from the list
and tap the Edit button. Enter all necessary changes and tap the

ok [/ ] button to save the changes.
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2. To find a point by name, tap the Find by Point button on the
Points screen and insert the whole name or a part of the name
(in the latter case, select the Match partial name field). Tap
Search. The first point satisfying the search criterion is
highlighted in the list on the Points screen. Tap the Find Next
button to find another point with the same name.

3. To find a point by code, tap the Find by Code button on the
Points screen and select the code from the drop-down list (in
the latter case, select the Match partial name field). Tap Search.
The first point satisfying the search criterion is highlighted in
the list on the Points screen. Tap the Find Next button to find
another point with the same code.

4. On the Point Info tab, enter new information on the point: the
name, code, and note if preferred (Figure 6-2). The screen will
auto-hide and show the string input box based on the code type.
All line and area codes will display the string field while all
point codes will hide the string field. Code needs to be defined
at the time it is entered if it is not an existing code.

Point |Layer,‘5tyle ]Phutu Note ]

[®] Point 113

. Code NAIL
T
Note |

Local{m}

North |1462. 188
East |1533.|359
Ele¥ |213.425

[] control Point

Figure 6-2. Enter New Point Information

e Use the icon next to the Attributes List icon to add points
with Line and Area codes the end/start of a line and to insert a
point to a line out of sequence.

5. To set the code and attributes available for the code chosen, tap
the Attributes List icon [g=] (Figure 6-3 on page 6-3)
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¢ On the Point Attributes screen, select the desired code from
the drop-down list. A symbol will show the code entity type

(E' Point, Line, or [¢] Area).

¢ Set one or two control codes in the lower field from the
available ones for a Code Style of Line or Area.

The Control Code is a special type of code that is
@ used by the graphic tool for the interpretation of
survey results.

The supported control codes (AS, AE, C, R) control line behavior
when creating arcs, closure of lines, and rectangles respectively.

The AS control code indicates the start of an arc, and the AE control
code indicates the end of the arc. Arc parameters are determined
using additional points in the line.

To use your own control codes, check and enable the Allow Custom
Control Code box on the Global screen (Figure 4-107 on page 4-86).
In this case, you can enter any string to mark it as a control code,
TopSURYV will not interpret these control codes.

P roint attributes.... [Nl I3
Code IIn gbr -

Ctrl Code IE v
|2 v

12, pin 4

l Props " Repeat l Default

l Multiple Codes

Figure 6-3. Point Attributes

* The field, marked by the sign, is used for entering a string

to generate a line for a Code Style of Line or Area. Code
Style is set when editing the code.
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* The lower field shows the available attributes. Tap on the
attribute to provide a field to enter its value.

 Tap the Properties button to view the ranges for the
attributes. Attributes can only be added on the Feature-
Attributes screen when adding a code.

» Tap the Repeat button to erase the entered values.
* Tap the Default button to set default values.

* Tap the Multiple Codes button to edit multiple codes and
strings. Multiple codes and strings associated with a point
make the point a part of numerous lines.

6. On the Layer/Style tab (Figure 6-4), select the layer that the
point will be stored to and the plotting properties to represent
the point on the selected layer. (If needed, tap the List )

button to edit layers.)

Layer I{By Code> »
Point Style

I illed Circle

Cl:lll:lr

Figure 6-4. Set Layer and Point Style

7. On the Photo Note tab (see Figure 6-5 on page 6-5), add a
photo comment on the point.

» Tap the Add/Edit button to open the Browse screen to select
the image or to use the camera on GMS-2, GMS-2 Pro or
GRS-1 to Capture a new picture).

* To erase the image, use the Delete button.
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Edit Point [ 3¢ |

LayeriStyle | Phata Mote

<<
==
Erowse

Capture
[Delete] Edit FH Add v|

Figure 6-5. Add Photo Note

Editing Points

8. If the point is contained in multiple point objects, these points
will display in the Check Points tab on the Edit Point screen.

EZor — EAED

Check Points | wa | Photo Mote E[

Marne | dn | dE

100 4.763 -0.001

100 12,275 0.000

< ' >

Figure 6-6. Check Points

9. When editing a point which has a station available for Weighted
averaging, the WA tab will display on the Edit Point screen. The
WA tab displays coordinate residuals of the check point. Tap the
Use In WA/Exclude from WA button to control either to use or
not to use the station as a weighted average (see Figure 6-7 on

page 6-6).
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Check Paints | WA | Phota Mote Elj

Marmne | M Resid | E Resid
100 0,000 0,000

B0 4,763 -0,001

B0 12,275 0.000

< >

Figure 6-7. Weighted Average

10. To add a point manually, tap the Add button on the Points
screen. If it is necessary to use the point as the Control point,
check mark this box.

11. To enter a PTL point, turn on the PTL Mode using the Help
Icon menu in the top-left corner of the Points screen. When
adding or editing a PTL point, insert the starting and ending
reference points and the PTL offsets: offset from the starting
point along the reference line, horizontal offset from the
reference line, and the height offset with respect to the starting
point (Figure 6-8).

= edit point 7]
Paint Info | Layer/Style | PTL | Pho 4

Start Ref Pt ||

PTL Offsets(m)

Line IlD .0oo
Offset IlD .0oo

Ell ht IlS?.DDD

End Ref Pt 101

Figure 6-8. Edit PTL Point
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Storing Points

You can store points in the TopSURV database as stand-alone points,
linework, and open polylines or areas (closed polylines) by using an
appropriate Code Style for these points.

Stand-alone Points

Points which have no codes, or have codes of the Point type but no
strings associated with the codes, are simply stored as points
(Figure 6-9).

E Code i E Add Paint - m
. nip Point | Laver/Style | Phato Note
Desc T — CE )
e  [moeemy| _y | Ooe [ v
Layer |5t v [:]
MNote
Bt Grid: SK1942-Zone_7 © ...(m)
Style Morth |6179450.983
o IFiIIed Circle + East |499131‘5gg
Ell ht [ize.575
[ cantrol Paint

Figure 6-9. Code of Point Type

The map shows the points as stand-alone in the selected style
(Figure 6-10).

‘E 20m [~
=)

101 E

102 * @

. )

Figure 6-10. Map View for Stand-alone Points
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Linework

To store the points that will be connected to form a linework, select
the same unique combination of codes and strings. Select the codes of
the Line type to use for such points (Figure 6-11).

1. All points with the same code-string combination are connected
in the order of measurement to form a line.

2. Points can also be associated with multiple codes and strings,
thus making the point a part of numerous lines.

R CAES
Desc Ifarm |§| it I
T4pe e 9 [ code o
Layer Ist v E] . I = -
MNote |
[Puint| Line |Attribute] Localim)
Style Morth I1DDD.DDD
I |Dash L East I1DDD.DDD
Elev I1DD.DDD
width 3Pt~
[] control Point

Figure 6-11. Code of Line Type

The map shows the points connected into a line in the selected style
(Figure 6-12).

e 0]

T—2om
N

10000

/\jmm

RE=EEED

Figure 6-12. Map View for Line Points
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Linework Package

Additional manipulations of linework can be performed using control
codes for the points with the same code-string combination. Up to
two control codes can be specified for every code associated with a
point to store the points which will be connected to form open or
closed polylines. Select the codes of the Line type to use for such
points.

The supported control codes of AS, AE, C, and R control line
behavior by allowing creation of arcs, closure of lines and creation of
rectangles, respectively. The delimiter is set in the Global Code
Options screen (see Figure 4-107 on page 4-86).

Code Attributes - F‘thD ND! U Paint | Layer/Style | Phota Note

[] code M [@] Fort |1—
ctrlCode  |aE v — [7] Code L.AE]
B 5 | @r e &

MNote |
Local(rm)

Narth IlDDD.DDD
East I1DDD.DDD
Elew IlDD.DDD

[] control Point

Multiple Codes

Figure 6-13. Code of Line Type with Control Code

1. The AS control code indicates the start of an arc; the AE
control code indicates the end of the arc. Arc parameters are
determined by the presence of additional points in the line.

* These points can create the line segment with the arc start/or
end point which will act as the tangent to the arc.

* If only one point is between the arc start and end points, the
arc is formed such that all the three points lie on the arc. If
there are two, or more than two points, between the points
with the AS and AE control codes, the points are all
connected by straight line segments.
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2. The R control code is applied to the third point of a three point
polyline, and results in the automatic creation of a fourth point
of a parallelogram whose diagonal is specified by the first and
the third point (Figure 6-14).

3. When the C control code is applied to a point, it connects it to
the starting point of the line, thus closing the line.

The map shows the points connected into a line in the selected style.

T—oam (-]
10000 %

1 10001 @

)]

Figure 6-14. Map View for Line Pints with Control Codes

TopSURV will not use this linework package if the Allow Custom
Control Code box on the Global screen is check marked (see

Figure 4-107 on page 4-86). In this case, the user can enter any string
to mark it as a control code. TopSURYV will not interpret these control
codes.
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Area

Areas are simply closed lines formed by points with the codes of the

Storing Points

Area type and the same code-string combination (Figure 6-15).

Name pt_p

Desc Ipillar
Type IArea v

Layer Ist v E]
PuintlLine Area | Attribute

Style
Fill Style |m v

Transparency (5o o

o EAEd

Point | Layer/Style | Phato Mote

[@] Paint

[¢] code  [ala v
— =
Mote |

Grid: SK1942-Zone_7 : ...(m)

Narth |E| 179630.983
East |409381.628
Ell ht |186.6?5

[] control Point

Figure 6-15. Code of Area Type

The map shows the points connected into a line and the area that can

be filled with the selected style (Figure 6-16).

Figure 6-16. Map View for Area Points

P/N 7010-0493

6-11




Storing Data

Editing Codes

To edit codes and attributes, tap Edit Job » Codes. Codes already in
use cannot be edited or deleted. The Code - Attributes screen displays

(Figure 6-17).

[

o

Edit Job

—>

Codes

ECDdE - Attributes
Code |Descripti... |
ﬂbd_fm farm Del
Z‘In_gb qgreen br...

[ ]pt Edit

t_p pillar

Attributes

12; tel

s

Del

Edit

£](2][e] [e][elz

Figure 6-17. Code - Attributes

1. To add a code, tap the Add button on the right side of the
screen. The Code screen displays.

* Enter the code name and description (if needed).

* Select the type of code (from Point, Line, Area). A symbol

will show the code type ( Point, Line, or [¢] Area).
Select the layer that the code will be stored to. Set the Code
Style to represent points, lines and areas with this code on the
selected layer (Figure 6-18 on page 6-13). On the Attributes
tab, select a radio button for the prompt for code at the
beginning of a line or at every point along the line. Tap the ok

[/ ] button.

2. To define the attributes for the new code, select the code and tap
the Add button on the right side of the screen. Set the name,
type, and parameters of the attribute for the code on the
Attributes screen (Figure 6-18 on page 6-13). Attribute type
indicates whether attribute values can be set as boolean True or
False, or selected from a list of available values, or are

6-12
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Editing Codes

alphanumeric strings, integers or real numbers. Check and
enable the Required box to always use the default value of the

code. Tap the ok [./ ] button.

E Code | o b 4 E Attributes - m
Name pt_p Name Iheight
D I ill
est pifar Type IInteger v
Type [area s Min val [1
Layer Ist L E] Max Val I?
Point | Line | Area | Attribute
Style
Fill Style |m v
Color
Default IE]
Transparency |50 o D Required

Figure 6-18. Edit Codes / Attributes

3. To edit a code or attribute, double-tap the object or select it and

tap the corresponding Edit button (Figure 6-17 on page 6-12).
In the Code or Attribute screen, make changes and tap the ok

[/ ] button (Figure 6-18).

To delete a code or attribute, highlight it in the list and tap the
corresponding Del button (Figure 6-17 on page 6-12). Codes
being used in points and their corresponding attributes cannot
be deleted.

To export the code library to the selected file format, select the
Export To File option (Figure 6-19 on page 6-14) from the Help
Icon menu in the upper-left corner of the Code - Attributes
screen (Figure 6-17 on page 6-12).
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Data
|C|:||:Ie Library

Format
Topcon XML (*.xml)

Topcon Text Custom (*.txt)
Carlson (*.FCL)

Figure 6-19. Export to Code Library

Editing Point Lists

To work with Point Lists, tap Edit Job » Point Lists.

1. To add a point list, tap the Add button on the List of Pt Lists
screen (Figure 6-20).

lo—— [ ——
5, [=
] A
(,L ) —p | 2
Edit Tob Layers List of Point Lic [N

PointList1

oZ0m
AHT
>

IIA

Figure 6-20. List of Point Lists
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Editing Point Lists

To edit a point list, select the point list and tap the Edit button
on the List of Pt Lists screen. In the Edit Point List screen
displays (Figure 6-21) and shows the Point List Name and
selects the points for the list.

Name: IPuintListl
(#][ List of Point[H

47100
101

@ 102
105
103
104

(]2 *llatom (]
Point Info SelPts -

Figure 6-21. Add Point List — Point List Tab

Adding a point to the Point List can be performed in two ways; either
through the map or through the Sel Pts button (Figure 6-21).

To add a point through the map, do the following:

1.
2.

3.

Tap the plot on the right. A large Map screen opens.

Select the points by tapping them on the map - the two
consequently tapped points will be connected with a line.

Tap Close.

To add a point through the Sel Pts button, do the following:

1.

Tap the Sel Pts button. A floating menu of six items display.

Select one of six ways of adding points.

* By Range — When specifying the range of points, the symbols
7, ¢ or “;” should be used to separate the names of the points

to be selected. The symbol ‘-’ can be used between two point

names when the two points, and all the points between them

are to be selected.

* By Code — All the points with the codes checked here will be
selected.
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By CodeString — All the points with the highlighted code with
the Strings checked here will be selected.

By Radius — By specifying the center point and the radius, all
the points that lie within the area are selected.

From Map — The points can be selected from the Map screen
as described above.

From List — Desired points can be selected from a list of
available points.

Repeat actions until all the points are added to the list.

3. Use the arrow buttons to modify the order of points in the list,
and the delete button to remove points from the list.

4. Tap the ok [/ ] button.

Editing Layers

The “layers” in a TopSURYV job can be thought of as overlapping
sheets of paper containing different drawing elements. Each layer is
associated with a definite set of points, codes, lines, and alignments.
When creating a layer, it can be either shown or hidden (that is,
displayed or not displayed).

Each new job contains a special Zero (“0”) layer. By default, all job
objects will be stored to this layer. Layer O cannot be deleted or
renamed.

Tap Edit Job » Layers to display the Layers screen (Figure 6-22 on
page 6-17).
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i_}____l -'_‘-g-_ E_Lavers | 4 |
{‘\ ' ) | F ¥ |Name |Status
Edit Job Layers 0 Default:Has...

Has Objects

| on |[ off [an onllan off

EE[ Del H Edit " Ins H Add

Figure 6-22. Layers

1. To add a layer, tap the Add button on the Layers screen. The
Add Layer screen displays.

2. On the Add Layer screen, enter the layer’s parameters and tap
the ok [./ ] button. The layer will be included in the list of
layers.

3. To delete a layer, select it from the list of layers and tap Del.

4. Tap on the |E| icon to list the layers in ascending or descending
running order. After tapping in the Name header of the table,
the icon will toggle to the Name column to set the layers in
ascending or descending order of names.

5. Use the arrow buttons to modify the order of layers in the list,
and the Ins button to add a layer and insert it below the
currently selected layer.

6. To turn on/off the visibility of selected or all Layers, tap on the
corresponding button On/Off or All On/All Off.

7. To edit a layer, either double-tap the layer or select it on the
Layers screen and tap Edit. On the Edit Layer screen
(Figure 6-23 on page 6-18), change the layer’s parameters as
needed and tap the ok [./] button.
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* On the Layer tab, enter a new layer name, check and enable
the Visible box to show the layer on the map, and enter any
additional information in the Note field (Figure 6-23).

3 v EAED
Layer Stylelobjects

Layer Name IIII
visible 72

Note ’puints 1-100

Figure 6-23. Edit Layer

* On the Style tab (Figure 6-24), define the plotting style
properties for the points, lines, and areas of the layer.

3o EAE3
Layer | Style | Objects
Point Style

IFiIIed Triangle »
Line Style

ISl:llid v

Width 1Pt v

Area Style

I\."ert. Lines v

Transparency [90 %

Figure 6-24. Edit Layer Style

8. To view objects on the existing layer, tap on the Objects tab
(Figure 6-25 on page 6-19).
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Lines
= Areas
s Area-g
Roads

Figure 6-25. Layer Objects

Editing Linework

Linework is provided in the points which are connected to form open
or closed polylines. For details, see “Storing Points” on page 6-7. To
edit lineworks, select the Edit Job » Lineworks icons.

T l—— 7 - -
IE“ {’ /4] ~ &
e ) List of Lineworl |
Edit Job Linework p——v T
rerece 18 AN BB
rerens 2B AN BB
rere e 25BB

—2m

AHT

< ? l=2m

Figure 6-26. Edit Linework

1. On the Linework screen, tap the Add button to create new
linework. The Edit Line screen displays (Figure 6-26 on
page 6-19).
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2. To delete the linework from the list, tap the Delete button
(Figure 6-26 on page 6-19).

3. To edit the properties of a linework, either double-tap or
highlight the linework in the list and tap the Edit button
(Figure 6-26 on page 6-19).

4. On the Points in Line tab of the Edit Line screen, change the
name of the linework if necessary (Figure 6-27).

* To change the order of the points, use the up and down
arrows.

* To view information on a point, select the point in the list and
tap Point Info.

* To add points to the selected/created linework, tap the down
arrows next to the Sel Pts button in the lower right-hand
corner. Select the appropriate parameter from the Sel Pts pop-
up menu.

et Line
Points in Line | Layer/Style

Linework Mame

(][ List of Paints ‘E‘.:.zm

7 #0000000C
7 #00000001 |

@ 7 #00000001
7 #00000001

(#]]< > )

l Paint Info I SelPts - l

Figure 6-27. Edit Line

5. On the Layer/Style tab of the Edit Line screen (Figure 6-28 on
page 6-21), set layer and plotting properties to use to display

the points and lines on the map and tap the ok [ ./ ] button.
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Layer/Style
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v

Point Style
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+ | | Color
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width |1 Pt

Figure 6-28. Edit Line/Point Style

Editing Areas

Area is bound with a closed line. Line nodes (points) have the same
code of area type to form an area boundary. To edit lineworks, tap
Edit Job » Area. The Area screen displays (Figure 6-29).

Edit Job

—

Az E Area

b
o

List of Areas

~esreRBATEA-1
~eeechd_fmg2
~eeeebnd_fmBAre
e ee by _fmBAre

100

< 4

S0 m

RN ———
T

100 m

Edit

Editing Areas

Figure 6-29. Select Area

1. On the Area screen, tap the Add button to create a new area.
2. To delete the area from the list, tap Delete (Figure 6-29).
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3. To edit the properties of an area, either double-tap or highlight
the area in the list and tap Edit. The Edif Area screen displays
(Figure 6-30).

4. On the Points in Area tab, change the name of the area if
necessary.

F-—d Add Area AR
Points in Area |LayerfStyle

Area Name IMI
E] List of Point: ’

112
111

@ & 110
& 109
47 100

(]2 > e=som M)

[Puint Inﬁ:l] Sel pts v|

Figure 6-30. Edit Area

5. To change the order of the points, use the up and down arrows.

6. To view information on a point, select the point in the list and
tap Point Info.

7. To add points to the selected/created area, tap the menu in the
lower right corner. Select the appropriate parameter from the
Select Points pop-up menu.

8. In the Layer/Style tab of the Edit Area screen, set layer and
plotting properties to use for display the points, line and area on

the map and tap the ok [ ./ ] button.
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Operating Raw Data

Tap Edit Job » Raw Data. The Raw Data screen displays

(Figure 6-31) and reflects all the collected measurements. In GPS+
mode, this screen also displays the coordinates of the base and the
vector of the stored points from the rover to the base.

T l—— -
e O - o T EY

. V7 a I —

\ﬂ, / J Mame Type Codes ~

Edit Jol Raw Data s Topo IRF6... 5S¢
16 Topo IRF6.. 5S¢
17 Topo IRF6.. 5S¢
M1 Topo  IRF6.. S¢

#1000 Auto... TD St
#1 1001 Auto... TD St

&7 4 Tem r e

< 4

[ First ” Last ” Edit |

Find Code | (Find Point | Find Mext

Figure 6-31. Raw Data

1. To move the cursor to the first or last point, tap the First and
Last buttons.

2. To find a point, tap the Find Point button and fill out the fields
in the Find by Point screen. The point can be found by name or
a part of its name.

3. To find a point by code, tap the Find Code button and select the
code in the Find by Code screen.

4. To find the next point that satisfies the same conditions as the
previous found point, tap the Find Next button.

5. To edit the raw data point, tap the Edit button. The Edit Raw
Data screen displays.

6. On the Edit Raw Data screen (Figure 6-32 on page 6-24), enter
additional notes for a point by typing the note in the suggested
field. The appearance (parameters) of this screen varies based
on the type of raw data being edited. (Note that editing Ant Ht,
HR & HI values, azimuth, etc., will not immediately recompute
coordinates.)
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7. To recompute the point coordinates, tap the Recompute button
on the Raw Data screen.

8. To toggle between displaying GPS+ raw data and TS raw data,
select the Show Raw GPS+/TS option from the Help Icon menu
in the upper-left corner of the screen.

6-24

Ededitrawnata [ S
Topo |Data

@ Point lm—

[] Code |—v
HR [.o00 m  |vert v
Ant Type [GR-3 v

Note

Figure 6-32. Edit Raw Data
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Editing GPS Sessions

To create or edit sessions (only in GPS+ mode) of automatic survey
for post-processing, tap Edit Job » Sessions.

‘iif‘é 1 o

_’ l Sessions

Edit Job Sessions 1D Type | Start Da

Sitel Static Sun

< 4

Receivers E]

Figure 6-33. Session Edit

1. To create a new session, tap the Add button on the Sessions
panel (Figure 6-33). The Session Setup screen displays.

2. On the Session Setup screen (Figure 6-34), enter or select
session settings parameters.

Site Name

Type |Stati|: v
Start Time [Sunday v [+ =0 =
End Time IW Ig_gu_%
Interval |3|:|— sec

Minsvs [+

Ant Type [GR-3 v

antHt [Lo00 m
[Vertical &

Figure 6-34. Session Setup
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Enter the site name, the type of the survey, the time (in local time)
and date of the start and end of session, the interval between
measurements, minimum number of satellites needed for the
survey and the value and type of the antenna height. Then tap the

ok [/ ] button to return to the Sessions screen (Figure 6-33 on
page 6-25).
3. To add a receiver, tap the Add button on the right side of the
screen.
4. Enter the name of the receiver in the Receiver Name dialog
box. Then tap the ok [/ ] button.
5. To hide/display the session plans of the receiver, tap on the “-/

+” sign located near the receiver name to collapse/expand the
tree node (Figure 6-33 on page 6-25).

6. To put a session to the session plan of the receiver, highlight the
desired session in the left panel and check the necessary
receiver on the right and tap the [¥] button (Figure 6-33 on
page 6-25).

7. To edit the session, select it in the left panel and tap the Edit
button (Figure 6-33 on page 6-25).

8. To delete the session from the sessions list or the receiver, use
the [<] button (Figure 6-33 on page 6-25).

9. Tap the ok [./] button to save the changes and close the
screen.
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Editing Objects from the
Main Map

Editing objects in the job can be accessed either from the Edit Job
menu or from the Main Map.

To open the Main Map, tap the Map icon.

1. When in the Main Map (Figure 6-35), tap the desired object to
highlight it. Then hold the stylus on the selected object for a
while until a pop-up menu displays. The menu options depend
on the object selected.

I
S
E

" 0616

M——s0m
N

Map

Map Icon

2006 57 spEA
. 7agg . 2001
. 7498

7403 Stakeout
Point In Direction

L@ =[Eo =)

7494
: Edit

o002 Delete

@ Add To Layer

Map Properties

Figure 6-35. Editing from the Main Map

2. To select multiple objects, tap the % toolbar icon and extend

a square window from right to left to include the desired
objects. These objects can either be deleted or added to a Layer.
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Notes:
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Chapter 7

Designing a road is performed by establishing numerically known
station points along a center line of the proposed route (horizontal
alignment). To furnish data for estimating volumes of earthwork, a
profile is run along the center line (vertical alignment) and the road
surface is defined.

There are two definitions of the road in TopSURV where:

1. The road surface is described with Cross Section Set, and the
main alignment is the center line of this surface. Cross Section
Set is grouped together cross profiles, taken along lines passing
through each station and at right angles to the center line (cross
sections).

2. The road surface is described with String Set, and the main
alignment may not be the centerline of the physical road
surface but a center line marking the center of a road
construction project. String Set is a set of road Strings, made up
of paired horizontal and vertical alignments.

The horizontal alignment can be designed by sections described
through lines, spirals, arcs and intersection points. Intersection point
is defined as the intersection of the two lines tangential to the
'incoming' and 'exiting' spirals, or to the central curve at the PC and
PT points, if spirals are not specified.

The vertical alignment can be described through vertical grades and
parabolas, or long sections.

The cross section can be described using templates.

To design a road, select the Edit Roads icon in the main menu. Road
designing consists of designing a road as a whole and designing each
component of the road: horizontal alignments, vertical alignments,
cross section sets or string sets, and cross section templates.
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Editing Roads

To edit a road, tap Edit Roads » Roads.

1. On the Roads screen either double-tap the road or tap the Edit
button. The Edit Road screen displays (Figure 7-2).

I Road 4
Qt’ _> @ E oads o
Edit Roads Roack
< >
-

o o3 m
[Delete] [ Edit ] [ Add ]

Figure 7-1. Roads

~ Double-tapping a plot on any edit screen opens a
greater map.

2. On the Alignment tab of the Edit Road screen, set the name and
select the layer and the alignments, then open the Surface tab.

* If needed, change the layer from the drop-down list to locate the
road. Select the layer from the Layer drop-down list, or use the

(.- | button to edit layers. (For details refer to “Editing Layers”
on page 6-16).

* Select a pre-defined horizontal alignment from the Hz Alnt

drop-down list to use in designing the road. Use the List [ ... ]
button to edit horizontal alignments. (For details refer to “Editing
Horizontal Alignments” on page 7-5).

This Horizontal Alignment defines the stationing for the road and
must be set for either way of creating a road: with Cross Section
Set or String Set.
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* Select a pre-defined vertical alignment from the Vr Alnt

drop-down list to use in designing the road. Use the List [ ... ]
button to edit vertical alignments. (For details refer to “Editing
Vertical Alignments” on page 7-12).

This Vertical Alignment defines the vertical center alignment for
the road only if Cross Section Set is being used.

* Set the starting station with distance to it, or the starting chain
distance, depending on a selection made on the Display screen.

* Set the interval between the station points where road related
computations are made.

| Alignment |surface |

Name G5L_Road_test]
Layer IL_"HT [:
Hzaint  [hord 9|

Start 5tn Il:l+l]l].l]l]l] m

Stn Interval |5.000 m

Figure 7-2. Edit Road Alignment

3. On the Surface tab of the Edit Road screen, define the road
surface (Figure 7-3 on page 7-4).

* Select a way of describing the road surface: with a set of cross
sections (X-Sec Set) or a set of strings (String Set). Select a pre-

defined set from the drop-down menu. Use the [ --- ] button to
edit corresponding sets (see “Editing Cross-Section Sets” on
page 7-20 and “Editing String Sets” on page 7-22).

* Set limits along the road for the width of a cross section (Working
Corridor), to only include those strings inside. Enter two offsets
from the centerline: offsets to the Left (near to the centerline) and
Right (far from the centerline) sides of the corridor. The value
entered in the Left field must be more than in the Right field.
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E.Edit Road
Alignment | Surface
[ string set | /SRR

working Corricor

Left [5.000 m

Right IlD.DDD m

Figure 7-3. Edit Road Surface

 Tap the ok [/ ] button to save the road file and return to the
Roads screen (Figure 7-1 on page 7-2).
4. After the road is edited, calculate the road points using the
Calculate Road Points option from the Help Icon menu in the
upper-left corner of the Roads screen (Figure 7-1 on page 7-2).

¢ On the Calculate Road Points screen, select the desired road
point types (Figure 7-4 on page 7-4). If needed, change the
station interval and tap Next to set the properties of the generated
points in corresponding screens. In the last screen, opened by the
Next button, tap the Calec button to perform calculations.

i Calculate Road Points m

Points to Generate
Centerline Points

Points Right of Centerline
Points Left of CenterLine

Include Transition Points
PrefixfSuffix

INune v

Station Interval

IS.DDD m

Figure 7-4. Calculate Road Points
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Editing Horizontal Alignments

To edit a horizontal alignment, tap Edit Roads » Horizontal.

1. On the Hz Alnt screen (Figure 7-5), either double-tap the
horizontal alignment or highlight it and tap the Edit button.

2, 4
| —» | ©

Q Name

Edt Roads Horizontal hord |

~
v

—am

[pelete | | Edit | | add |

Figure 7-5. Horizontal Alignment

2. On the Start Pt tab of the Edit Hz Alnt screen (Figure 7-6),
enter the alignment name and Start Point, the Code, the North/
East coordinates, and the Start Station number (or the starting
chain distance).

S Edit Hz Alnt [/ | 8¢
Start Pt |Hz

Alnt Name  [TTiTENT|
HH start pt Az
Code Ic

[1

MNorth Iﬁ 185632.51 m
East 419215.966 m
Start Sta IIII+IIIIII.IIIIIIIII m

Figure 7-6. Edit Horizontal Alignment
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The point name can be entered manually (if a new point name is
entered, the point will be created with the coordinates entered in
the North and East fields), selected from the map, or selected
from the list. If needed, enter a photo note for the point.

3. On the Hz tab of the Edit Hz Alnt screen (Figure 7-7), add
horizontal alignment elements.

Start Pt | Hz

| Element A ||TH

Curve
™, Spiral
==Line

™ Spiral ¥
< > o2m
End Sta 0+21.000 (]

[ msert v|[ add +]

| pelete || Edit |

Figure 7-7. Add Horizontal Alignment Elements

* To add a horizontal alignment element (Figure 7-8), tap the Add
button and select an element from the floating menu: either line,
curve, spiral, or intersection point.

* In the corresponding screen displayed, enter parameters for the
element (length and azimuth for line, length, radius, azimuth, turn
for curve; length, radius, azimuth, turn, direction, for spiral; point
coordinates, curve radius, incoming and exiting spiral lengths, for
intersection point) and tap the ok [./ ] button. Add as many
elements as needed to define the road.

» To view the start and end stations (or chainages) information for
the selected alignment element, highlight it and tap the End
Station information under the element list (see Figure 7-8 on
page 7-7).
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Elernent Mos0m
=== ine N
£ Curve
== Line %
N Clrve

=== ine

Start Sta 1+00.000

End Sta 3+00.000
== g=1r= =g gua ) E]

[ msert v|[ add ]

[ pelete |[ Eat |

Figure 7-8. Information on Element Start and End Stations

4. Tap the ok [/ ] button on the Edit Hz Alnt screen to save the
horizontal alignment and return to the Hz Alnt screen.

Adding a Line

1. To add a line, select the Line option from the Insert or Add
floating menu on the Horizontal tab of the Edit Horizontal
Alignment screen. The Line Screen displays.

2. On the Line screen, enter the length of the line element and the
azimuth only for the starting element of the road (Figure 7-9 on
page 7-8). By default, the azimuth is set tangent to the previous
element. To change the azimuth of all other elements, remove
the check mark from the Tangent to Previous Item box on the
Help Icon in the upper-left corner of the screen.

Caution should be exercised when setting the
@ azimuth, since road elements are usually tangential
to each other.

3. Tap the ok [/ ] button to save the element to the road and to
return to the Edit Hz Alnt screen (Figure 7-8 on page 7-7).
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Eiro /1]
Length [IINGL m
Azimuth [58°50°06.07

M

Figure 7-9. Add Line

Adding a Curve

1.

To add a curve, select the Curve option from the Insert or Add
floating menu on the Horizontal tab of the Edit Hz Alnt screen.
The Curve screen displays.

On the Curve screen (Figure 7-10 on page 7-9), enter the

following parameters, and tap the ok [./ ] button to save the
element to the road and to return to the Edit Hz Alnt screen
(Figure 7-8 on page 7-7).

The length of the curve element, or one of five parameters
unambiguously defining the curve length: chord, tangent, middle
ordinate (the distance from the midpoint of a chord to the
midpoint of the corresponding curve), external (the distance from
the midpoint of the curve to the tangent), or delta (the angle
between the radii corresponding to the curve). Using the degree
of chord (DCH) or degree of curve (DCV) parameters, the radius
can be calculated.

The azimuth only for the starting element of the road. By default,
the azimuth is set tangent to the previous element. To change the
azimuth of all other elements, remove the check mark from the
Tangent to Previous Item menu on the Help Icon in the upper-left
corner of the screen.
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Caution should be exercised when setting the
@ azimuth, since road elements are usually tangential
to each other.

* For the direction of turn (Figure 7-10), select either Right (for
clockwise direction) or Left (for counter-clockwise direction.)

Etne /1]

# |Radius joo0.000 m
& |Length bso.ooojlH
Azimuth  [58°50°06.

Turn IRight v

M

TN

—=50m

Figure 7-10. Add Curve

Adding a Spiral

1. To add a spiral, select the Spiral option from the Insert or Add
floating menu on the Horizontal tab of the Edit Hoz Alnt screen
(Figure 7-8 on page 7-7). The Spiral screen displays.

2. On the Spiral screen (Figure 7-11 on page 7-10), enter the
following parameters:

* The radius of the curve, or one of two parameters unambiguously
defining the radius: the degree of chord, or the degree of curve
(for detail, see “Adding a Curve” on page 7-8).

* The Length of the spiral or Sp Const, the parameter that is the
square root of the product of the length and the radius of the
spiral, as defined above. Consequently, the spiral constant has the
units of length.
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* The azimuth only for the starting element of the road.
By default, the azimuth is set tangent to the previous element. To
change the azimuth of all other elements, remove the check mark
from the Tangent to Previous Item menu on the Help Icon in the
upper-left corner of the screen.

azimuth, since road elements are usually tangential

@ Caution should be exercised when setting the
to each other.

¢ For the direction of turn, select either the Right value (clockwise
direction or the Left value (counter-clockwise direction.)

* For the direction of movement along the spiral, select either 7S to
SC (entering the turn), or CS to ST (exiting the tum)l.

& |Radius Start W m
& [Radius End [200.00 mq
& tongth | m
Azimuth Im

Turn

/@lnght—

——50m TS To SC +»

Figure 7-11. Add Spiral

3. Tap the ok [/ ] button to save the element to the road and to
return to the Edit Horizontal Alignment screen.

1. The traverse points on the turn have the following markers:
TS-traverse-spiral; SC-spiral-circle; CS-circle-spiral; and ST-spiral
traverse.

7-10 TopSURYV User’s Manual



Editing Horizontal Alignments

Intersection Point

1. To add an intersection point, select the Intersection Point option
from the Insert or Add floating menu on the Horizontal tab of
the Edit Hz Alnt screen. The Intersect Pt screen displays.

2. On the Intersect Pt screen (Figure 7-12), enter the following
parameters:

* For the name of the intersection point, either enter the name
manually (with the coordinates specified in the North and East
fields and a height of zero), or select it from the map or the list.

* The local coordinates of the intersection point cannot be changed
for an existing point.

* For the radius of the curve, or one of two parameters
unambiguously defining the radius, either enter the degree of
chord, or the degree of curve (for detail, see “Adding a Curve” on
page 7-8).

* The length of the corresponding spiral elements, or the spirals
constants are defined (see “Adding a Spiral” on page 7-9).

o EAER
FH Point [az—

Morth M m

East M m
o Lonan 2 T m

Figure 7-12. Add Intersection Point

3. Tap the ok [/ ] button to save the element to the road and to
return to the Edit Hz Alnt screen (Figure 7-8 on page 7-7).
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Editing Vertical Alignments

To create a vertical alignment, tap Edit Roads » Vertical. The Vert
Alnt screen displays (Figure 7-13).

1. Tap the Add button to add a new vertical alignment. The Add
Vt Alnt screen displays (Figure 7-14 on page 7-12).

2 -
e

Name
Edit Roads Wertical |

< >
AHT
—_—

—=10m

[pelete | | Edit | | add |

Figure 7-13. Add Vertical Alignment

2. Onthe Add Vt Alnt screen (Figure 7-14 on page 7-12), enter
the name of a new vertical alignment.

3 Add vt Aint [/ | 8¢
Name IvE

VAL Type
Length & Grade

Station & Elevation

Figure 7-14. Add Vertical Alignment

* Select the method of creating the vertical alignment (VAL Type):
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— select Length & Grade to create the vertical alignment by
sections of graded lines. The vertical alignment will be
presented as a set of sections between the stations where the
heights are known (usually these are the extremes of the
vertical alignment line), and the interval around the station
where the vertical alignment line has a parabolic shape.

—select Station & Elevation to create the vertical alignment by
elements, starting and finishing at any station where you want
and starting again.

* Tapping the ok [/ ] button opens the next Add Vt Alnt screens
similar to those for editing vertical alignments (Figure 7-15).

3. For the Length & Grade type, on the Start Pt tab of the Edit Vt
Alnt screen (Figure 7-15), enter the name of the vertical
alignment and parameters of the starting point and station. (For
the Station & Elevation vertical alignment type, the start point
name is not needed).

Start Pt |vert

Alnt Name

HH start pt [a2
T —

Eley |133 978 m
Start Sta IIII+IIIIII.IIIIIIIII m

Figure 7-15. Add Vertical Alignment — Start Pt Tab

* The start point name can be entered either manually, selected
from the map, or selected from the list (the point will be created
with the height entered in the height field for a new point name).
If needed, enter a photo note for the point.

* The point code can be entered manually or selected from the
drop-down list. The code of an existing point cannot be edited.
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4. On the Vert tab of the Add Vt Alnt (<name>) screen (Figure 7-
16), add the vertical alignment elements, or long sections (for
the Station & Elevation vertical alignment type).

Elernent Eu 20m
Long Sectior

< >
End Sta 3+00.000 ]E]
l Insert l l Add l
l Delete l l Edit l

Figure 7-16. Add Vertical Alignment — Vert Tab

* When the vertical alignment type is Length & Grade, tap the Add
button and select either vertical grade or parabola from the
floating menu. Enter the parameters of the element: either length
and grade for the vertical grade, or parameters for a selected
curve (either length, start and end grade for the parabola, or the
radius of the arc for the circular arc).

* When the vertical alignment type is Station & Elevation, tap the
Add button and enter the parameters of the Long Section: either
the length of the parabola at the station (with the assumption that
the station is located in the middle of the interval), or the radius of
the arc, depending on the type of the curve type selected.

Add as many elements or long sections as needed to define the
road.

» Tap End Station information under the list of elements or long
sections to view the start and end stations for the selected item
(Figure 7-17 on page 7-15).

5. Tapthe ok [/ | button on the Add V¢t Alnt screen (Figure 7-17)

to save the vertical alignment created and return to the V¢ Alnt
screen. The new vertical alignment will be displayed in the list.
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Start Pt | Wert

Elernent
T

Vertical Grad
Y Parabola

Vertical Grad M/

N B

Start Sta 0+00.000

End Sta 2+00.000
I3

T ST 200,

[ msert v|[ add ]

ing Vertical Alignments

Edit

l

Tomere ||

Figure 7-17. Information on Start and End Stations

To view the stations of the highest and low positions in the vertical
alignment, select the High/Low Positions option from the pop-up
menu opened by the Help Icon in the upper-left corner of the screen.

Alnt Name: Verl

EHigh,‘Luw Positions dy ]

Ilstati... [7... [Ee... [rad...]

0+19.... High 13...
0+26.... Low 13... 5.000

Figure 7-18. High/Low Positions
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Adding Vertical Grade

1.

To add a vertical grade, select the Vertical Grade option from
the Insert or Add floating menu on the Vert tab of the Edit Vit
Alnt screen (Figure 7-17 on page 7-15).

On the Vertical Grade screen (Figure 7-19), enter the length of
the vertical grade element and the grade percentage of the
element. If the grade is falling, the value should be set to
negative.

Tap the ok [/ ] button to save the vertical alignment element
created and return to the Add Vertical Alignment screen.

Length [200.000 m
Grade |5 %

AHT

—=50m

Figure 7-19. Add Vertical Grade

Adding a Curve

1.

To add a curve, select the Curve option from the Insert or Add
floating menu on the Vertical tab of the Edit Vt Alnt screen
(Figure 7-17 on page 7-15). The Curve screen displays.

On the Curve screen (Figure 7-20), select the type of curve to
add, either Circular Arc or Parabola. The plot at the bottom of
the screen shows the element appearance.
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Cunre - m

@R Trge IParabuIa »

|- Length [200.000 m
Start Grade [15 %
End Grade |3 %

AHT

—=50m

Figure 7-20. Add Vertical Curve
Enter the radius of the arc or the length of the parabola element,
depending on the type of curve selected.

Enter the starting and ending grades percentage of the element.
If the grade is falling, use a negative value.

Adding Long Sections

1.

For Long Sections vertical alignment types, only enter the
vertical alignment name in the Start Pt tab of the Add Vt Alnt
screen (Figure 7-14 on page 7-12).

To add a long section, tap the Insert or Add floating menu on
the Vertical tab of the Edit Vt Ant screen (Figure 7-15 on
page 7-13). The Long Section screen displays.

On the Long Section screen (Figure 7-21 on page 7-18), select
the type of the curve to add from the Curve Type drop-down list,
either Parabola or Circular Arc, and enter the station distance
from the beginning of the road, the elevation (height) of the
station, and the length of the parabola at the station (with the
assumption that the station is located in the middle of the
interval), or the radius of the arc, depending on the type of curve
selected.
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Station |D+IJIJ.IJIJIJ m
Elevation |149.IIIIIIIII m

Curve Type ICirl:uIar ArC v
Arc Radius 1lIIIZI.lIIIZIl:I m

AHT

c—=20m

Figure 7-21. Add Long Section

3. Tap the ok [./] button to save the element to the road and to
return to the Add Vt Alnt screen (Figure 7-17 on page 7-15).

Editing X-Sect Templates

To work with Cross-Section Templates, tap Edit Roads » Templates.
The X-Sect Templates screen displays (Figure 7-22).

Q'} <\> Vi X-Sect Templates L
Name Cut Slope | Fill Slop

Edit Roads Termplates al 0.001 0.001
stop-1 0.000 0.000
< >

[HT ﬁJ\@—
—————Zm
(20 ]

Figure 7-22. X-sect Templates

7-18 TopSURYV User’s Manual



Editing X-Sect Templates

1. To create a cross-section, tap the Add button on the X-Sect
Templates screen (Figure 7-22).

2. On the X-Sect Templates screen, enter the parameters of the
template: the name of the template, the Cut/Fill slope
parameters, and the segments comprising the template
(Figure 7-23).

Mamme ll—

Slope (x:1)

Cut ID.DDD
Fill I5.DDD E]

-

Segment P... |Hz |Vert
8.000 -0.500 ¥

[Delete || Edit ][ msert ][ add |

Figure 7-23. X-sect Templates

3. To add a segment to the template, tap the Add button. The
Segment screen displays.

E Segment f
Segment Paint Iﬁ
Offset
Haorizontal
IEI.DDD m
¢
ID.SDD m

Figure 7-24. Segment

4. On the Segment screen (Figure 7-24) enter the parameters of
the segment (the name of ending segment point and offsets).
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5. The added segment will be attached after the last segment in the
list. Repeat adding segments until the template is ready for
work.

6. Tap the ok [/ ] button. The template will appear in the list of
templates.

Editing Cross-Section Sets

To create a set of cross-sections, tap Edit Roads » X-Sections. The
X-Sect Set screen displays (Figure 7-25 on page 7-20).

3 3 x-sect set
{ '? — > | Name
Edit Roads ¥-Sections

M

—=20m

[pelete | | Edit | | add |

Figure 7-25. Cross Section Set
1. To edit a selected cross section set, either double-tap the cross
section set or highlight it and tap the Edit button.
2. To remove a selected cross-section set from the list use the
Delete button.
3. Tap the Add button to add a new cross-section set. The Edit X-
Sect Set screen displays.

4. On the Edit X-Sect Set screen (Figure 7-26 on page 7-21), enter
the name of the new cross-section set and tap the Add button to
add cross-section to the set.
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Name Iml

Station
0+00.000
0+44.000

Left X-Sect... ~
al
al

0+44.100
0+55.000 v

< 4

AHT

————2m

[elete || Edit |[ add |(»]

Figure 7-26. Add Cross Section Set

5. Inthe X-Section screen, define the station, where the cross-
section will be applied, or the distance to this station, and
specify the cross-section templates for the left and/or the right
parts of the road cross-section. These can be chosen only from

the existing cross-section templates. Tap the ok [/ ] button.

station 0+00.000| m

X-Sect IButh v

X-Section

Left al v
Right al v
AHT

o o | e

Figure 7-27. Cross Section

6. Repeat steps 2 and 3 to add as many cross-sections as necessary
to define the road.
If two or more cross sections are defined in one set, the
intermediate cross sections are calculated using interpolation.
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Editing String Sets

String Set is a combination of strings that represents the three
dimensional surface of the road or a desired part of it. A single string
is defined by one or many pairs of the horizontal and vertical

alignments.

To create a set of strings, tap Edit Roads » String Set. The String Set
screen displays (Figure 7-28) a list of string sets used for the road and
a general scaled view of the highlighted string set.

&

Edit Roads

—

String Set

EDD LSft
| pelete || Edt || Add |

Figure 7-28. String Set

1. To edit a selected string set, either double-tap the string set or
highlight it and tap the Edit button.

2. To remove a selected string set from the list use the Delete
button.

3. Tap the Add button to add a new string set. The Edit String Set
screen displays a list of single strings included in the set.

4. On the Edit String Set screen (Figure 7-29 on page 7-23), enter
the name of the new string set and tap the Add button to add a

new road string to the set.
The Edit Road String screen displays.
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3 Edit string set A E
String Set |551111

E] 'List ofs... | [1n

52

E] o100 USft
[ Detete |[ Edit |[ ada |[D]

Figure 7-29. Edit String Set

5. The Edit Road String screen displays the string name and a list
of alignment pairs in the string, and scaled plots of a
highlighted pair of the horizontal and vertical alignments.

(e vone 5o EAED
String

Hz ... |vt.. | [N
52_... S2_...
Slab Siab
=50US
AHT
oS0 USft
[ Detete |[ Edit |[ ada |[D]

Figure 7-30. Edit Road String

6. Tap Edit to edit the selected pair of alignments or Add to create
a new pair of alignments. The Edit Alignment screen displays
(Figure 7-31 on page 7-24).
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P edit alignment ... [
Lo v

o vt Alnt |51 line-1 v

Select

Figure 7-31. Edit String Alignments
7. On the Edit Alignment screen, you can select:

» Horizontal/ vertical alignments from the drop-down lists of
existing ones, or

* Linework from the linework list or from the map from which to
create alignments. In this case, you wall be prompted to name the
created alignments for string (Figure 7-32).

EName Alignment [ b 4

Creating Alignments for String
from Line: ~e~line-1

Enter Alnt Name: I line-1

Figure 7-32. Enter Alignment Name

e Tap the ok [/] button to return to the Edit Road String screen
with the created alignments.
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Map

Editing Roads from the Main Map

Editing roads in the job can be accessed either from the Edit Roads

menu or from the Main Map.

To open the Main Map, tap the Map icon.

1. When in the Main Map, tap the desired road to highlight it.
Then hold the stylus on the selected road for a while until a
pop-up menu displays (Figure 7-33).

1”@‘ ESos16

L4
WH—s50m
N

Map

]I@!

Map Icon
2006\

77

Road Stakeout
Real-time Road Stakeout
Slope Stakeout

7493

Edit
Delete

7494

Add To Layer

Map Properties

2002

Figure 7-33. Editing from

2. To select multiple objects, tap the %' toolbar button and

the Main Map

extend a square window from right to left to include the desired

objects. These objects can be deleted or added to a Layer.
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Notes:
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Chapter 8

surveying with
TopSURV

Performing GPS+ Surveys

After creating a job with the desired configuration in TopSURV and
completing the preliminary work (the antenna is plumbed and the
receiver and controller are connected), the survey can begin.

¢ To use RTK measurements, two receivers are needed: a Base
Station receiver, with an antenna plumbed above a point with
known coordinates, and a Rover receiver, with an antenna
plumbed above the points being surveyed.

If a local system is used, perform Localization first

@ to determine coordinate transformation parameters
from Geodetic/Grid coordinates to local
coordinates.

and Auto Topo. Topo surveys collect data one at a
time at several locations, whereas Auto Topo
surveys continuously collect data (usually for
trajectory survey work).

; Survey work can be performed in two modes: Topo

* To use Network RTK and Network DGPS positioning, a Rover
receiver is needed, with an antenna plumbed above the points
being surveyed, and correction data received by the Rover from
reference station networks.

* To use the Real Time DGPS survey mode, a Rover receiver is
needed, with an antenna plumbed above the points being
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surveyed, and correction data received by the Rover from
differential services.

* To use the PP modes, two receivers are needed: one located on an
occupation with known coordinates, and the other is either
located on static occupations (PP Static mode), moves along a
trajectory (PP Kinematic mode), or moves to position points of
interest (PP enabled RTK, Network RTK, Network DGPS and PP
DGPS). Data collected in PP (post-processing) modes can be
processed later in the office for estimation of baseline vectors.
The Topo and Auto Topo surveys for PP Kinematic and PP DGPS
modes are performed similarly to real-time surveys.

Job configuration settings will be applied to the Base receiver only
after starting the Base and to the Rover receiver only after selecting a
survey option.

Localization

Localization parameters can be defined either before beginning the
job or after the completing the job.

Localization parameters provide transforming coordinates between an
original coordinate system (WGS84, or any datum selected, or any
grid selected) and a local system. To calculate these parameters, the
localization (control) points with pairs of coordinates in both systems
are used. The local coordinates and the original coordinates are those
of the same point on the surface of the earth, in the local and original
systems, respectively. The names of the local (Known) and original
(Measured) points must be different.

Under Local (known) coordinates TopSURYV understands coordinates
of Ground type. Therefore, always enter or import local coordinates
as ground.

For localization to work properly (for WGS84, or any datum
selected), import local coordinates with Projection set to <none> and
Ground Coord Type in the Coord System screen.

For localization with a current grid projection, check the Grid/Ground
box on the Coord System screen to enable Ground Coord Type.
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The quality of coordinates and general layout of localization points
directly affects localization accuracy. Localization points should be
located more or less evenly around the jobsite.

1.

Tap Setup GPS » Localization. The Localization screen
displays the list of pair points which will be initially empty
(Figure 8-1 on page 8-3).

On the Localization screen, select the desired type of
localization that TopSURYV allows for the given original
coordinates (Figure 8-1).

E Localization

Knowen Pt Meas Pt

N —[%a] |

Setup GPS Localization

100_loc 101 0.011 23
111 _loc 112 0,155 ic
114 _loc 113 0,144 41
< >
Type Jarid - Local v
[]keep scale 1.000
Add Edit:

Figure 8-1. Localization Screen

e select WGS84 -> Local to transform WGS84 coordinates to local

coordinates. In this case TopSURYV will use the oblique
stereographic map projection on WGS84 as intermediate to
calculate localization parameters.

select Datum -> Local to transform coordinates on any datum
(selected in the Coordinate System dialog of the current job) to
local coordinates. In this case TopSURYV will use the oblique
stereographic map projection on the datum as intermediate to
calculate localization parameters.

select Grid -> Local to transform coordinates on any projection
(selected in the Coordinate System dialog of the current job) to

local coordinates. In this case TopSURYV will use this projection
on corresponding datum to calculate localization parameters.
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ST

This type of localization is more rigorous than others
which use only the stereographic projection for an

unknown local projection. This way allows
increasing the distance between localization points
without disadvantage of transformation precision.

* Check marked Keep scale 1.000 preserves localization from a
scale transformation.
3. Tap Add to add pairs of points to the list. On the Add Point

screen, set the following parameters, then tap the ok [/ ]
button (Figure 8-2):

Add Point - m

i AR
2201 3200 10+3
Knowen Point

Paint |1DD

Use Horiz Use Vert
Measured Point
Paint |101
I
Code I

Epoch Count O

Figure 8-2. Add Localization Points

* In the Known Point panel, enter a point with the local coordinates
in the Point field. Check mark the Use Horizontal and Use
Vertical boxes to use this point for horizontal and/or vertical
localization. The horizontal and vertical use of any control point
can be changed by highlighting the desired line in the
Localization screen (Figure 8-1 on page 8-3), and then tapping on
the header of the H Control or V Control. This toggles the display
between “yes” and “no”. Double-tapping on the selecting line
opens the Add Point screen (Figure 8-2) that also allows changing
the horizontal and vertical use.
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* In the Measured Point panel, specify a point with original
coordinates in the Point field. Tap the start measuring [E button

to use the current position or manually add the point to the job
points.

4. Repeat step 3 to enter additional localization points. Note the
following information about localization points.

* When only one localization point is available, the offsets are
computed and the system is oriented to North, and the scale is set
at height.

* When two localization points are available, the offsets, azimuth,
and scale are computed.

* With three localization points, Vertical deflection is also
computed.

* When additional localization points are specified, the parameters
resulting in the least errors will be computed.

* The value of the residuals specify the level of reliability for each
localization point. The residuals are along horizontal or vertical
axes. The control columns display the status of the point, either
“yes” for used or “no” for not used. Select the line and tap H
Control or V Control to change the status.

* The localization is updated (recomputed) every time a new point
is added to the list of localization points. The new coordinate
system will be saved under the name “Localization” and is
automatically selected.

5. To view the results of the localization, tap the Details button on
the Localization screen (Figure 8-1 on page 8-3).

6. The Localization details screen displays (see Figure 8-3 on
page 8-6). The Map tab displays the localization points marked
by blue triangles.
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ELDEE"
Results | Map
Localize To SK1942-Zone_ ~
Geodetic Origin
Lat N 55°43'44.2¢
Lon E 37°33'27.2¢
Ht 186.889 m
Local Origin
MNorth 6179436.58
East 409376.220
Ht 157.993 m
Scale 0.99988323
Rotation 0°00'13"
v
< >

Figure 8-3. Localization Details

7. To configure the modem, select the Config Radio option from
the Help Icon menu in the upper-left corner of the screen.

8. To edit the job points, select the Edit Points option from the
bitmap menu in the upper-left corner of the screen.

9. To export the localization data to available data formats, select
the Export To File option from the bitmap menu in the upper
left corner of the screen.

The name of localization in the GC3 format will be set to the
current job name. After importing such a file into a new job, the
coordinate system will be saved under the name of the job
where the GC3 file was created.

Export File formats allow only WGS84 -> Local
@ type of localization.
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1. Connect the controller to the Base Receiver. Switch on the

devices.

2. Select the Setup GPS » Start Base icons. On the Start Base
screen, set the following information (Figure 8-4 on page 8-7):

M

Setup GPS

1*.-')

Start Base

WIESS4(m)

Paint Jasel]

Lat ID°DD'DD.DDDDD"

Lan 0°00'00.00000"

Elht  |0.000

AntHt  [0.000 [vertical v
@ Start Base

I|Ready

Figure 8-4. Start Base

* Enter the coordinates of base location manually, select a point
with the known coordinates, using the map or list of available

points.

* Enter the code of the Base manually or select the code from the

list.

* The current location can also be measured by tapping the auto

position icon (the coordinates of the current point will

appear), and can be used to set the Base.

* Measure and insert the Antenna height in the corresponding field.
If the antenna has not been set up yet for the job, specify the
antenna parameters.
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3. Tap the button to set the receiver as a Base,
transmitting data.

For external Digital UHF and Satel UHF radios,

@ performs quick start of the base. Pressing this
button queries a frequency list from the radio and
shows it in the status bar in the bottom of the
screen. After getting the frequency list, select an
appropriate frequency from the drop-down menu,
and tap the near OK to setup the radio.

4. To set/change the radio parameters selected in the job
configuration, tap on the Config Radio menu item in the upper-
left corner of the screen (see “Config Radio” on page 8-9).

5. To start multiple bases, tap on the Multi Base menu item in the
upper left corner of the screen (“Multi Base” on page 8-11).

6. To get faster access to the Grid to Ground system (in the
defined system) for the Origin Point option, select the Grid to
Ground option from the Help Icon menu in the upper-left
corner of the screen available if starting the base in a grid
coordinate system.

Starting Base with Autonomous Position

1. If the Base starts in autonomous mode, and an observed Topo
point has known coordinates stored in the job and has the same
name as the base, you can correct the base position.
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2. In the Duplicate Points screen, check and enable the Correct
Base box (Figure 8-5).

o cos— EAED

100 Already Exists!

Offsets{m)
dN -12.024
dE 0.001
dH -0.001

Overwri

(C) store As Check Point?
Use in Weighted Average

[] correct Base

Figure 8-5. Correct Base

The existing coordinates of the observed point are not replaced by the
coordinates of the observed point. Instead, the known coordinates of
this point are used to correct the Base coordinates. For Correct Base
to work properly, the coordinate type selected in Display (see
“Display” on page 4-78) must be the same as for the known
coordinates of the observed Topo point.

After either closing the Topo screen or moving to another tab,
recomputations are performed and the coordinates of all points are
updated using the new Base coordinates.

Config Radio

Use the Config Radio menu item in the upper left corner of the Start
Base screen to set up the radio modem (The same item is accessible
from the Status, Topo, and Auto Topo screens.) Also, if necessary,
you can change the radio parameters selected in the job configuration,
and then set them to the radio modem.
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Figure 8-6 shows an example for Internal GR-3 Digital UHF radio
modem.

P2 Config Radio 7]
Type Internal GR-3 Digital UHF
Connected to Im
Radio Port IC—
Channel I—v
Power |1 W -
Protocol ISiranex—v
Modulation W

l Get Freq ” Set Radio l

Figure 8-6. Config GR-3 Digital UHF Radio

1. Tap the Get Freq(uency) button to set the frequency that the
radio will broadcast and / or listen to.

Channels.ccx) must be loaded (using the Modem
TPS software) before any frequencies will display
in TopSURV. Please do this BEFORE configuring
the radio.

@ A Script file with Frequency list (Pac Crest

2. For the base radio, set the signal strength that the Base will
transmit.

3. Tap the Set Radio button to set the parameters to the radio.
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Configure RE-S1 Repeater

To setup the RE-S1 as a stand-alone repeater during the survey
configuration, first enable the usage of the RE-S1 radio modem as a
repeater. Then the Config RE-S1 Repeater option appears in the pop-
up menu of the Status, Start Base and Topo screens. This option
opens the Config Radio screen to set the RE-S1 as a repeater.

F=3corna ot EAED

Radio Connected to

IRepeater

Type RE-51 Repeater

Radio Port [N
Location INurth America

Protocol IFH915 Ext
Channel I 1 v

lDiscunnect ” Connect l

Figure 8-7. RE-S1 Repeater Configuration

1. Select the radio port that connects with the receiver or
controller, the territory (North America, Australia or New
Zealand) where the RE-S1 is used, and the operating frequency
channel.

2. Tap the Connect button to open a daisy chain and send
commands to setup the RE-S1 radio as a repeater.

3. Tap the Disconnect button to turn the RE-S1 modem off.

Multi Base

The Multi Base function in TopSURYV is implemented using the Time
Division Multiple Access (TDMA) mode of transmission. This means
that one Base can transmit at the beginning of the second and another
Base can transmit a half second later on the same frequency. The
Rover can recognize the two separate data streams.

1. Create a job, configure the RTK survey and set all necessary
settings.
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2. To set up Base 1, connect the controller to the receiver at Base,

then tap Survey P Start Base.

Select Multi Base from the menu in the upper-left corner of the
Start Base screen. The Multi Base screen displays (Figure 8-8).

Base Station ID |1 v
Transmit Delay IBIII + | msec

Figure 8-8. Multi Base

Select the Base Station ID and Transmit Delay. For example,
select 11 as the Base Station ID and select 30 msec for the
Transmit Delay (Figure 8-8). With transmission delays, the bases
are allowed to broadcast multiple RTK data on the same
frequency.

Tap the button. Base 1 will transmit as ID 11 at 30

milliseconds after the second. It will output RTK data at a
transmission rate of 1 second. Disconnect from Base 1.

3. Setup Base 2: connect the controller to the receiver at Base 2.

Setup of Base 2 is the same process as for Base 1 but a different
ID and transmission time must be selected for Base 2, for
example 12. Recommended time delay for Base 2 is 530 msec.

Tap the button. Base 2 will transmit as ID 12 at 530

milliseconds after the second or 1/2 second after Base 1. Base 2
will also output RTK data at transmission rate of 1 second.
Disconnect from Base 2.
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Note that both transmitters need to be set to transmit at the
same frequency and they must transmit in a CMR+ format.

At the Rover, connect the controller to the Rover receiver. If the
rover receives CMR+ corrections from more than one base,
there will be an additional tab in the Survey/Status menu
called Mult-Base, which is a table with information about the
Base Stations the Rover receiver is listening to (Figure 8-9).

P status B

Pos | Sys | Mult-B | plots | Svs

Use | 1D | Base | Age | L

1] Basel01 1

< >
Figure 8-9. Multi Base tab

* Check which base to use. Currently, TopSURV only supports

processing RTK baselines from one base at a time.

* After the Topo screen is opened, the receiver connected to the

6.

controller will be configured as the Rover.

For a newly created job, the bases remain active for another job.
It is not necessary to reconnect to the bases and restart them. On
the Rover side only, open the Status screen and select the base
with which to work.
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Status of GPS+ Survey

The status information gives the user an overview of the receiver main
operating states. The states are indicated only for information. Select
the Setup GPS » Status icons to open the Status screen that shows
the states of the current position of the receiver, RTK, and satellite
constellations (see Figure 8-10 on page 8-14).

For details on status information, refer to the TopSURV Reference
Manual, chapter 8.

Pos |Sys | Plots | SWVs

& 13 &, 13 uTC [19:03:44

Fixed

Local(Usft)

Morth  -14088.969
East 12118.581
Elev  87.878

&% ppop 1.8

H 2.201 v 3.200 USft
Base Dist 23601.871 USft

Figure 8-10. Status

Setting Up Survey With Known Points

The “Known Point Initialization”method of initialization is
performed when the rover occupies a known point as a faster step in a
kinematic survey to initialize the fixed solutions.

This function is used with single frequency receivers and for quality
control on dual frequency receivers. Tap the Setup GPS » Known
Point Init icons to initialize the receiver using known coordinates for
the Rover station.

1. In the Known Point Init screen (Figure 8-11 on page 8-15),
select the known point and set the antenna parameters of the
station.
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3 known point Init &y

— Point [709
Known Pt Init

Local(Usft)
North [8717.510
East Iﬁ? 17.919
Eley W

Ant Ht |6.562

uUsft |Vertic v

Figure 8-11. Known Point Rove

r

2. To start initialization, tap the Initialize button (Figure 8-11 on
page 8-15). The KPI Position screen displays the status
information on Rover initialization (Figure 8-12).

P/N 7010-0493

=1 position

& 13g 13 uTC
Fixed

23:13:22
Residuals{m)

North -13.000

East 7.013

Eley -0.735

" pooP 1.8

H 2.201 ¥ 3.200 m

KPR Status Initialized

Figure 8-12. KPI Position Screen
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Initializing mmGPS+

Before beginning the setup for a mmGPS+ system, configure the
mmGPS+ aided survey (see “Creating a GPS+ Configuration” on
page 4-3).

The setup process of a mmGPS+ system includes calibration of the
laser transmitter and initialization of the sensor.

Transmitter Calibration

The laser transmitter is the vertical grade control reference for the
jobsite. The following procedure will calibrate the transmitter with
the correct channel and communication port, as well as set up the
transmitter’s height and locate it at the jobsite.

1. Connect the controller and transmitter.

2. Tap Setup GPS » mmGPS+Init. The Init mmGPS+ screen
displays (Figure 8-13 on page 8-16).

3. On the (Trans) Data tab, select the ID that corresponds to the

channel of the transmitter, then tap Add (Figure 8-13). The
Transmitter screen displays.

= D v x|
Data | pos | Sensor
Name 1D Data
2
3
4
| add | [ Edit | [pelete |

Figure 8-13. Initialize mmGPS — (Trans) Data Tab

4. On the Transmitter screen (Figure 8-14), enter a Name for the
transmitter (usually the serial number), select the Com Port for
the transmitter (usually COM1), then tap the Get Data button
(Figure 8-14).
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E Transmitter : b 4
Name |12

Com Port |COM1 -

D 1
Calibration Data OK

Firmware Version 1.300

Clear Data l l Get Data

Figure 8-14. Enter and Get Transmitter Data

Once TopSURY retrieves the transmitter’s data, close the setup
successful screen. Then tap the ok [ ./ ] button.

On the (Trans) Pos tab, select the desired transmitter. Tap Edit
to enter the transmitter’s position (Figure 8-15).

12

<

>

lRESECt] l Edit l lDElEtE]

Figure 8-15. init mmGPS -Trans Tab

7. On the Init mmGPS+ screen, enter the following information

and tap the ok [/ ] button (Figure 8-16 on page 8-18):

P/N 7010-0493

» Using the map, select the point the transmitter is installed over.

* Enter the height of the transmitter using one of the following:
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— Enter the Ht measurement from the ground to the mark on the
transmitter’s side and the m method as slant.

— Check and enable the 2m Fixed Tripod box if using a 2 meter

fixed tripod.
EKnuwn Point
Point  |DRAN
[B]
Transmitter
Name 12
D 1
[]Fixed Tripod |2.uuu
Ht  [0.000 m |Vertic v
Known Pt Offset 0.000

Figure 8-16. Enter Transmitter’s Position

8. Unplug the controller from the transmitter. Continue with the
following section to initialize the sensor.

Sensor Initialization

The initialization process will upload transmitter calibration
information to the sensor connected with the receiver, as well as set
up the sensor for receiving the transmitter’s laser beam.

1. Connect the controller and GPS receiver.
2. Select the Sensor tab and enter the following information
(Figure 8-17 on page 8-19):
¢ Select the Receiver Port that connects the receiver and sensor,
usually port D.

* Select the Transmitter ID, usually ANY. The ANY selection will
allow the sensor to independently select the transmitter with the
smallest error rate.

* Select Auto for the Sensor Gain to automatically control the
mmGPS receiver’s detection level of the transmitter’s signal.
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* Check and enable the Init Time Improvement box to improve the
RTK fix time for the receiver.

Data | Pos | Sensor

Receiver Port ID -

Transmitter ID ANY -

Sensor Gain IAutl:l -

Firmware Version 51v1.40

Figure 8-17. Init mmGPS — Sensor Tab

3. Tap the Init Sensor button to start the initialization process.

4. When the initialization completes, tap Close on the setup
successful confirmation screen.

In the event that a point has been lost, the resection operation can
measure an unknown point. The self-levelling mechanism may also
need to be measured and the transmitter calibrated to ensure correct
grade. For details on these mmGPS operations, see Appendix A.

PZS-1 sensor with a 5/8 inch plug into the rover

@ When using mmGPS+, include the height of the
antenna height.
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Performing a Topo Survey

1.

2.

Tap Survey » Topo. On the Topo screen (Figure 8-18):

Enter the current Point name, enter a photo note using the button
if necessary,

Select a Code. A code symbol will show the code entity type ([-]
Point, Line, or [#] Area). Code needs to be defined at the

time it is entered if it is not a code that exists in the codes dialog.
The Topo screen will auto-hide and show the string input box

based on the code type. All line and area codes will display the
string field while all point codes will hide the string field.

Open the Point Attributes screen under the icon to set the
code and attributes for the selected code, layer and to enter a
photo note for the point if necessary. For GMS-2, GMS-2 Pro or
GRS-1 you may capture a picture using a camera integrated into
these devices.

Enter the Ant Ht and select a height type.

@[] [Z= [B] +
- 13 &7 Topo |Data | Map | Offsets

Suryey ”
loE0) 1 UgL[Fixed v &g

[@] Paint  [110
code i v
2 v 8= (B
antHt  [o00 m

Epoch count O

H
0.201 0,400 10+3

o

rtical

North: 6179291.211
East: 409373.508
Ell ht: 186.676

[=]

Figure 8-18. Topo

To set the mmGPS+ options in mmGPS+ aided RTK survey,
select the mmGPS+ Options item from the Help Icon menu in
the upper-left corner of the Status, and Topo screens.
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3. Use the Config Radio menu item in the upper left corner of the
screen to set and/or change the parameters to the radio modem.
(For details, refer to “Config Radio” on page 8-9.)

4. When in DGPS survey mode using OmniSTAR differential
corrections, select the Config OmniSTAR item from the bitmap
menu in the upper-left corner of the screen to start the
OmniSTAR service (“OmniSTAR Status” on page 8-24).

5. When in DGPS survey mode using Beacon differential
corrections, select the Config Beacon item from the bitmap
menu in the upper-left corner of the screen to start the Beacon
service (“Beacon Status” on page 8-25). If using the differential
corrections receiver BR-1, select the Config BR-1 item from the
bitmap menu in the upper-left corner to configure the Beacon
receiver (“Config BR-1” on page 8-26).

6. Tapthe button to change the survey parameters settings to
desired values.
7. 1If the location of the point to be observed is unreachable, set

offset parameters using a simple offset or offsets from a line.
Tap the Offsets tab (Figure 8-19 on page 8-22).

* For simple offset use, tap the [@ szmuth & Offsets - button, enter the
name and Code of the offset point, and insert the angle parameter
(Azimuth or Bearing), the height parameter (zenith distance,
elevation angle or vertical distance) and the horizontal distance.
Toggling between angle or height parameters is performed by

tapping the corresponding button. Tap [E to save the offset
point.

* For line offset use, tap the |[u# of=tune button, enter or select

from the list or map (or measure positions by means of the
button) two points comprising the reference line, specify the
direction of the line and enter the parameters of the offset point:
Name, Code, the distance along the line of sight between the end
point and the projection of the offset point on the reference line,
the distance from the reference line to the offset point along the
projection, and the height of the point.
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Tap [E to save the point; several offset points can be saved using

one line.

* For laser offset use, tap the offset Lassr - button, which is

available when an external laser distance meter has been added in
the Config Survey or when using TopSURV on GMS-2 Pro with
an integrated laser.

E Topo &

lE Offset Line l
l@ Azimuth & Offsets l
Offset Laser ‘

Figure 8-19. Topo — Offsets

8. Tap [E on the Topo tab to start the measurement process
(Figure 8-18 on page 8-20). After pressing this button, a new

cancel button appears along with the counter of the epochs
collected. When using a mmGPS system, the status bar displays

a mmGPS icon |#] . This icon displays when the receiver
calculates mmGPS heights.

9. In the survey for post processing, begin logging files to the
receiver: tap the button (see Figure 8-20 on page 8-23).
To stop logging, tap the same button (during the logging

process, this button says “stop log” , and the symbol
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located in the icon bar on the place of Status icon in the RTK

mode becomes: % ).

- E

H v gg
D - 2201 3.200 10+ 3

[@] Paint  [110
code i v
Ant Ht ID.DDD m Wertical s

Epoch count O

North: 6182019.088
East: 409430.361
Ell ht: 186.668

(=]

Figure 8-20. Topo for PP Survey

10. View the Data tab for details on the last point stored.

11. Use the Map tab to view a plot of the point with respect to other
stored objects. If necessary, select the Grid Setup option from

the pop-up menu on the top left corner of the screen to setup a
grid to be displayed with the Map.

12. If a topo point is observed a second time and named with the
identical name, a prompt will ask to Override, Rename, or Store
as Weighted Average point. Multiple WA points can be stored
and the results can be viewed in the Edit Points screen. The Use
in WA button makes weighted averages of topo points.
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OmniSTAR Status

To view the status of the OmniSTAR service for DGPS survey type,
select the Config OmniSTAR item from the Help Icon menu in the
upper-left corner of the Topo screen. The same item is accessible
from the Status and Auto Topo screens.

1. Select the OmniSTAR satellite from which to receive
differential correction data (Figure 8-21).

oo EAED

Satellite
[EA_SAT Lon 25E v

OmniSTAR SN 200153
Subscription 11/29{2007

Figure 8-21. Config OmniSTAR

2. Tap Status to view the status of the link to the OmniSTAR
satellite selected (Figure 8-22 on page 8-24).

Satellite
[EA_SAT Lon 25E v

OmniSTAR SN 200969
Subscription  11f29/2007

Version HP 4.10
Frequency 1535.2 MHz

SV Lock Locked i,
Eak LU N 47 N~

£ | ¥

Set Satellite

Figure 8-22. OmniSTAR HP Status
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Beacon Status

To view the status of the Beacon service for DGPS survey type, select

the Config Beacon item from the Help Icon menu in the upper-left

corner of the Topo screen. The same item is accessible from the

Status and Auto Topo screens. The Beacon screen displays

(Figure 8-23).

1. Select the country where the radio-beacon differential service is

located and the station that broadcasts differential corrections
for the Rover receiver.

e EAE3

Country |USA v

Station |ACUSHNET, MA v

Status

Figure 8-23. Configure Beacon Status

2. Tap Status to view the status of the link to the radio-beacon. On
the Beacon Status screen, the following information is shown,
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if applicable: the name of station, the Beacon board version, the
broadcasting frequency, and signal-to-noise ratio (Figure 8-24).

E Beacon Status

Station ACUSHNET, MA

Version NfA
Frequency NfA
Signal Quality  NfA

Figure 8-24. Beacon Status

Config BR-1

When using the Beacon receiver BR-1 in DGPS survey configuration,
select the Config BR-1 item from the Help Icon menu in the upper left
corner of the Topo screen to configure the BR-1. The same item is
accessible from the Status and Auto Topo screens.

1. Tap the Config button to send the appropriate configuration
command for BR-1 radio channels (Figure 8-25 on page 8-27):

¢ When Automatic Scan mode is on, all four channels of the
BR-1 will automatically scan frequencies until one of the
channels find the available Beacon Signal. After the signal is
found, the channel will keep this frequency.

* When Automatic Scan mode is off, the frequency and data
transfer rate of the known Station selected will only be set to
channel ‘a’ of the BR-1 receiver. The other channels will not
work.
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Country |USA

Station [ACUSHNET, MA

[ status ][ confo |

Figure 8-25. BR-1 Configuration

mmGPS+ Options

To set the mmGPS+ options in mmGPS+ aided RTK survey, select
the mmGPS+ Options item from the Help Icon menu in the upper-left
corner of the Status, and Topo screens.

On the mmGPS+ Opts screen, do the following (Figure 8-26 on
page 8-28):

* mmGPS+ is DISABLED - select “Turn mmGPS+ ON” from the
drop-down list to enable mmGPS+ height computation.

» Use weighted and height computations — check and enable to
combine mmGPS elevations and GPS elevations. When selected,
this option forces the receiver/sensor to always consider the angle
and distance when determining the elevation, then combines the
two elevations accordingly. This option works well at large
distances (300m) and steep angles.
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» Height Difference Limit — Set the threshold for the difference
between GPS and mmGPS+ height measurements.

mmGP5+ is DISABLED

|Tum mmGP5+ ON v

Height Difference Limit

[o.o84 wustt

Figure 8-26. mmGPS+ Options

Performing an Auto Topo Survey

1. Tap Survey » Auto Topo. On the Auto Topo screen, enter the
point name, select the Code if necessary and insert the Antenna
height and height type (Figure 8-27).

‘ ’}. _ i E..ﬂ,l_ltlj Topo " dn .
g
Survey

Auta Tapo

-

o

b

] H Y
1IU%F'*ed 0201 0400 §+‘§
[@®]raint  [5o15

lz‘ Code I 2 v

P~

antrt  [ENE m
IVerticaI v

(IS

Figure 8-27. Auto Topo
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2. Use the Config Radio menu item in the upper-left corner of the
screen to set and/or change the parameters to the radio modem.
(For details, refer to “Config Radio” on page 8-9.)

3. When in DGPS survey mode using OmniSTAR differential
corrections, select the Config OmniSTAR item from the bitmap
menu in the upper-left corner of the screen to start the
OmniSTAR service (“OmniSTAR Status” on page 8-24).

4. When in DGPS survey mode using Beacon differential
corrections, select the Config Beacon item from the bitmap
menu in the upper-left corner of the screen to start the Beacon
service (“Beacon Status” on page 8-25). If using the differential
corrections receiver BR-1, select the Config BR-1 item from the
bitmap menu in the upper left corner to configure the Beacon
receiver (“Config BR-1” on page 8-26).

5. Tap the button, select the parameters for data logging, and
tap the ok [ ./ ] button: the solution type solution for automatic
data logging while moving and the interval between
measurements (meters or seconds). To return to default values,
tap Defaults.

6. Tap @l on the Auto Topo tab and begin moving. When using a

mmGPS system, the Auto Topo tab displays a mmGPS icon [].
This icon displays when the receiver calculates mmGPS
heights.
To interrupt the process of survey, tap the [E button.
To override the interval Survey parameter temporarily and log
the current location, tap [E button.

9. In PP Kinematic and PP DGPS surveys, begin logging files to
the receiver: tap the button. To stop logging, tap the same

button (during logging, the button changes to “Stop Log” ,
and the symbol located in the icon bar changes to @).

10. Open the Data tab to view details of the last point stored.

11. Open the Map tab to see a plot of the point with respect to other
stored objects.
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12. If necessary, set up a grid displayed with the map using the
Grid Setup option from the Help Icon menu in the upper left
corner of the screen.

13. If the receiver switches base stations when recording real time
data, a warning message displays.

Cross-Section

A cross-section survey is performed to obtain the coordinates of
points that lie on a plane perpendicular to a center line. It is typically
performed by moving from one side of the road to the other in the
cross-sectional plane, and then crossing back in the opposite direction
at a different location along the road. This process is repeated at
different stations along the centerline, until all the desired cross-
sectional points have been observed.

1. To start working, tap Survey » X-Section.

2. On the Cross Section screen, set the parameters of the station
where the cross-section survey is to be performed: the Road/
Horizontal alignment/Horizontal and Vertical alignments name,
the code and attributes of the center line, the station where the
cross section is surveyed and the increment of distance towards

the next station (Figure 8-28). Tap [/ ] .

The Station and Interval fields appear only if the
road is selected.
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)
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Station

Interval IlDD.DDD m

Figure 8-28. Cross Section

3. On the X-Sect screen (Figure 8-29 on page 8-32) perform the
usual observation work relative to the cross-section, as
described in “Performing a Topo Survey” on page 8-20.

Cross-sectional points at the same station should have different
codes, with at least one of them having the centerline code. For
example, codes for cross-sectional points could be A, B, C, cl, D,
E, E in the order of survey.

Tap the button to automatically change the station number.
Also, the application automatically uses the same codes but in the
opposite order for the next station (£, E, D, cl, C, B, A). The
station and the codes can be changed.
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Figure 8-29. Cross-Section Accept

Find Station/Chainage

The Find Station task is used for the identification of the station by
computing the distance from the beginning of the road to the
projection of the station to the road, and the offset of the station from
the center line of the road.

1. To start working, select the Survey » Find Station icons
(Figure 8-30 on page 8-33).

2. Enter the Road/Horizontal alignment/Horizontal and Vertical
alignments name, the name, and the code of the point and the
antenna height and type (Figure 8-30 on page 8-33).

3. To compute the result with an existing point, tap the |2
(Figure 8-30 on page 8-33).

4. To compute the result with the coordinates of the current
location without making an observation, tap the [E button
(Figure 8-30).

5. To make an observation of the current location and store the
coordinates to a point, and to compute the result with this point,

tap the button (Figure 8-30).
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Figure 8-30. Find Station.

Tape Dimension

Using the Tape Dimension task, calculate the periphery of structures,
such as buildings that have features perpendicular to each other. This
is done using tape measurements, relative to the two known points
that belong to one side of the structure (wall of the building), forming
the so called reference line.

1. To start working, tap Survey » Tape Dimension (Figure 8-31
on page 8-34).

2. On the Ref Line tab, enter the information about the two points
that comprise the reference line: the names and codes. If the
reference line points are to be observed, tap the Meas button in
the corresponding fields (Figure 8-31 on page 8-34).
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Suryey

3. On the Tape Dim tab, set the parameters for performing the
survey: the name and code of the surveyed point, and the
direction (left or right of the previous line) and the distance of

P

Tape Dirmn.

E Tape Dimension
RefLine | Tape Dim | Data | Map

Start Pt

Point
|:| Code

End Pt

Point
|E| Code

Figure 8-31. Tape Dimension — Ref Line Tab

the movement from the previous point (Figure 8-32).

4. To apply the taped distance to the perimeter line, tap the Accept
button.

—=10m

E‘ Dist Left I Accept ]

|n.000

Finish =

Figure 8-32. Tape Dimension — Tape Dim Tab

5. Close the Tape Dimension work in either of two ways:
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* To connect the first and the last point with a line, tap Finish
and select the Close Polygon item from the drop-down menu
(Figure 8-32 on page 8-34).

* To calculate the difference between the last and the first point,
tap Finish, then select the Calc Closure item from the menu
(Figure 8-32 on page 8-34).

Performing a Static Survey

1. To open the Static Occupation screen (Figure 8-33), choose the
PP Static configuration in the Survey Config screen (use the
Configure icon) and tap Setup GPS » Static Occupation
(Figure 8-33).

g _> Estatic Occupation E
@ L FRN L
Static Occup, Point |STP
'0in
Code Ib:p v
AntHt [1.000 m  [Slant v
Duration 0:00:00

Figure 8-33. Static Occupation Screen
2. Enter the parameters of the occupation point: name, code and
antenna height and height type.

3. Tap Start Occ. The survey will start, and the Duration field
displays the time passed, since the beginning of survey.

4. To stop the survey, tap the Stop Oce button.
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Performing Total Station
Surveys

After completing preliminary work (that is, the instrument is plumbed
above the reference point and the controller is connected to a modem
(for Robotic Surveys) or to the total station), the survey can begin.

First, set one or more backsight points to be used for the survey. Then
choose a task to perform: sideshot (single or multiple) survey, cross-
section survey, finding station, tape dimension measurement, or
missing line determination. In the case of Robotic Survey, the auto
topo task is also available. The remote control function should be set
before performing a Robotic survey.

Backsight Survey

1. Tap Setup » Backsight (Figure 8-34 on page 8-37). The BS
Survey screen displays.

2. On the Serup tab of the BS Survey screen, set the following
backsight parameters (Figure 8-34 on page 8-37):
* Choose the occupation point using one of these methods:
— enter the name manually
— select the point from the map
— select the point from the list of fixed or job points
— add an arbitrary occupation point near a road station, or

— calculate the occupation point coordinates using the
coordinates of known points with the resection method. The
elevation can be computed using the known elevations of the
other points.

* Set the height of the instrument (HI) and the height of the
reflector (HR), choose the backsight point/backsight azimuth (or
enter multiple backsight points using the floating menu on the
bitmap in the corresponding field) and check if the height of the
backsight point rod is fixed for the whole set of measurements in
Ang/Dist Sets-Dir/Rev mode (Figure 8-34).
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Fixed Height

Figure 8-34. Backsight Survey Setup
3. On the Measurement tab of the BS Survey screen:

* Set the horizontal circle reading that corresponds to the backsight
point direction to zero, azimuth, input value, the value obtained
from the instrument, or the value changed by +/- 90 or 180

degrees. Select the corresponding option from the menu [EH.

Setup | Meas DatalMap

4 o o
D ﬂa oo B

Occupy A 1.700 m

Backsight — --- 2.000 m
Azirnuth 0°00'o0”

SetCrto  [or0000" =

[ Measure Distance
Turn To Backsight

5@ Check 5"5 Set

Figure 8-35. Measurement

¢ Select (check mark boxes) if the robotic total station will turn to
the Backsight point, and if the distance to backsight point should
be measured.
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* To check the quality of the chosen backsight point, tap the Check

button. The screen displays the residuals of the current backsight
point (Figure 8-36).

Setuleeas Data | mMap

Occupy ET1 1.000m ~
Backsight T1 2.000m
Azimuth 293°32'26"

HD Error

VD Error

HA Error 0°00'00"

BS Azimuth 293°32'26"

HA 0°00'00"

VA 84°36'16"

5D w
< >

Figure 8-36. Check Backsight

To set the backsight settings in the instrument, tap the Set
button.

Note that when moving to the next occupation, the previous
occupation point becomes a backsight point by default.

Sideshot (Topo) Survey

Once the backsight point is set, make a single sideshot.

1.

Tap Survey » Topo (Figure 8-37). Select the Sideshot Dir

measurement method using the settings button, and set the
order and the type of the measurements in a set.

On the Sideshot Dir screen, enter the point name, code, and the
height of the target.

Set the backsight point, if that has not been done before. Tap the
BS Setup button and follow the instructions in “Backsight
Survey” on page 8-36.

Check and enable the Traverse Point box to tag the point as
Traverse. The Traverse Points for the Measurement are stored
in the Traverse Point List.
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Figure 8-37. Sideshot-Direct

5. To select next occupation point, select the Adv entry from the
menu on the bitmap in the upper-left corner. Once the next
occupation point is selected from the traverse point list, the
controller automatically sets the current occupation point as the
backsight and the selected traverse point as the next occupation
point. If only one point is tagged as a traverse point, then this
point is automatically chosen as the next occupation point and
the current point is selected as the backsight (when the Adv
(advance) menu is selected).

6. To perform the sideshot, tap the [E button (Figure 8-37 on
page 8-39).

7. If a point location is unreachable, set offset parameters using
the Offsets tab. For details on these settings, refer to the
TopSURYV Reference Manual.

* Hz Angle — defines a point using the horizontal angle from one
point and the distance to another.

* Hz-Vt Angle — defines a point using the horizontal and vertical
angles.

* Dist. Offset — defines a point giving from which to add or subtract
distances horizontally and vertically.
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* Hidden Point — defines a point on the ground surface, with a
slanted rod touching the ground point. The rod has two targets.

* 2 Line ISection — determines a point by the intersection of the two
lines. Each line is defined by two points or two measurements.

* Line & Corner — determines a point on the corner using one line
defined by two points.

Line & Offset — determines a point distant from a line defined by
two points.

* Plane & Corner — determines a point (Corner) by a plane defined
by three points and an angle measurement.

8. If the IS Robot (Live Video) instrument with WiFi connection
to the controller is used for surveying, the live video of the
instrument view appears on the dialogs.

WiFi and Ad-hoc network connection can be
$ +established between IS Robot and FC-2200, FC-

2500, FC-200 or GRS-1.

The Video tab allows the user to touch the screen and have the
instrument drive to that location.

] —

[ Meas| Data |Map |vrdeo| OFfsebs|

Figure 8-38. Live Video
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Measuring Sideshot Sets

If the measurement method is Sideshot-Direct/Reverse (performed
using the (SS-Dir/Rev) Sideshot-Direct/Reverse screen,

(Figure 8-39), a set of sideshots can be measured once the backsight
has been setup.

The measurement to a single point is taken using the Direct Position
and the Reverse Position of the Total Station (that is, Plunge (flip).
Rotate the Total station by 180 degrees to get the reverse
measurement.

For instance, if the Total Station Measurements in Direct Position are
HA =70, VA =60, SD =143.23m, then the reverse measurements,
without any errors would be HA 250(=70+180), VA 300(=360-60),
SD=143.23m. One set consists of one direct and one reverse
measurement. These measurements are used to eliminate the Vertical
circle centering errors.

8 Meas | Data | Map | Set
Pairit |ResHa  |Resva |
4 -0°01'23"  0°00'38"
4 0e01'28" -0°00'38"
< >
[Remove IRe-Meas l l Accept l

Figure 8-39. Sideshot-Direct/Reverse

1. If necessary, change the measurement mode. Tap the
button, and select the mode in Meas Method.

2. Perform the sideshot survey as described in “Sideshot (Topo)
Survey” on page 8-38, taking any measurements necessary.

3. Move to the next point and repeat these steps. The last recorded
measurement is displayed on the Data tab.
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4. If a point location is unreachable, set offset parameters as
described above.

Angle/Distance Sets

If the measurement mode is Ang/Dist Sets-Dir/Rev (performed using
the Ang/Dist Sets-Dir/Rev screen), the instrument uses the specified
Angle sequence to perform repeated measurements. A sequence of
four measurements constitutes one set. One example sequence is:

¢ (1) the measurement of the sideshot in direct face

* (2) then the measurement of the backsight in direct face

* (3) then the measurement of the backsight in reverse face

* (4) finally the measurement of the sideshot in reverse face

1. To change the measurement mode, tap and pick the desired
mode.

2. Perform the sideshot survey as described in “Sideshot (Topo)
Survey” on page 8-38, taking any measurements necessary.

3. The last recorded measurement is displayed on the Data tab.

Tap the Accept button to measurements in the set when it is
complete.

5. If a point location is unreachable, set offset parameters as
described above.

Resection

The coordinates of the unknown point at which the total station is set
can be calculated by resection when the number of points of a known
position are observed. The location by resection can be performed
when a minimum of two points of known coordinates are observed.

1. Add the points of known coordinates to the Point List.

2. Tap Setup » Resection (Figure 8-40). This function is also
available from the Backsight Survey screen. Tap Setup »

Backsight, then tap the menu icon [= and select the
Resection item (Figure 8-34 on page 8-37).
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3. Set the name of the occupation point, the heights of the
instrument and the target. Tap Next.

h— €

Setup Rgsacti E} Occupy lm—
esaction 5 -
2

[F Ho [toon m
[f R [t500 m

Figure 8-40. Occupation Point

Only in Robotic mode the user can use GPS
@ positions instead of pre-defined control points for
calculating the resection task.

4. On the Resection 3D screen (Figure 8-41), select the point of
known coordinates from the map or from the list.

E_F:.e-seu:tiu:un D m &
| 8 weas [Dats [ vap | st |

ﬂh g HR. Il.SDD
[@®] Faint 110

E¥ code II—
N

HA 12°00'00"
VA 90°00'00"
SD 10.000

Measure F5 Direct

5

Figure 8-41. Resection

5. Select the Options item from the Help Icon menu in the upper-
left corner of the Resection 3D screen.
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6. Inthe Resection Options screen (Figure 8-42), choose whether:

* To calculate the height (3D) or just the horizontal coordinates
(2D). The 2D/3D option is retained between sessions to do a new
resection with the previously used setting.

* To calculate 3D resection using horizontal coordinates and
heights separately (2D+H) or jointly (3D Combined).

* To set your own values of accuracy for distance and angle

measurements.

E Resection Options
Resection Type "
Resection Method |2D+H v

Use Default Measurement Accuracy
Measurement Accuracy

Distance ID.DDS m

PP I3.D
Horz Angle IS.D seC
Wert Angle 10.0 seC

Figure 8-42. Resection Options

7. Aim the instrument at the point and enter the reflector height.
Then tap the [fi‘;l button to take the sideshot to the point.

8. Repeat the procedure for the remaining known points.

9. Open the Set tab (Figure 8-43).

10. Tap the Accept button. The coordinates of unknown points will
be calculated. In the screen that displays, enter the name of the
calculated point and tap the ok button [ ./ ]. The point will be
added to the Point List.
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Point | ResHA| Reswvall
1 0.0001 0.0000
2 -0.0000 -0.0000
3 -0.0000  0.0000

<
sdN  0.0007
sdE  0.0009
SdH  0.0044 Re-Meas

Accept

Ground to Grid scale Remove

0.9999985
Use Ctrl

IIII v

Figure 8-43. Set Tab

Resection from GPS Points

In Robotic mode, you can use GPS measured points for resection of
TS occupation point. This is only available if the user has defined a
project using grid to ground or localization.

1. Check mark the Enable GPS box to use GPS positions for
resection (Figure 8-44). You can use Bluetooth connection to
get GPS positions.

E Resection \/J—“q

% Occupy Al |E]
W HI 1.700 m
[ Hr [2.000 'm
GPS Options
Enable GPS Bluetooth

Prism to ARP Il].l332 m

Figure 8-44. Enable GPS

2. Set the offset from the prism to the Reference Point (ARP) of
GPS antenna attached to the prism road. Tap Next.
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3. Take GPS measurement of the points with GPS antenna
attached to the prism rod (see Figure 8-45 on page 8-46).

— Check mark the Measure GPS box. The status bar will show
information about GPS solution.

— Press [E to save a measurement. If necessary, the logged
measurement can be deleted by pressing the red icon.

E Resection 3D

4% Measurement |Data | Map I Meas Set |

il H v gg
IIU%- 0017 0020 9+ 6

[®] point  [100 3 resection 30 EllE R
Code [ | 18 Measurement | Data | Map | Meas Set |
Meas GPS 1 ulflas- ofbt oa2 ‘stg
[®] point [t
Code I :I
@ Meas GPS

Epoch count: 2

ol

Figure 8-45. Measure GPS

4. Clear the Measure GPS box and take TS measurements as usual
with a robotic total station (Figure 8-46).

Resection 3D m

4% Measurement |Data I Map I Meas Set |

NeCFE® k=

@ point  [1

Code

[] Meas GPS

Measure F5 Direct

HA 122°44°'04",VA 85°23'54",5D 6.902

[ [=]

Figure 8-46. Resection in Robotic Mode

The Measurement tab shows the current values of the total station
measurements and provides a set of tools for control. The arrow
button toggles between the total station status icons and search icons.
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Status icons:
N shows the battery status for the total station.

o shows the status of communication between the controller
and total station.

* g% — shows battery and memory status for the controller.
. — displays the current prism offset in use.

. / — switches on/off the arrow keys on the keypad to
adjust the rotation up, down, left, or right.
Search icons:

. — will trigger the RC-2/RC-3! to perform the “Quicklock™ or
“Turn Around” command.

. — causes the instrument to perform a standard search for the
prism.

— will lock onto the prism that is in the field of view or
“track” it without searching.

[ - opens the Rotate dialog (Figure 8-51 on page 8-51), which
allows the Total station to turn to various angles or points.

. — interrupts the total station and stop it from searching the
prism and turning; the instrument will go into “Standby” mode.

1. RC-2/RC-3 is the Remote Control System 2 or 3 for optical
communications. For instructions of how to operate the RC-2/RC-3
device, consult the instruction manual for RC-2/RC-3.
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Remote Benchmarks

The elevation or height of the point at which the instrument is set can
be calculated when two or more points of known coordinates are

observed.

1. Add the points of known coordinates to the Point List.

2. Tap Setup » Remote BM. This function is also available from
the Backsight Survey screen. Select the Setup » Backsight
icons, then tap the icon menu next to the Map icon in the Occ.

Point field and select the Elevation item (Figure 8-34 on

page 8-37).

3. On the Elevation screen set the occupation point for which the

elevation will be calculated (Figure 8-47), tap Next.

f— &

Setup Rernate BM

E_EIE'-.-'ath:un |
fg} ooy IE

E3
[F Ho [reon m
[f R o077 m

Figure 8-47. Unknown Elevation
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4. On the Known Elev screen (Figure 8-47), select the point of
known coordinates from the map or from the list.

# Meas | Data | Map | set
@? e HR |1.500

[® [ pont JJio
E¥ code II—
[1

Taking a Measurement...

&

Figure 8-48. Known Elevation

5. Aim the instrument at the point and enter the height of the rod
(target). Tap the [‘El button to take the sideshot to the point
6. Repeat the procedure for the remaining known points.

7. Open the Set tab in the Known Elev screen (Figure 8-49 on
page 8-49), tap the Accept button. The vertical coordinate of
unknown points will be calculated.

#* Meas | Data | Map | Set l
Point | Res va | Res Ht |
0.0001 0.002
2 -0.0000 -0.001
4 -0.0001 -0.003
< >
I Remove ] I Re-Meas ” Accept ]

Figure 8-49. Calculate Vertical Coordinates for Unknown Points
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8. In the Store Point screen that displays, enter the name of the
point and tap [/ ].

Remote Control

If the survey process is performed by one person with a robotic
instrument, the remote control is used for the transmission of the
commands from the controller to the total station. The radio modems
need to be set and connected to the controller and the instrument.

1. Tap Setup » Remote Control (Figure 8-50).

A — | &

Setup Remaote Ctrl

HA 125°21°26°,VA 81°34'157,5D
4.780 {m)

-

Q)

Figure 8-50. Remote Control
2. On the Remote Cntrl screen, you can rnake the instrument
search for the target (with the Search icon), lock on the
target (with the Lock |(%) . icon), stop rotating (with the Stop
| icon) and rotate to a pre-defined angle (with the Turn C]

icon). The icon [ will trigger the RC-2/RC-3 to perform the
“Quicklock” or “Turn Around” command.

3. Tap the Turn :J; icon. The Rotate screen displays.

Enter the following rotation angles on the Rotate screen
(Figure 8-51 on page 8-51).
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* Tap the Turn button on the Rotation Angles panel to rotate
the instrument. The instrument can also be made to rotate to a
point.

* On the Rotate to Point panel, enter a point name, or choose
one from the map or a list, and tap the Turn button.

* To Plunge the instrument (rotate the telescope and the body
by 180 degrees), tap the Plunge TS button.

All the observations can be done in the remote mode as well, if
the instrument chosen is robotic.

P rotate

Rotation Angles

Hz |125°21'25"
vert  [B1oa418"
Rotate to Paoint

@] eaint |

B = fom m

Turn

A
o

~P Flurge TS

Figure 8-51. Rotate

Cross-Section

A cross-section survey is performed to obtain the coordinates of
points that lie on a plane perpendicular to a center line. This type of
survey is typically performed by moving from one side of a road to
the other in the cross-sectional plane, and then crossing back in the
opposite direction at a different location along the road. This process
is repeated at different stations along the centerline, until all the
desired cross-sectional points have been observed.

1. To start working, tap Survey » X-Section (Figure 8-52 on
page 8-52).
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2. On the Cross Section screen (Figure 8-52 on page 8-52), select
or enter the following parameters for the station where the
survey will be performed, then tap [ ./ ] : the road name, the
code and attributes of the center line, the station where the cross
section is surveyed, and the interval distance to the next station.
If the road has not been created, define the plane.

‘ !’\ <n> E Cro tion -m
Survey ¥-Section & Iwayll

Code II w
|1 v

Station |1+DD.DDD m
Interval IlD.DDD m

Figure 8-52. Cross Section

The Station and Interval fields appear only if the
road is selected.

3. Inthe XSect-Dir screen (Figure 8-53 on page 8-53) perform the
usual observation work, relative to the cross-section, as
described in “Measuring Sideshot Sets” on page 8-41. The only
difference lies in the presence of the Cur Stn button, which

makes the measurement, but unlike the |lH| button does not
store the point (Figure 8-53 on page 8-53).

4. Cross-sectional points at the same station should have different
codes, with at least one of them having the centerline code. For
example codes for cross-sectional points could be A, B, C, ¢,
D, E, E in the order of survey. After the [/ | button is tapped,
the station number automatically changes. Also, the application

8-52 TopSURYV User’s Manual



Performing Total Station Surveys

automatically uses the same codes, but in the opposite order for
the next station (F, E, D, cl, C, B, A). The station and the codes

can be changed.

[®] code ||.'1\
fle  [oomo m

XSect Dir

# Meas | Data | M
@Point IDREISlD

Along CL: 0.000, Offset: 0.000

Measure F5 Direct
[ Traverse Paint

Find Station

Figure 8-53. XSect-Direct

The Find Station task is used for the identification of the station by

computing the distance from the beginning of the road to the

projection of the station to the road, and the offset of the station from

the center line of the road.
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1. To start working, tap Survey » Find Station (see Figure 8-54).

»

Suryey

2. If needed, set the backsight point. Tap the BS Setup button and
follow the instructions in “Backsight Survey” on page 8-36.

Find Station

| &% CESE = |

| # Meas [Resutts | Map |
#| Road |Way11
Bl &
[®] roint  [presiz [
IE Code IA—v
8 O EY @3S

Measure F5 Direct

BS Setup

Figure 8-54. Find Station — Measurement Tab

3. Enter the road, the name and the code of the point and the
height of the rod (target) (Figure 8-54 on page 8-54).

4. To compute the result with an existing point, tap the Pt Stn
button.

5. To compute the result with the coordinates of the current

location, without storing the point, tap the Curr Stn button.
6. To take a sideshot and store the coordinates to a point, and

compute the result with this point, tap the [E button.
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Tape Dimension

Use the Tape Dimension task to calculate the periphery of structures
such as buildings that have features perpendicular to each other. This
is done using tape measurements, relative to the two known points
that belong to one side of the structure (wall of the building), forming
the so called reference line.

1. To start working, tap Survey » Tape Dimension (Figure 8-55).

> P

Suryey

Tape Dirn. Start Pt

Point
|:| Code

End Pt
Point IDREIN

|E| Code A

Figure 8-55. Tape Dimension — Ref Line Tab

2. On the Tape Dimension tab, set the parameters for performing
the survey: the name and code of the surveyed point, and the
direction (left or right of the previous line) and the distance of
the movement from the previous point (Figure 8-56).
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3. To apply the taped distance to the perimeter line, tap the Accept
button.

|§| Pt RESL -

—=10m

E‘ Dist Left [ Accept l
fo.000 Fiish

Figure 8-56. Tape Dimension — Tape Dim Tab
4. You can close the Tape Dimension work in one of two ways:

* To connect the first and the last point with a line, tap Finish
and select Close Polygon from the menu.

* To calculate the difference between the first and last point, tap
Finish and select Calc Closure from the menu.

Missing Line

The Missing Line task emulates the total station measurement from
one point to another and stores the result to the Raw Data database.

1. To start working, tap Survey » Missing Line (Figure 8-57 on
page 8-57).
2. Enter the Start and End points names and codes (Figure 8-57).

To measure the point, tap the Meas button in the corresponding
field.

3. The Data tab displays the results of the measurements (the
measurement is performed when the Data tab is chosen). The

same result is reflected in the Raw Data screen, with the type
MIM.
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Suryey Missing Line Start Pt
Point
|:| Code
End Pt
Point IDREIN
|E| Code IA

Figure 8-57. Missing Line — Ref Line Tab

Auto Topo

This function is activated only with Robotic instruments, and collects
points by Time and Distance.

1. To open the Auto Topo screen, tap Survey » Auto Topo in the
Robotic mode.

A

Survey Auto Topo

HA 0°00°00"
VA 85°09'08"
SD 7.012

Figure 8-58. Auto Topo
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1. Enter the point name, code and the height of the rod
(Figure 8-58).

2. To set the Auto Topo method and interval, tap the button

and enter the desired values in the corresponding fields in the

second Mode screen. Tap [./ ] to save the changes and return
to the Auto Topo screen.

3. Tap the Start button (after tapping, the button changes to
“Stop”’) and begin moving.
To store the current position, tap the Log Now button.

5. To make the instrument search for the prism, tap the Search

button.

6. To lock onto the prism that is in the field of view or “track” it

without searching, tap the Lock icon.
7. To send the “Quicklock” or “Turn Around” command, which
will cause the Total Station to search for the RC-2/RC-3!, tap

the Qlock icon.

8. To turn the Total Station, tap the Turn icon and enter the
desired horizontal and vertical angles, or the direction point on
the Rotate screen. Tap Turn in the corresponding field to
perform the rotation (Figure 8-59 on page 8-59).

Tap [/ ] to return to the Auto Topo screen.

9. To stop tracking the prism and take the “Standby” mode, tap the

Stop icon.

1. RC-2/RC-3 is the Remote Control System 2/3 for optical
communications. For instructions of how to operate the RC-2/RC-3
device, consult the instruction manual for RC-2/RC-3.
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| &2 B2

Rotation Angles

Hz [1z5°z128"
vert  [B1oa418"
Rotate to Paoint
@] eaint |

4
B = fom m

Turn

of [ ] @

Figure 8-59. Rotate

Scanning

This function is activated only with Robotic and Motorized

reflectorless total stations, and can collect points with or without
using images.

1. To open the Scanning screen, tap Survey » Scanning in the
Robotic mode (Figure 8-60).

Suryey

Scanning

scan with Image

Figure 8-60. Select Scanning Type
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2. On the Scanning screen, select a desired scan type, either Scan
with Image or Scan w/o Image, and tap Next (Figure 8-60).

In order to import an image into TopSURYV to scan,
@ the image must be captured with a calibrated, fixed
focal length camera.

Scanning with Images

On the Select Scan screen (Figure 8-61), enter the following scan
session parameters.

1. Select a name for the session from the Session drop-down list.

2. Select a previous Image from the Image drop-down list or
browse for a new one (images are stored as JPEG with file
extension *.jpg).

3. If the image exists in the Job, then the Camera information will
be automatically selected. Otherwise, select a previous Camera
from the Camera drop-down list or browse for a new one
(Cameras are stored as a text file with the extension *.cmr).

4. Once all fields are filled, click Next.

E Select Scan

Session

| First_sesslon »

Image
| image_for_scan.JPG "
Camera

| min_focal.cmr "

|

Figure 8-61. Enter Scan Session Information

* Click the View button to open the Orient screen (Figure 8-62 on
page 8-61). This screen displays the image, along with orientation
and scanned points for completed scan sessions.
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aaafem

Tap on Orientation Pt

Figure 8-62. View Completed Scan Session

5. Perform image orientation. On the Orientation screen
(Figure 8-63), associate a position on the image (x,y) with a
known coordinate (N,E,Z).

o Orie %

REENG

Tap on Orientation Pt

Meas << Back | Mext >

Figure 8-63. Perform Orientation
* The Pan button enables drag control of the image. When
disabled @) tap on the image in the general area of where the

orientation point is located. The image will zoom to this point and
show a crosshair (Figure 8-64 on page 8-62).
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AaySleE

Select or meas Orient Pt

[ Meas ]v[ << Back ] Next »»
S|

Figure 8-64. Select Orientation Point

* To view the image, select one of the two options from the drop-
down list in the bottom left corner of the screen:

— Tele (telescope) is the default zoomed-in view of the crosshair
(Figure 8-64)

— Wide View zooms out and shows the area of the image which
contains the orientation point (Figure 8-65).

%l%l [wide ~

Select or meas Orient Pt

[ Meas ]v[ << Back ] Next »»
S|

Figure 8-65. Select Orientation Point — Wide View

* Adjust the position of the crosshair.
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— When the Arrow button is enabled |§| , use the arrow keys
on the keypad to move the crosshair up, down, left, or right.

— Use the El button to move the crosshair to the center of a

circular object on the image. First tap somewhere inside the
circular object. The object should be a well-defined circle
with high contrast between the inside and outside of the
circle.

* Use the bitmap menu options (Meas, From Map, From List)
to take a measurement or to select an existing point from a map or
list.

* To delete the selected orientation points, select the points and tap

the Delete button on the Orientation Res screen
(Figure 8-66).

E_ Orient Res b 4

Name ||:I)([pi... ||:IY[p... |
oriod4  -2.5 -0.5 GOOL
orio3 2.5 0.4 BAD

voriol -2.4 -0.3 GOOL
orin2 2.4 0.4 BAD

< >

MAX dX:2.5 dY:0.5 GOOD
RMS dX:2.5 dY:0.4 BAD

[ Delete I << Back ][ Next >3 ]

Figure 8-66. Delete Orientation Points

* When four or more orientation points have been established, tap
the Next button on the Orient screen (Figure 8-67 on page 8-64)
to display the orientation results.
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ajajafem

Tap on Orientation Pt

Meas v' << Back || Next >>

Figure 8-67. Calculate Image Orientation

6. View the image orientation results on the Orient Res screen
(Figure 8-68). The results for each Orientation Point is
displayed as dX and dY in image pixels.

EHoww: B3

Name ||:I)([pi... ||:IY[p... |
oriod4  -2.5 -0.5 GOOL
orio3 2.5 0.4 BAD
oriol -2.4 -0.3 GOOL
orin2 2.4 0.4 BAD

< >

MAX dX:2.5 dY:0.5 GOOD
RMS dX:2.5 dY:0.4 BAD

[ Delete I << Back ][ Next >3 ]

Figure 8-68. Orientation Results

» Tap Back to continue to the Scan screen to select areas for
scanning.
* To adjust the orientation calculation, select a point and tap

Delete. If four points still remain, the new results are displayed.
If there are less than four orientation points, then the results
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screen will automatically close to continue the orientation
procedure.

7. Select one or more areas to scan, using one of the following two
methods and then begin the scan.

* Scanning method A: Draw a rectangle by tapping the stylus on
the screen for the start point and dragging to the end point. When
the stylus is lifted, the area is set.

* Scanning method B: Draw a polygon by tapping the stylus down
at each vertex. Lines will be drawn connecting each vertex to the
previous one. Tap the stylus near the first vertex to close the area.

RVR\EN)

Draw Scan Area, then press Next

[ Clear I << Back ][ Next >3 ]

Figure 8-69. Select Rectangular Scan Area

* Tap the Settings button to set the instrument to “Non-Prism”
mode, which is required for scanning and also to change the
measurement mode (Fine or Coarse).

* When the areas are set, tap Next to begin the scan. The Interval
screen displays to set the scanning settings (Figure 8-70 on
page 8-60).

* Tap Clear to erase all areas previously drawn.

8. Select a scanning interval. Enter the starting point name and the
horizontal and vertical intervals. The intervals can either be
entered as angles (Figure 8-70) or number of points. Tap Next.
The Estimate Time screen displays (Figure 8-71).
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[ EEE |
Start Pt IDREIS 12

Scan Mode IFine v
Meas Mode INormaI MP v

Interval Cistance

H Dist ID.SDDDD m
W Dist ID.SDDDD m

Figure 8-70. Select Scanning Interval

View the time estimate. Before scanning begins, the scanning
information is displayed including the total number of points to be
scanned and an estimate of the time it will take to complete the scan.

E Estimate Time

Start Pt DRBS12

Scan Mode  Fine

Meas Mode  Mormal NP
H Interval 12°46'44.5"
Y Interval 0ezz'46.6"

Areas 1
Points 152
Time 00:10:23

Figure 8-71. Estimate Time

9. If the estimated time is too long, click and enter larger
intervals. Finally, click [/ ] to begin scanning points.

10. View the scanning in progress. As the total station measures
points within the pre-defined area, each point will display on
the image (Figure 8-72). If necessary, click Stop to stop the
scan.
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RVR\EV)

Scanning...

Figure 8-72. Scanning with Images

Scanning Without Images

1. Set the type of scan orientation and tap Next to select the scan
area on the Area screen (Figure 8-73).

Scanning

|Scan wio Image »

Figure 8-73. Select Orientation Type

2. Select the Scanning Area on the Area screen (Figure 8-74 on
page 8-68). The starting and ending points for the scanning area
can be selected from the Point List or Map, or measured
(Figure 8-74). When finished, click Next.
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4Ptz 4Pt3

Select or meas Paint 1

Figure 8-74. Select Area

3. The same Interval and Time Estimate screens will be displayed
(Figure 8-70 on page 8-66 and Figure 8-71 on page 8-66).
4. View the scanning in progress. As the total station measures

points within the pre-defined area, each point will display on
the screen (Figure 8-75).

Scanning. ..

Figure 8-75. Scanning without Images

* Tap Clear to remove measured points from the screen and
return to the Area screen.
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 Tap Stop to immediately stop the scan and return to the Area
screen.

5. After scanning is completed, the screen returns to the Area

screen to set a new area for scanning. The [ icon denotes the
scanned points in the list of points.

sure the Show Scan Points item is check marked in
the pop-up menu in the upper-left corner of the
Points screen.

@ To show scan points in the list of job points, make

Monitor

The Monitor function measures one or more prisms repeatedly and
uses the measurements to detect changes in the position of the prisms.
The measurements are recorded into the raw data file.

1. Set the format and destination for the output file in the Monitor
Options screen which is accessed from the context menu in the
upper-left corner of the Configure Instrument dialog box
(Figure 8-76).

E Monitor Options

E Monitor Options

Log To IFiIe » Log To oML
Type IRaw Data w Type IRaw Data w
Format =C-6/GTS-7 Format IFC-EU‘GTS-? w

File Mame I\Storage Card\ TPS\T

Cornm Settings
Baud [115200

Parity  [Mone
Data |2
Stop |1

L4 1E9 B9 |

[]store &5 check Point []store &5 check Point

Figure 8-76. Monitor Options

Optionally, the raw measurements or the computed points can be
output to a file or communication port in either FC-6 or GTS-7
formats.
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2.

The available options vary, depending on whether a file or a COM
port is selected. In the case of file output, one can browse for the
destination of the file using the List [...] button

Add the points to be measured to a point list. The list is then
used in monitoring the survey.

Tap Survey » Monitor (Figure 8§-77). The Monitor Pointlist
screen opens to load the desired point list (Figure 8-77).

P — Mo

5 [&] Ppoint List [PointList1
rvey Maritar 2
[

List of Points ~ '% .

42 :
gi A 8 occptl

< > =200 m
[ [»]
HR |2.uuu m

Figure 8-77. Monitor Point List

After the point list is selected, tap the Next button. Another
Monitor screen displays (Figure 8-78 on page 8-71).

Tap the @l button to initiate the sequence of measurements

which repeats at the desired interval listed as the Cycle Time.
If a prism cannot be found after a period of 15 seconds, the total
station will rotate to the next point in the sequence. If “ON” is
selected from the Auto field drop-down list, the total station
automatically rotates to the next point in the sequence and
records a measurement. If it is set to “OFF”, the total station
rotates to the point, but allows you to verify or correct the
centering to the prism prior to taking a measurement. The
monitor function will always complete the entire sequence,
even if the measurements take longer than the cycle time.
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P&

Press Start when ready

[®] Foint 138 (B [® roint 139
Cycle Time ID secs Cycle Time ISD e
Auto On Auto on

HA 0°00'01"

VA 85°09'09"

5D 7.012

Measuring Point {1f3)

7| |

O

Figure 8-78. Monitor

6. View the data displayed in the Data tab. The values listed are
the differences between the coordinates of the reference point
and the measured point.

Performing Level Surveys

After completing preliminary work (that is, the instrument is leveled
in a desired location above the reference point and the controller is
connected to the instrument with the cable), the survey can begin.

First, if needed, perform the Two Peg Test to check if the line of sight
of the level telescope is horizontal when the instrument is leveled.
Then perform Level Run in appropriate sideshot survey mode (single
or multiple). Refer to “Config: Survey Parameters — Level” in the
TopSURYV Reference Manual for details.
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Two Peg Test

To execute the Two Peg Test, tap Survey » Two Peg Test
(Figure 8-79 on page 8-72).

The Two Peg Test screen guides you through a series of
measurements to help determine any errors.

1. First, take shots to the first point assuming the level is fairly
centered between the two points.

\ \ \I;? E_T'-.-'-.-'n:l Peg Test
® |l
LIFvEn [Twio-Peq Test

Measure to Pegl(pl)

Locate Peg2

Figure 8-79. Take Peg 1 Reading
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2. Then move the instrument to one of the pegs and take the shots
again to Pegs 1 and 2 (Figure 8-80).

3 o Peg Test

dpl 4ol
pl: VD:1.200, HD:5.000

Measure to Peg2(p2)

Locate Peg2l [ Meas ‘

Figure 8-80. Take Peg 2 Reading

* Tap the Locate Peg2 button to measure the horizontal
distance to Peg2 and compare it with the already taken
measurement to Pegl. This measurement is not used in the
error computations.

» Tap the Meas button to take measurements for the displayed
prompted Peg (Figure 8-80 on page 8-73). The Two Peg Test
Results screen displays.

The Two Peg Test Results screen (Figure 8-81) displays the results of
the test after all measurements are taken. The computed error means
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inclination of the actual line of sight from true horizontal. This error
is proportional to the distance from the level to the rod.

3 &
Shot Data
pl WD 1.000
pl HD 2.000
p2 WD 1.045
p2 HD 2.005
pl' WD 2.050
pl' HD 1.000
p2' WD 2.005
p2' HD 1.000

Error = 0.000

i

Figure 8-81. Two Peg Test Results

Level Run

To set up a Level Run, tap Survey » Level Run (Figure 8-82 on
page 8-74). The Level Run screen displays.

1. Type in a name for the level run and any additional information
on this level, if needed. Tap Next.

P [
Survey Level Run Mame
MNote b & road

Figure 8-82. New Level Run
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Tap on the DL tab to display all leveling data in progress
(Figure 8-83).

Pairt Code | BS -~
1.1000

DRES12 1.1250

DRES13 1.0900

>
[orEs16
O =

[ 85 |[ ss | s |

Figure 8-83. Leveling

2. Select the point for a rod reading in the [¢] field. Select it from
the map or from the list of points.

3. Set the code for the measured point in the ¥ field. Use the
bitmap menu next to the field to set a new code.

4. Use an appropriate tool to make leveling measurements:

* BS — usually sighting back along the leveling line, the Level
takes a rod reading on a point of known elevation.

* SS — the Level takes a sideshot to the point.

* FS — the Level takes a rod reading on a point of unknown
elevation.
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Tap on the Data tab to view information related to the current
measurement (Figure 8-84).

| Runial)
Data
Paint DRES16
Elev 0.263
ES 1.0900
HI 1.263
ES Dist 0.000

Surn BS Dist 24,600
SumBS-SumFS 1,500

MNotes
FS 1.0000
FS Dist 10,000

Sum FS Dist 23.100
Accurnulated.., 0,263

Figure 8-84. Data Level Run

5. Use the Vertical Offset option from the bitmap in the upper-left
corner of the screen to set the vertical offset to apply at the
point.

6. To select the columns and the order of the columns to display in
the fieldbook, use the Display Settings option from the bitmap
in the upper-left corner of the screen
(Figure 8-85 on page 8-76).

E Settings

Colurnn to Display ~

¥|Code

v |ES

v HI

v F5

¥ Elev

v|ES Dist

v|F5 Dist

v|5um BS Dist

v|5um FS Dist

v SumBS-SumFs v

< >

Figure 8-85. Change Display Columns
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7. To display the SumBS-SumF'S measurement, select the Show
SumBS-SumFS option from the bitmap in the upper-left corner
of the screen.

8. Use the Inverse option to perform the Two-Point Inverse cogo
computation.

9. Select a stakeout option from the bitmap in the upper-left
corner of the screen for DL survey mode to stake a Point, Point
List or Elevation. Staked points are not added to the level run,
they are independent.
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Notes:
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Chapter 9

Staking Out

The Stakeout process involves finding points near a desired location.
The preliminary work for GPS, Total Station, and Digital Level
stakeout is similar to that for the Survey work.

The stakeout function can be accessed from the Stakeout menu or
from the Main Map.

When in the Main Map, tap the desired object to highlight it. Then
hold the stylus on the selected object until a pop-up menu displays
(Figure 9-1). The menu options depend on the object selected. Select
the appropriate item from the pop-up menu.

| & 31 R -~ |
T—com (-]

2006 77 5 0
’ . 7agg . 2001
. 7498

7403 Stakeout
: Point In Direction

EFEEE0E)

7494
: Edit

o002 Delete

@ Add To Layer

Map Properties

Figure 9-1. Stakeout from Main View

P/N 7010-0493 9-1



Staking Out

Stakeout a Point

1. Tap Stake » Points. The Stakeout Pt screen displays. See
Figure 9-2 on page 9-2.

2. On the Stakeout Pt screen, tap the button.

Stake Paints _q} Design Paint

[::4
IE Code &
z
Mote
Ant Ht oo m
[Vertcal v |

Stake Report
8 ]

Figure 9-2. Stakeout Point
3. To stake out a point for GPS+ do the following:

¢ On the Stk Parms screen, specify the following stakeout
parameters: enter the horizontal distance tolerance (Hz Dist
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Tolerance), select the Reference Direction, and select the Solution
Type value. Then tap the ok [/ ] button (Figure 9-3).

Hz Dist Tolerance IIJ.IZISIII m

Reference Direction

|Mmring Direction v
Solution Type
|Fixed Only »

Auto Accept

Num Meas to Avg |3

[] Precision (m)
Hz [0.0150  vert [0.0300

Figure 9-3. Stakeout Parameters - GPS+ mode

4. To display the icon for the staked point on the map, select the
Display option from the bitmap menu in the upper-left corner of
the Stk Parms screen (Figure 9-4). In the Staked Point Icon

screen, set appropriate parameters for the icon.

5. To stake out a point for the TS: set the horizontal distance
tolerance and reference direction. Also, select the manner in
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which the Total Station should be turned towards the design
point. Then tap the ok [/ ] button.

Hz Dist Tolerance W m
Reference Direction
|Instrument Reference v
Turn TS to Design Pt

|HA only »

[]search After Turn

[[]Num Meas to Avg |1lII

Figure 9-4. Stakeout Parameters — TS mode
6. On the Stakeout Point screen:

* Select the design point from the list or a map, or insert the name
manually.

» Specify the antenna parameters: the height value and type or the
height of the rod, based on whether you are in GPS+ mode or TS
mode.

* Check if the PTL Point Stakeout is performed.

* Set the current stake report. Select it from a predefined list using
the ] button. For details on stake report configuration, see

“Configuring Stake Reports” on page 4-88.

routines. To view the report, select the View Report
option from the bitmap menu in the upper-left
corner of any stake screen.

@ Stake Reports are available for setting in all stake

* Tap the Stake button (Figure 9-2 on page 9-2).
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GPS Stakeout

7. For GPS+: use the information on the Stakeout screen for
finding the target point (Figure 9-5). Tap @ after the location

is close enough to the design point. Tap the E button to
change the design point (increment to the next point in the data
set) of the stakeout.

o H V&
1IU%F'*ed 2201 3200 10+3

B

Dir to Dsgn 181°12'05
Fill 2.212

HD to Dsgn 9.762
Right 2.865

Figure 9-5. GPS Stakeout

TS Stakeout
8. For TS: sight the prism. On the Stake screen (Figure 9-6 on

page 9-6), use the @ button to take a measurement and then
show the current position relative to the design point.

9. Use the EDM button to select distance measurement mode.

Tapping the [E button causes a measurement to be taken, and
the computed coordinates to be stored to a point.

Tap the desired button from to stakeout the next
(increment to the next point in the data set) point in the data set
or return to the previous one.
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EIK
HR. I.DDD i

18

Dir to Dsgn 2°31'31.2"
Fill 4.185

HD to Dsgn 1.159
Right 0.008

[ owe | [=I=IFald

Figure 9-6. TS Stakeout

10. For Robotic TS: you can use the search icons to control TS.

Dir to Dsgn 127°37'55
Cut 2.246

HD to Dsgn 3.197
Left 0.579

[ - =~ |

Figure 9-7. Stakeout with Robotic

. — will trigger the RC-2/RC-3! to perform the “Quicklock” or
“Turn Around” command.

1. RC-2/RC-3 is the Remote Control System 2 or 3 for optical
communications. For instructions of how to operate the RC-2/RC-3
device, consult the instruction manual for RC-2/RC-3.
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. — causes the instrument to perform a standard search for the
prism. This function is useful for setting the stake and measuring
the final position.

— opens the Rotate dialog (Figure 8-51 on page 8-51), which
allows the Total station to turn to various angles or points.

. — interrupts the total station and stop it from searching the
prism and turning; the instrument will go into “Standby” mode.
This function is useful for moving the pole to set the stake in the

The icon displays the current prism offset in use.

11. If the IS Robot (Live Video) instrument with WiFi connection
to the controller is used for staking, you can again use the arrow
button to open the live video of the layout of the target and

the current position shown graphically. Touch the screen and
have the instrument drive to that location.

Stakeout Views

12. You can switch views of stakeout process using the View Panel
option from the pop-up menu on the top left corner of the
screen.

the stylus in the map area on the Stake screen. The

i ; i The same context menu can be accessed by holding
~,
last view mode is recalled between sessions.
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* Select Data View to display all possible data of staking.

il H v ghgt
@10%':"‘ed 2201 3200 10+3

Fill 2.214
Ell ht 184.676
Dsgn Ell ht  186.889
Back 23.851
Right 11.026

HD to Dsgn  26.276

SD to Dsgn  26.369

Dir to Dsgn  181°12'18.3"
North 6179462.748
East 409377.079

Figure 9-8. Data View of Stakeout

* Normal View is default that shows graphic and text live values of
stakeout (see for example Figure 9-5 on page 9-5).

* Select Overhead View to display the graphical view of the layout
of the target and current position (Figure 9-9 on page 9-8).

| e H v G
@130%':"‘ed 2201 3200 10+3

I *

—=10m -$'
Dir to Dsgn 181°11'43
Fill 2.215

HD to Dsgn 44.272
Right 15.988

Figure 9-9. Overhead View of Stakeout

* Select Map View to display the full screen graphical view of the
whole job with the highlighted design point and current position.
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— 7 orw Dsgn 181°11'46°

e B
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Figure 9-10. Map View of Stakeout

Stakeout Values

13. All graphical views contain four user definable labels for
showing any live value (see Figure 9-10). You can tap on one of
them to change it on the Select Value screen (Figure 9-11 on

page 9-9).

Stakeout a Point

Highlight a desired value and press the ok [ ./ ] button to display
instead of that you clicked.

P/N 7010-0493

Stakeout Values

E Select Value - m

(Off)

CutfFil

Current Elevation
Diesign Elevation
Forward/Backward
Left/Right

Horz, Dist, to Design Pt
Slope Dist. to Design Pt
Azimuth to Design Pt
Current Morthing

(Current Easting

[ ]use Maximum Text Height

Figure 9-11. Select Value
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Changing Rod Height

14. You are able to change the rod height either directly on the
stakeout navigation screen or using the Rod Height option from
the pop-up menu opened with the Help icon on the top left
corner of the screen.

EEnter Rod Height:

HR [i.000] m

Figure 9-12. Enter Rod Height

Store Point Information

15. Select the Design Pt/Layer option from the menu popped up
after tapping the bitmap in the upper-left corner of the Stakeout
screen. In the Store Design Point screen (Figure 9-13), select
the layer from the drop down list or tap the List [ ... ] button to
edit layers.
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Layer

Figure 9-13. Select Layer for Staked Point

|<Ely Codes

7 ]

Stakeout a Point

Display Store Pt Info is enabled by default to display information on
the staked point before storing it. Check the Advance box to open the
Stake screen automatically for the next point.

Stare Point 4

Stake | Code | Mote | Data

Marne | Wallie | e
Stake Pt. DRAMNI_stk

Stake Mote DRANL

Stake Code

Stake 035,623

Stake 1.292

Stake Elev 1.967

drorth -60.535

dEast -0.010

dElev -2.212

Culd

Fill 2.212

Time 2010:07:26 13,
Advance

Figure 9-14. Store Point

The Store Pt Info screen allows editing the current staked point
properties (on the Stake, Code and Note tabs), shows the stakeout
report for this point (on the Data tab), and allows setting properties of
the calculated design point, when applicable, for example in the Line

& Offsets stakeout task.
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Design Offsets

16. To change the elevation of the staked point, select the Design

Offsets option from the Help Icon menu in the upper-left corner
of the Stakeout screen. Check and enable the Design Elev box
in the Design Elevation screen to manually edit the elevation
value (Figure 9-15).

Diesign Eley

=

Road Offset
I m
DTM Offset

V] Jo:s00 m

Figure 9-15. Design Elevation

Stakeout a Point in Direction

Perform a Stakeout Point in Direction task when the location of the
design point is unknown, but can be computed with distance and
angle offsets from a known point.

1.

To perform a Point and Direction stakeout, tap Stake » Point in
Direction (Figure 9-16).

In the Stakeout Point & Direction screen, enter the starting
point name (known point), the azimuth set by value or as the
direction to another known point, the angle offset from the
azimuth line, the distance offset along the angle offset line, the
height offset, and the parameters of antenna (GPS mode) or the
height of the rod (target) (TS mode).

Enter the name of the stakeout point in the Store Pt field. Tap
the Stakeout button (Figure 9-16 on page 9-13).
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Stake Report
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Figure 9-16. Stakeout Point & Direction

3. For GPS+: use the information on the Stakeout screen to find
the target. Tap Store once the position is close enough to the
desired one (Figure 9-17).

]
g H v &g
@130%':"‘ed 2201 3200 10+3

B

Fill 2.214

Back 14.587

HD to Dsgn 15.516
Right 5.289

111 @

Figure 9-17. Stakeout Point & Direction — Stakeout

4. For TS: sight the prism. In the Stakeout screen tap the Cur Pos
button to check the position. Use the EDM button to select
distance measurement mode: Coarse, Fine or Coarse Tracking.

Once the position is close enough to the desired one, tap [E to
store it (Figure 9-18).
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Figure 9-18. Stakeout Point & Direction — Stakeout

Stakeout a Point List

1. To stake out points in a point list, tap Stake » Point List
(Figure 9-19).

=
H—

Stake Point List

oint: List

B Paint List tList T
(4]
List of Points & ‘H‘.:. 10 m

% DRANL
€ ORENL

< 4

E] [Jreverse Order E]
Ant Ht ID.DDD m
IVerticaI e

Stake Report
L L]

Figure 9-19. Stakeout Point List

2. In the Stakeout Point List screen, select a pre-existing points
list, set the antenna parameters (GPS mode): height of the
antenna reference point (ARP) above the mark and the type, or
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the height of the rod (target) (TS mode).
To perform a stakeout, starting from the end of the Point List,
check and enable the Reverse Order box. Use the arrow buttons
to modify stakeout order. Then tap the Stakeout button
(Figure 9-19 on page 9-14).

3. For GPS+: use the information on the Stakeout screen for
finding the target. Tap [E after the position is close enough to

the designed point. To move to the next point, tap the ==
button.

4. For TS: sight the prism. On the Stakeout screen tap the gl
button to check the position. Once the position is close enough
to the desired one, tap [E to store it. To move to the next
point, tap the button.

5. To stakeout another Point List, tap to return to the
Stakeout Point List screen and select another point list.

Stakeout a Line

To stake points along a line, tap Stake » Lines (Figure 9-20).

2. On the Stakeout Line screen (Figure 9-20 on page 9-16),
specify the reference line by choosing the start point and either
the end point or the azimuth. Currently, the stakeout points have
the same height as the starting point. Also, specify the antenna
parameters (GPS+ mode), or the height of the rod (TS mode).
Tap the Stake button.
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Stake Report
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Figure 9-20. Stakeout Line

3. For GPS+: use the information on the Stakeout Line screen for

finding the target line. Tap [E after the point is close enough
to the line and at the desired distance from the starting point

(Figure 9-21).

7 TR

il H v gg
z]lﬂ%- 2201 3200 10+ 3

F

To Line R 7.564
Fill 2.215
Offset L 7.564
Ell ht 1.973
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Figure 9-21. Stakeout Line

4. For TS: sight the prism. On the Stake Point screen, tap the [l
button to check the position (Figure 9-22). Once the position is
close enough to the line and at the desired distance from the

starting point, tap [E to store it.
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To Line L 23.390
Fill 5.199

Offset R 23.390
Elev -1.011
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Figure 9-22. Stakeout Line

5. Tapthe button to return to the first Stakeout Line screen.
Enter parameters for the next reference line.

Stakeout a Curve

1. To stake out points along a horizontal curve, tap
Stake » Curves (Figure 9-23 on page 9-18).

2. On the Curve screen (Figure 9-23 on page 9-18), specify the
reference curve by choosing the starting point (Point of
Curvature), the ending point (Point of Tangency) and the radius
parameter of the curve at the end point. The stakeout points
have the same height as the starting point. Also, specify
whether the curve turns right or left and whether to use a small
or large part of the circle. Enter the antenna parameters (GPS+
mode), or the height of the rod (TS mode). Tap the Stake
button.

P/N 7010-0493 9-17



Staking Out
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Figure 9-23. Curve

For GPS+: use the information on the Stakeout Curve screen to

find the target curve (Figure 9-24). Tap [E after the point is
close enough to the curve and at the desired distance from the

starting point.

il H v gg
@10%- 2201 3200 10+ 3

To Line R 8.677
Fill 2.224
Offset L 8.677
Ell ht 1.965

Pt: -0+00.957 =

Figure 9-24. Stakeout Curve

4. For TS: sight the prism. On the Stake Point screen, tap the gl
button to check the position (Figure 9-25). Once the position is
close enough to the curve and at the desired distance from the

starting point, tap [E to store it.
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Figure 9-25. Stakeout Curve

Stakeout Offsets

With offsets, you can stake Line, Intersection, Curve, 3 Pt Curves, or
Spiral.

Line & Offset

When the desired points lie at regular intervals on a line that is
parallel to a known line, and is at a known horizontal and vertical
distance from it, the Stakeout Line & Offset task should be
performed.

1. Tap Stake b Offsets » Line (Figure 9-26 on page 9-20).

2. Inthe Line&Ofst (Stakeout Line & Offset) screen, set the
direction of the line, the type of height computations for the
stakeout point (currently the stakeout point will have the same
height as the starting point of the line), the number of
subdivisions of the line (if an end point is specified) and the
starting station (chainage) of the line. Tap Next (Figure 9-26 on
page 9-20).
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Figure 9-26. Stakeout Line & Offset Parameters

3. Inthe Sta&Ofst (Station & Offsets) screen, set the station along
the line being staked, the station staking interval, the right or
left offset of the stakeout point with respect to the line, the Up
or Down Height offset, the height and the type of the antenna
height (GPS mode), or the height of the rod (target) (TS mode).

If the number of segments has been selected, the station

interval is automatically computed and cannot be changed
(Figure 9-27).

- -

Interval I1D.DDD b
MNum Segrments |1D

& [ might Offset_|[0.000 m
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Stake Report
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Figure 9-27. Station & Offsets
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4. For GPS+: use the information on the Stakeout screen for
finding the target. Tap @ after the position is close enough to

the desired point. Tap the / buttons to retreat/
advance the station by the specified Station Interval, for staking
out the previous/next station, respectively. Stations before the
beginning and past the end of the alignment can also be staked.

b
o,

il H v ghgt
@10%':"‘ed 2201 3200 10+3

B

Fwd 6.271

Fill 2.209

Left 3.575

HD to Dsgn 7.218

Figure 9-28. Stakeout GPS

5. For TS: sight the prism. On the Stake screen tap the %] button
to measure the target. Tap the EDM button to select distance
measurement mode, either Coarse, Fine or Coarse Tracking.

Once the position is close enough to the desired point, tap [E

to store it. Tap the =] / [ buttons to retreat/ advance the
station by the specified Station Interval, for staking out the
previous/next station, respectively (Figure 9-29 on page 9-22).
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Figure 9-29. Stakeout TS

% .

Tap in the current station string to enable the
floating information screen that displays the point
name, the note, design elevation (if enabled), the
station number, and the offset value of the current

Three Point Curve & Offsets

When the desired points lie at regular intervals on a curve that is
parallel to a curve with three known points, and is at a known
horizontal and vertical distance from it, the Stakeout Three Pt Curve

& Offsets task can be performed.

1. To stake out Three Pt Curve & Offsets, tap

Stake » Offsets » 3Pt Curve. The 3 Pt Curve screen displays.

2. On the 3 Pt Curve screen (Figure 9-30), enter or select from the
list or map the following sets of three known points, to create a

curve and tap Next:

* The starting PC Point (Point of Curvature) and ending PT Point
(Point of Tangency) on the circle, and a third point on the curve,

and the starting station (chainage) of the line.
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Figure 9-30. Three Point Curve

* The starting PC Point (Point of Curvature) and ending PT Point
(Point of Tangency) on the circle, and the center point (also called
a Radius Point). For this set of points, the distance between RP
Point and PC point should be equal to the distance between RP
Point and PT point. The radius and the PC and PT points define
two curves, one with delta less than or equal to 180 degrees
(Small curve), and the other with delta greater than or equal to
180 degrees (Large curve). Select either Small or Large from the
Curve drop-down box (Figure 9-31) to indicate which of these
two curves will be used for staking and the starting station
(chainage) of the line.
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Figure 9-31. Three Points Small Curve

3. In the Sta& Ofst screen, set the station along the curve being
staked, the station staking interval, the right or left offset of the
stakeout point with respect to the curve, the Up or Down Height
offset, the height and the type of the antenna height (GPS
mode), or the height of the rod (target) (TS mode).

ets
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Mum Segments llD—

& [ Right Offset_]0.000 w

& [ u oo m

Stake Report

Mot Set! (]

Figure 9-32. Station & Offsets

4. Tap the Stake button and perform the stakeout as described in
“Line & Offset” on page 9-19.
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Intersection & Offsets

When the design point is the intersection of two lines that are parallel
to two other lines and at known horizontal distances from these, the
Stakeout Intersection & Offsets task should be performed.

1.

To stake out Intersection & Offsets, tap Stake » Offsets »
Intersection. The Stakeout 2Line& Ofst screen displays
(Figure 9-33).

On the Stakeout 2Line&Ofst screen, define the starting point
and azimuth for the first known point; specify the horizontal
offset to the first parallel line. Tap Next (Figure 9-33).

/ . ZLine&0fst
—_—) ey i :
~ Line 1

Stake Offsets [€] From Pairt - ]
l & [ sztopt  [oRBs2 --
& [ Right Offset_[1.000

/
e

Intersection

Stake Report
Mot Set!

L.

Figure 9-33. Intersection & Offsets — Line 1

3. The second Stakeout 2Line&Ofst screen defines another line

(Line 2) using a point and an azimuth, and another definition of
the horizontal offset to the second parallel line (Figure 9-34 on
page 9-26). The height and name of the intersection point of
these two parallel lines (stakeout point) should be specified,
along with the height and type of the antenna (GPS+ mode), or
the height of the rod (target) (TS mode).
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Figure 9-34. Intersection & Offsets — Line 2
4. To start the stakeout, tap the Stake button.
5. For GPS+: use the information on the Stakeout screen for

finding the target. Tap [E after the target is close enough to
the design point (Figure 9-35).
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Figure 9-35. Stakeout

6. For TS: sight the prism. In the Stakeout screen, tap the [l
button to check the position. Once the position is close enough

to the design point, tap [E to store it (Figure 9-35).
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Figure 9-36. Stakeout.

7. Tap the button to return to the first Stakeout Line screen.
Enter parameters for the next reference line.

Curve & Offsets

When the desired points lie at regular intervals on a curve that is
parallel to a known curve, and is at a known horizontal and vertical
distance from it, the Stakeout Curve & Offset task should be
performed.

1. To stake Curve & Offsets, Stake » Offsets » Curve. The
Curv&Ofst screen displays.

2. On the Stakeout Curv&Ofst screen, set the parameters of the
known curve: the PC Point (Point of Curve), the starting point
of the curve, the azimuth of the tangent of the curve at the PC
point, the radius parameters of the curve, the length parameter
of the curve, the turn value of the curve, and the starting station
(chainage) of the line. Tap Next.
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Figure 9-37. Stakeout Curve & Offset

3. In the Stakeout Sta& Ofst screen (Figure 9-38 on page 9-28),
set the station along the curve being staked, the station staking
interval, the left or right offset of the stakeout point with respect
to the curve, the Up/Down Height offset, the height and the
type of the antenna height (GPS mode), or the height of the rod
(target) (T'S mode).
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Figure 9-38. Station & Offsets

4. Tap the Stake button and perform the stakeout as described in
“Line & Offset” on page 9-19.
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Spiral & Offsets

When the desired points lie at regular intervals on a curve that is
parallel to a known curve, and is at a known horizontal and vertical
distance from it, the Stakeout Curve & Offset task should be
performed.

1. To stake Spiral & Offset, tap Stake » Offsets » Spiral. The
Stakeout

2. In the Stakeout Spiral&Ofst screen, set the parameters of the
spiral to be staked out: the starting point of the spiral, the
azimuth of the Tangent of the curve at the PC point, the radius
parameter of the spiral, the length parameter of the spiral, the
direction of turn, direction of movement of the spiral and the
starting station (chainage) of the line (Figure 9-39). The
direction values are: TS -> SC (Tangent Spiral -> Spiral
Circle), which is the incoming spiral to the internal circle, and
CS -> ST (Circle Spiral -> Spiral Tangent), which is the exiting
spiral from the circle to the Tangent. Tap Next.

J d [ 75 Font IDRAN -
Stake Offsets
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Figure 9-39. Stakeout Spiral & Offset

3. In the Stakeout Sta& Ofst screen (Figure 9-40), set the station
along the spiral being staked, the station staking interval, the
left or right offset of the stakeout point with respect to the
spiral, Up or Down Height offset, the height and the type of the
antenna height (GPS mode), or the height of the rod (TS mode).
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Figure 9-40. Station and Offset

4. Tap the Stake button and perform the stakeout as described in
“Line & Offset” on page 9-19).

Stakeout Roads

1. To stake out points on a road, and on either sides of it, tap
Stake » Road. On the Roads screen select the road for stakeout

and tap the ok [/ ] button. The Stk Road screen displays.

Stake Road

ss  [o+00.000 m

‘.}Lﬂum\/ Hozom
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Stake Report
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Figure 9-41. Stakeout Road
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2. On the Stk Road screen (Figure 9-41), set the road, horizontal,
or horizontal and vertical alignments to be staked out and the
starting station, the height and the type of the antenna height
(GPS mode), or the height of the rod (target) (TS mode). If
staking the transition points (points where horizontal elements
of the road change and included in spite of the station distance),
check the appropriate field (Figure 9-41). Tap Next.

3. In the next Stakeout Road screen (Figure 9-42 on page 9-32),
set the properties of the cross-section on the stakeout station:

* The station where the stakeout is performed.
* The interval of the station increment.

* The hinge (end) point of the current segment. To move the
current segment point along the cross-section, use the arrow
icons next to this field. The result displays on the
scheme at the bottom of the screen.

* The horizontal offset from the current segment point, the
vertical offset from the current segment point.

* Select the reference line for offsets by selecting the type of
template offsets:

— Centerline: both the horizontal and vertical offset starts at the
centerline.

— Intersect Left: the vertical offset starts at the segment point;
the horizontal offset starts at the point of intersection of the
line parallel to the left segment with the cross-section.

— Intersect Right: the vertical offset starts at the segment point;
the horizontal offset starts at the point of intersection of the
line parallel to the right segment with the cross-section.

— Segment: the horizontal offset starts at the beginning of the
segment; the vertical offset starts at the centerline.

— Surface Left: the horizontal left offset starts at the beginning
of the segment; the vertical offset starts at the point on the
surface of the segment that corresponds with the horizontal
offset.
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— Surface Right: the horizontal right offset starts at the
beginning of the segment; the vertical offset starts at the point
on the surface of the segment that corresponds with the
horizontal offset.

When Intersect Left or Right is selected, use the /

buttons to toggle between the vertical offset and offset
perpendicular to the current segment.

I. Stalnterval  [100.00m

Segment Pt l—. .
i [ Right Offset |[2.000 m
& [ unoteet Jam m

*——5m _\_/

Figure 9-42. Stakeout Road (second screen)

4. Tap Stake, then the Stake screen opens.

To perform road stakeout in real time, select the Real Time
Stakeout option from the pop-up menu in the top left corner of
screen.

If the stake report is set for the current stakeout routine, the Set
References option from the pop-up menu in the top left corner of
screen allows selecting references, surfaces or segment points, for
additional reporting options. For details on the Set References
option, see page 9-35.

Use the [nitial Point Name to set the name of the first point and a
value for increment/decrement of names of points calculated for
the stakeout task (see Figure 9-51 on page 9-38).
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Stakeout Slope

1. To stake out the slope of a road, tap Stake » Slope. The Stk
Slope screen displays.

2. On the Stk Slope screen, select a road/ horizontal / horizontal
and vertical alignments, the starting point of the stakeout, the
height and the type of the antenna height (GPS mode) or the
height of the rod (target) (TS mode). Tap Next.
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Figure 9-43. Stakeout Slope

3. On the next Stk Slope screen (Figure 9-44), set:
¢ The interval of the station increment.

* The hinge point (point of rotation for the Cut/Fill Slope lines) and
the values of the Cut/Fill Slope parameters, and the offset from
the catch point (the point where the slope crosses the surface of
the terrain). Use the arrows in this field to move the hinge point
along the cross section. This is reflected on the scheme in the
bottom of this screen.

* The horizontal and vertical offsets from the current hinge point.

* When Intersect Left or Right is selected, use the /

buttons to toggle between the vertical offset and offset
perpendicular to the current segment.

* Select the type of template offsets:
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— Auto: automatically set the last template point (without
offsets).

— Intersect Left: the vertical offset starts at the hinge point; the
horizontal offset starts at the point of intersection of the line
parallel to the left segment with the cross-section.

— Intersect Right: the vertical offset starts at the hinge point; the
horizontal offset starts at the point of intersection of the line
parallel to the right segment with the cross-section.

— Segment: the horizontal offset starts at the beginning of the
segment; the vertical offset starts at the centerline.

— Surface Left: the horizontal left offset starts at the beginning
of the segment; the vertical offset starts at the point on the
surface of the segment that corresponds with the horizontal
offset.

— Surface Right: the horizontal right offset starts at the
beginning of the segment; the vertical offset starts at the point
on the surface of the segment that corresponds with the
horizontal offset.

3
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- (" up Okt J/BEE

T——5m

N/ :_/‘9

Figure 9-44. Stakeout Slope

ID+DD.DDD

* Tap Next.
4. The next Stk Slope screen allows editing cut/fill slope to stake.
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Stakeout Slope

() Template Slopes

Left Right
Cut 0.000 0.000
Fill -5.000 -5.000

() Enter Slopes

Cut 0.000
Fil 0.000

Figure 9-45. Set Cut/Fill Slope

5. Tap Stakeout to stakeout the catch point (the point where the
slope crosses the surface of the terrain)

* To perform slope stakeout in real time, select the Real Time
Stakeout option from the pop-up menu in the top left corner of
screen.

* The Set References option from the pop-up menu in the top left
corner of screen allows selecting references, surfaces or segment
points, for additional reporting options.

Figure 9-46. Set References
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Tap desired surfaces or points to highlight them in green, then
click the ok [ 7] button to save the selections and to return to the
Stake screen.

(4] H v &g
@130%- 0,201 0400 10+ 3

[EN

BK 7.550

Cut 30.299

To CL R 60.598
HP Elev 153.000

[t 2o |[w[+] [E]

Figure 9-47. GPS Stakeout

Tap the [E button on the Stake screen to save positions as
points. The Data tab on the Store Point dialog before saving.

P | % ]

StakelCodelNote Data | Design

Marne | Wallie | e

Diesign Slope 1.2

Diesign Off, R 7.937

Extend Grade

P-CL 0.0%

CL Elevation 157.000

P Elevation 157.000

P-CL Cut 0,903

R Offs to CL 1.651

SDto CL 1.927

HD ta P-iCL L 6,349

P-CL P Cut 0,903 v
Advance Stk Offset P

_]cp Offset Wm

Figure 9-48. Store Staked Point for Slope
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You can tap the Set Ref button to view/edit the references on the
Set Reference map. The green color of the Set Ref button means
that the references are already defined.

Check mark the Stk Offset Pt box to enable setting an offset to the
catch point in the field below. This option is appropriate only to
slope stakeout.

Clicking the ok [ 7] button on the Store Point screen saves the
point and reporting data to the stake report, if available.

* The View Report option from the pop-up menu in the top left
corner of screen displays the full current report (also the [ ...}
button on the initial Stk Slope screen allows viewing reports).

3 &
Design Reference | O, | B, Design Pt]
L 1

L 2
Reference Point cL
Extend Grade CL-<2=
L 3
Reference Point cL
Extend Grade CL-<2=
L 4
Reference Point cL
Extend Grade CL-<2=
il [ [ [ ] ° |
Reference Point 2
Extend Grade 2-2CL=
< >

Refs

Figure 9-49. Report View

The Refs button displays the References data for the highlighted
design point.

The Refs button appears only if there are set
references, and is active only for design points with
references.
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\,‘—-‘q

Point | Point Elv | Cut/Fil | Offset to
132,135

L 130,135 C15.. L 78.4

< >

Figure 9-50. References

 Use the Initial Point Name to set the name of the first point and a
value for increment/decrement of names of points calculated for
the stakeout task.

3 it Pt tiame

Initial Design Point

First Paint

Code

Paint Inc/Dec Size |1—

Figure 9-51. Initial Point Name
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Stakeout Real Time Road

1. To stake out points on a road, and on either sides of it, tap
Stake » Real Time Road.

2. On the Stk Road screen (Figure 9-53), set the road to be staked
out and the starting station, the height and the type of the
antenna (GPS mode), or the height of the rod (TS mode). If
staking the transition points (points where horizontal elements
of the road change), check the appropriate field. Tap Next.

o
Stake Real Tirme Rd

= ss [ovonomo m

‘.}Lﬂum\/ Hozom
N HT

Ant Ht 2.000 m

Wertical

Stake Report
F2 C] Mext ==

Figure 9-52. Stakeout Road
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3. The Stk Road screen displays the cross-section segment at the
rod position, tap Next.

Stalnterval  [100.00 m

T\

Figure 9-53. Stakeout Road

* Another Stk Road screen shows cut/fill for template slopes, and
allows editing cut/fill slope to stake.

() Template Slopes

Left Right
Cut 0.000 0.000
Fill -5.000 -5.000

() Enter Slopes

cut 1,000
Fill 2,000

Figure 9-54. Stakeout Road — Cut/Fill

4. Tap Stakeout. The Srake screen reports the cut/fill values
computed for the current observed point. The design elevation
of the road is automatically calculated for the observed point,
using the alignment and templates.
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5. For GPS+: tap [E after the position is close enough to the
desired point.

| H v
B 1 U%- 2201 2.200

_Eur

SD to CP R 1.771
Cut 0.885

To CLR 1.771
Offs CP R 1.771

Pt: 1+56.530

Figure 9-55. Stakeout

]

6. For TS: sight the prism. In the Stake screen, tap the | button
to measure the target. Once the position is close enough to the

desired point, tap [E to store it.

Cut SPa 0.954

Cut 5Pb 0.954
Offs SPa L 0.899
Offs SPb R 6.101

[rersrm || [l

Figure 9-56. Stakeout

* The Set References option from the pop-up menu in the top left
corner of the Stake screen allows selecting references, surfaces or
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segment points, for additional reporting options. For details on
the Set References option, see page 9-35.

* Use the Initial Point Name to set the name of the first point and a
value for increment/decrement of names of points calculated for
the stakeout task (see Figure 9-51 on page 9-38).

Stakeout DTM

1. To stake out points inside of a digital terrain model, tap
Stake » DTM.

2. Onthe DTM Stk screen (Figure 9-57):

* Tap the button to select a TN3 file containing the desired
DTM.

& -

Stake DTM

antHt [omon mo [vertical v

[Jcreate TIN |CutIFiII
Stake Report
Mot Set! (]

[Juse alignment

Figure 9-57. Select DTM

* Set the height and the type of the antenna height (GPS mode), or
the height of the rod (target) (TS mode).

* Check and enable the Use Alignment box to use station and offset
information while staking the DTM, check and enable the Create
TIN box to generate a new TIN (TN3) Cut/Sheet model of the
points staked.

9-42 TopSURYV User’s Manual



Stakeout DTM

 Tap Stake. When opening the DTM file selected, TopSURV
displays a warning about the minimum and maximum values of
coordinates in the area covered by the DTM. A stakeout point
must be located on the inside of the DTM. If a stakeout point is
located on the outside of the DTM for the job, TopSURV neither
calculates nor writes the coordinates of this point. Tap Close to
open the Stake screen.

3. For GPS+: use the information on the Stake screen for finding

the target. Tap [E after the position is close enough to the
desired point (Figure 9-58 on page 9-43).

(€t emg H v &8 [
@10%':"‘ed 2201 3200 10+3 EJ
n

&)
PR

—=50m
North 6178545.517

Fill
East 415430.114
Ell ht 147.788

]

der

Figure 9-58. GPS Stakeout

4. For TS: sight the prism. On the Stakeout screen, tap the gl
button to measure the target. Use the EDM button to select
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distance measurement mode. Once the position is close enough

to the desired one, tap [E to store it.

EDM ||

@ f 3= HR [0.000
M

—=50m

MNorth 10.565
Cut

East 10.590
Elev -0.011

der .“‘:;. H

Figure 9-59. TS Stakeout

EEREaN

Stakeout Linework

1. To stake out points with code strings, tap Stake » Linework.
_ Rl

o
rk
& 1 [ ox >
Stake Linework
Strings ‘H‘uSm

1
2

S5 ID+DD.DDD m

Ant HE ID'DDD m
IVerticaI v

Include Transition Point

| & [N

Stake Report

Mot Set! [ ]| mext»=

Figure 9-60. Linework

2. On the Linework screen, select Code or Linework to use one
of two linework selections:
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* Code allows linework selection by CodeString (Figure 9-60).

riEwork

g gl [

Linework
(3] Strings ‘.‘uS m

1
2

S5 ID+DD.DDD m

Ant HE ID'DDD m
IVerticaI v

Include Transition Point

Stake Report
Mot Set! [ ]| mext»=

Figure 9-61. Linework Selected by Code

* Linework allows linework selection from the job lineworks
(listed in the dialog) or a polyline selected from the Map.

e

[B] [Cst of Linew.. | ‘.‘.:. 10

corara] Bl
ooy

s ra[ B2

S5 ID+DD.DDD m

Ant HE ID'DDD m
IVerticaI v

Include Transition Point

Stake Report

Figure 9-62. Linework Selection

If the line is a background line, copy the line to the job, update the
list of lineworks and select it in the list.
Specify the antenna parameters: the height value and type, or
the height of the rod, based on whether in GPS+ mode or TS

mode. Tap Next.
4. On the Station & Offsets screen, set offsets for stakeout.
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* Select stakeout mode: in real time or by station interval.

* Set offsets of the stkeout point with respect to the line at the
station.

* Select the stake location when stakeout to an angle point:

— Offset Bk: the stake location will be on the (back) segment
before the angle point.

— Offset Ahd: the stake location will be on the (ahead) segment
after the angle point.

— Bisector: when bisector is selected, the proposed stake
location will be on the bisectrix of the angle at the computed
offset from the angle point.

* Select the stake location when stakeout to a curve point:

— Offset: the stake location will be on the curve at the offset
distance from the curve point.

— RP: the radius point.

— PI: the point of intersection of tangents to the curve drawn at
the start and end curve points.

— MOC: the point in the middle of the curve.

» Tap Stake to start stakeout process.

Statio ets |
Interval I]_D.DDD m
MNum Segrments IlD
& [ might Offset_|[0.900 m
iy Up [o:10m m
Angle Points IOf‘fset El
Curve Points IOf‘fset v

Figure 9-63. Station Stakeout
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Level Stakeout

The Level Stakeout process involves finding elevations of points close
to a desired elevation.

Digital Level Stakeout of design points, and elevations can be
accessed from the main menu for a Level survey type or from the top
left menu in the Level Run screen.

DL Staking a Point

1. To stake out elevations of design points, tap Stake » Points.
The Stake screen displays.

2. On the Stake screen (Figure 9-64 on page 9-47), enter or select
from the map or list the backsight point for the stake
measurement and a design point to stake.

3. Tap the BS button to take the BS measurement before staking if
it is not already measured. Tap the Stakeout button.

T-E

Stake Paints

Stakeout

Figure 9-64. DL Stake Point

4. On the level Stakeout screen, tap the Meas button to measure
the elevation and compute a cut/fill value. Tap Store to set a
code for the point, the name, and a photo note; set the layer
name and plotting parameters, to view the point information
and save the staked point (Figure 9-65).
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Staked points are not added to the Level Run; they are
independent. Staked out points are listed as observed points on
the Points screen.

oLt

DRES13

DRES3

*

>,
HI 1.623
Elev 0,173
Fill 4,006

Figure 9-65. DL Stakeout

DL Staking Point List

1. To stake out elevations at design points in a point list, tap
Stake » Point List. The Stake Point List screen displays
(Figure 9-66).

2. On the Stake Point List screen, select a pre-existing points list,
enter either manually or select from the map or the list the
backsight point for the stake measurement.
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—— ~
! :
1 9 L | I
J > | BSPant  |DRESL3
Stake Paint List — _
A
Paint List PointListl
a @

[8]orEs1e

DRES16

E] [Jreverse Order E]

Figure 9-66. DL Stake Point List

To perform a stakeout starting from the end of the Point List,
check and enable the Stakeout in Reverse Order box. Use the
arrow buttons to modify the order of stakeout. Tap the BS button
to take the BS measurement before staking if it is not already
measured. Then tap Stakeout.

DL Staking Elevation

1. To stake out elevations, tap Stake » Elevation. The Stakeout
Eley screen displays (Figure 9-67 on page 9-50).

2. On the Stakeout Elev screen, enter or select from the map or
list, the backsight point for the stake measurement and enter an
elevation value to stake at points.
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Tap the BS button to take the BS measurement before staking if
it is not already measured. Then tap Stakeout.

, | [~RE -
J Hovat BS Paint [prEs13
K levation —_— =
Stake
Elevation |2.2 m

Stakeout

Figure 9-67. DL Stakeout Elevation

3. On the level Stakeout screen (Figure 9-68) tap the Meas button
to measure the elevation and compute a cut/fill value. Tap Store
to set a code for the point, the name, a photo note and the layer
name and plotting parameters. You can also view the elevation
information and save the staked point.

aut
DRES13

DRES3

*

>,
HI 1.623
Elev 0,173
Fill 4,006

Figure 9-68. Level Stakeout
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Chapter 10

COGO

The COGO functionality in TopSURYV is a comprehensive set of
COGO tools to calculate the coordinate geometry to solve the
geometry problems encountered in professional surveying and civil
engineering applications. For example, use COGO tools, including
Inverse, Intersection, Traverse, Curve Solutions to design the precise
points of boundaries, buildings, or other elements included in a
project. A built-in calculator will help to edit input values in the entry
fields of all dialog boxes.

Tap the COGO ’7, icon to access the COGO menu.

screen displays graphically the task being
performed. Tap this bitmap to open the greater map.
Tap the screen area to hide it.

; The icon in the upper-left corner of every COGO
~,

Inverse

Three inverse tasks available in the Inverse menu are based on
computing the azimuth and distance between two points, given their
coordinates.

Two-Point Inverse

The Point-to-Point Inverse task computes the inverse (azimuth and
distance) between two known points.

1. Select the points for the task from map or from the list
(Figure 10-1 on page 10-2).
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2. Tap the Calc button. The result of the calculation will be
displayed on the Results tab. The Map tab shows the results
graphically.

wo-Point Inverse

a r
., D Inwerse | Results | Map
Pt To Pt

From Point

ToPaint  |DREN

Figure 10-1. Two-Point Inverse

Inverse Point to Points List

The Inverse Pt to Pt List task calculates the inverse for all the points
in the Points list with respect to a known point.

1. On the Inverse Pt to Pt List screen (Figure 10-2), select a point
and a point list (Figure 10-2).

~verse Pt to Pt Lis = |
A E_In-.-ur..u Pt to Pt List [« ]
3 - i
L_Je . Irwerse Pt to Pt List -
Pt To List I‘ Results | Map

[

Paint RESH]
Paint List IPointList4

List of Paoint | |"®=10m

# DRAN1
#DRENL |,
ay )

Figure 10-2. Inverse Point to Point List
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Inverse

2. Tap the Calc button. The result of the calculation will display
on the Results tab. The Map tab shows the results graphically.

Inverse Point to Line

The Inverse Point to Line task calculates the horizontal offset of a
point with respect to a known line. The station along the line, where
the perpendicular passes though the point, and the height at this
station are also computed.
1. On Inverse Point to Line screen (Figure 10-3), select the point
name, and set the line by its start point, azimuth, and starting
station (Figure 10-3).

Elrr-.-'er-:.e Point to Line 4

i [ ] Irverse Pt to Line

Inverse Pt To Line
[®] Foint

StatpPant [oResz
& [ aztopt |[DREN
4

Start Sta ID+D.DD
[ stare PTL Paint Calc

Figure 10-3. Inverse Point to Line.

2. Tap the Calc button. The result of the calculation will display
on the Results tab. The Map tab shows the results graphically.
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Point in Direction

The Point in Direction task calculates the coordinates of a point,
using a known point, and angle and distance offsets from it.

1. On the Point in Direction screen (Figure 10-4) enter the From
point name (known point), the azimuth set by value or as the
direction to another known point.

Set the angle offset from the azimuth line, the distance offset
along the angle offset line and the height offset. Also select a
name and a code for the resulting point (in the direction
specified by azimuth and angle offset).

:i @ E.F'Eliﬂt in Direction
¥ ’ Paint Direction | Resyits | Map
Pt in Direction

From Point
& [ azmuth |[1z5°0000.07

Angle [z70000”
soon m
vertDst  [oson m

COGO Point IlDDDD
|E| Code [ v

E i Calc

Figure 10-4. Point in Direction

entry fields to add/subtract angle and linear values,
directly or use the Calculator. Start the calculator
from this field by pressing the F1 button on the
controller keyboard, or by tapping the Calculator
button on the pop-up keyboard for controllers with
soft input panels.

; To edit angles, azimuths, and distances etc., use the

2. Tap the Calc button. The result of the calculation will display
on the Results tab. The Save button in the Results page should
be tapped to save the checked point. The Map tab shows the
results graphically.
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Intersection

The Intersection task computes the intersection point or points when
given two known points and either the direction or distance from the
known points.

1. On the Intersection screen (Figure 10-5), select the points for
the task from map or from the list.

/ E Intersection dn
.j\ Intersection
Intersection L
Paint 1 JRES
& [ Distance |[50.000 -

Point2  [DRBNT
[ Distance][50.000 m

oGO Pt1 [10001
L1

1

v
coGo Ptz [10002 |2
[o] [« b Calc

Figure 10-5. Intersection

2. By tapping the Distance/Azimuth/Az to Pt button in the
corresponding fields, select the parameter for to use and input
its value.

3. Enter the name and code of the first resulting intersection point.

Tap the Calc button. The result of the calculation will display
on the Results tab. The Save button in the Results page should
be tapped to save the checked points. The Map tab shows the
results graphically.

5. [If Distance is specified for any known point in the Intersection
tab, there will be two solutions for the Intersection calculation
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Calculator

A built-in calculator in TopSURYV performs calculations and
conversions. To access the calculator, tap the Calculator icon
(Figure 10-6).

Calculator

L
]

Figure 10-6. Calculator

TopSURY, either press the F1 button on the
controller keyboard to start the calculator from this

field or tap the Calculator g icon on the pop-up
keyboard for controllers with soft input panels.

; To enter a calculated value to any entry field in

1. Enter the entire equation in the Input field, then press the
equals [=] button to calculate the result.

2. The Result field shows calculation results. This field is also
used as the ‘y’ or ‘theta’ values for rectangular / polar
conversions.

3. Once equals is pressed, the previous result is moved up to the
Previous Result field. This field is also used as the ‘x’ or ‘1’
values for rectangular/polar conversions.

4. To perform calculations, use the following buttons:

* MC — tap to clear the memory.
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* MR - tap to recall the memory value, indicated by M in the
Input field.

* MS — tap to save the already computed result into memory.

* M+ — tap to add the already computed result to the value in
memory.

* C —tap to clear all fields.
* backspace (<-) — to remove the last entry.

* copy - tap to close the calculator, in case it was started from
the COGO menu or to copy calculation results to that field if
the calculator was started from a field in TopSURV.

* sci — tap to display/use the scientific calculator (Figure 10-7).

Figure 10-7. Scientific Calculator

Curve Solutions

A curve is a part of a circle and thus can be described through the
center point (also called a Radius Point), the radius value and the

starting and ending points on the circle, also called a PC (Point of
Curvature) and a PT (Point of Tangency).

Using these values can help you find other curve parameters. For
detailed explanations on the different curve parameters, refer to the
TopSURYV Reference Manual.
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Curve

The Curve COGO task calculates the full set of parameters for any
curve, given one each, of the length and curvature parameters.

1. On the Curve Solution screen, select the curvature parameters
of the curve (Radius, Deg Chord, or Deg Curve) and the length
parameter of the curve (Length, Chord, Tangent, Mid Ord,
External or Delta), and the turn direction (Figure 10-8).

Curves

5 E Curva Solution b
I:l Curve Solution
Curye

Radius [pooo m
Length Im m

T——=5m
N

Turn |Right

[ Cale

Figure 10-8. Curve Solution.

2. Tap the Calc button. The result of the calculation will display
on the Results tab.

The Map tab shows the results graphically.

Pl & Tangents

The PI & Tangents task computes the PC point, the PT point, and the
center (Radius Point) of a curve, given the Point of Intersection (PI),

the radius, and the azimuths from the PI point to the PC and PT points
respectively. On the PI & Tangents screen, do the following

(Figure 10-9 on page 10-9):

1. Select the initial data for the task and the names and codes for
the result points (Figure 10-9).
2. Tap the Calc button. The result of the calculation will display
on the Results tab.
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Figure 10-9. Pl & Tangents
3. Tap the Save button in the Results page to save the checked
points.
The Map tab shows the results graphically.

Three Pt Curve

The Three Pt Curve task defines the curve using three points: the PC
and PT points, and either the RP point, or any point on the curve. If
the curve point is defined, then the RP Point will be computed, and
can be saved.

1. On the Three Pt Curve screen, select the initial data for the
task. The screen changes its appearance, depending upon the
first point chosen
(Figure 10-10 on page 10-10).

Select the name and code for the RP point, if applicable.

3. Tap the Calc button. The result of the calculation will display

on the Results tab.

4. Tap the Save button in the Results page to save the checked
point. The Map tab shows the results graphically.
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E Three Pt Curve dn

— o
3Pt Curve

Curves

& [_repnt | [10001
PC Prit [pran
PT Prit [orEs=
Curve W

Figure 10-10. Three Pt Curve

Radius & Points

The Radius & Points task defines a curve using the PC and PT points
and a radius parameter, and computes the RP point coordinates.

1. Onthe Radius and Points screen (Figure 10-11 on page 10-11),
select the initial data for the task: the curve points, the radius
parameter, the direction of turn and whether the smaller (less
than 180 degrees) or the larger curve (more than 180 degrees)
between the curve points is to be considered. Also, enter the
resulting RP point name and code.

2. Tap the Calc button. The result of the calculation will display
on the Results tab.

3. Tap the Save button in the Results tab to save the checked point.

The Map tab shows the results graphically.
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Area

Radlius & Pts

E Radius & Points

Radius Point | Results | Map

PC Foint
L4
PTPant  [oRAN
4
& [ padus  |f40.000 m
Turm IRith v
Curve lm
RPPoint [Jioonz
Ol —

Bl ¥ cc |

Figure 10-11. Radius & Points

Area

The Area task calculates the area of a polygon formed by any points
(By Points task), or the coordinates of a point (Hinge task)/points
(Line task) that, after being added to Point List/Linework/Area, form

a polygon of the desired area.

By Points

The By Points task calculates the area of a polygon.

1. Onthe Comp Area screen (Figure 10-12 on page 10-12), select
a PointList/or Linework/or Area that contains the points
constituting the vertices of the polygon. Use the arrow buttons

to change the order of the points (and thus the shape of the
polygon).

2. Tap the Calc button. The result of the calculation will display
on the Results tab.

The Map tab shows the results graphically.
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A I | .I__I_II'I 0 Area
trea IE‘ Area | Results | Map

PointList ¥ |[PointList4
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Linework
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Figure 10-12. By Points

On the Known Area — Hinge screen (Figure 10-13), the Hinge
method calculates the coordinates of a point that meets the following
conditions:

* The point is located on a known azimuth taken from the first point
of Point List.
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* When the point is added to the Point List between the first and the
last points, a polygon of known area is formed.

IE Area |Results | Map
PointList |P0intList4

Area Hirge

]

(#)[ st of Paints | Mr=10m
 DRANT

# DRASL

# DRENL

# DRC3

E] < »

Figure 10-13. Known Area - Hinge — Area Tab 1

1. Select the a PointList/or Linework/or Area, use the arrow
buttons to change the order, as desired and tap the Next button
(Figure 10-13 on page 10-13).

2. In the second screen under Area tab, select the known rotation
point from the list, the direction of rotation, the known

requested area, and the name and code of the resulting point
(Figure 10-14).

E Enown Area - Hinge
Iil Area | Results | Map

Total Area lm
Regd. Area lm@'
Rotation Pt lm
Dirsction CounterCloc s

[®] Pt [10002
Code II [
Il b

Figure 10-14. Known Area - Hinge — Area Tab 2
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3. Tap the Calc button. The result of the calculation will display
on the Results tab.

4. Tap the Save button on the Results tab to save the checked
point.

The Map tab shows the results graphically.

entry fields to add/subtract angle and linear values,
directly or use the Calculator. Either press the F1
button on the controller keyboard to start the
calculator from this field or tap the Calculator icon
on the pop-up keyboard for controllers with soft
panels.

; To edit angles, azimuths, and distances etc., use the
~,

Line

On the Known Area — Line screen (Figure 10-15), the Line method
computes the coordinates of two points that satisfy the following
conditions:

* The points are located on known azimuths, taken from the two
known points.

* The azimuth of the line formed by the points is known.
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* Along with two other known points, the points form a
quadrilateral of the known area.

Az E Known Area - Line
_’ 5

area Line Area |Results | Map

PointList |P0intList4

(#)[ st of Paints | Mr=10m
N
 DRANT
# DRas1
 DRENT
# DRC3
M

Figure 10-15. Known Area - Line — Area Tab 1

The Area tab (Figure 10-15) contains the initial data of the Line task.
See “Hinge” on page 10-12 for description of this screen.

1. Tap Next to open the second screen of the Area tab (see
Figure 10-16 on page 10-16)

2. On the second Known Area Line screen, select the initial data
for the task: the start and the end points, the azimuths from the

points, the reference azimuth and the known area value, and the
names and codes of the resulting points.

3. Tap the Calc button. The result of the calculation will display
on the Results tab. The Save button in the Results page should

be tapped to save the checked points. The Map tab shows the
results graphically.
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Area |Results | Map

Total Area |1661.98583
Reqd. &rea Im & sqm

Edge Pt1 DRANL v

Edge Pt2 DRASL v

[®] Pt [10002
lz‘ IA w |2 w

[®] Ptz [10003
@ IA w 2 ™
I << Back " Calc ]

Figure 10-16. Known Area - Line — Area Tab 2

Corner Angle

The Corner Angle task calculates the angle formed by the directions
of two points from a middle point (Figure 10-17).

Corner Angle

E Corner Angle

&ngle | Results | Map

Start Point Iﬁ|

Mid Paint |DRAN—
End Paint IDREIS—

Figure 10-17. Corner Angle

1. Define the angle sides by selecting the start, middle and end
points.

2. Tap Calc to compute the angle. The result of the calculation
will display on the Results tab, and the Map tab graphically.
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Offsets

The Offsets task calculates the coordinates of points along a line
(Line Offset task), or along a curve (Curve Offset task), or along a
road (Road Offset task).

Line Offset

The Line Offset task calculates the coordinates of points along a line.
The line can be divided either by the number of subdivisions or by the
interval starting from the station specified.

1. Define the line by selecting the start and end point/azimuth of
the line. Select whether to assign the height of the starting point
to all the calculated points, or whether to compute the height
values using through linear height interpolation along the line.
If needed, select the starting station (chainage) and the number
of subdivisions to divide the line. Check Include Transition
Point if the transition point should be included. Tap Next.

K > Pl Line Offset | &
. Start pt  [BEE
Line Offset — =

P o 153

Ht Comp |Interp0late Ht -

[ ]Mum Subs [o

[Jinclude Transition Point

Length
Wasm 85,174

55 m
[o+00.000

MNext ==

Figure 10-18. Line & Offset

2. On the Sta& Ofst screen (Figure 10-19), if needed, set the
starting station, station interval, offsets with respect to the line
at the station, the height offsets or the vertical grade (in
percentage) with respect to the height of the line at the station
and the starting name for the points calculated. Tap Calc.
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Interval W g
& [ Right Offset_]f2.000 L
o Jmm o
[@] cocoPant  [momz
|E| Code I— E

Figure 10-19. Station & Offsets

Curve Offset

On the Curv & Offset screen, the Curve Offsets task calculates the
coordinates of points along a curve. The curve can be divided either
by the number of subdivisions or by the starting interval from the
station specified.

7 = ]
“e PC Point [DRAN

Curve Offset
PT Paint [DREN

- = -
[JMumsubs |0

[Jinclude Transition Point

Turn [Right -

Masm
N

Interpol:

I s m
ID+DD ooo

Length:
108,931 m

MNext ==

Figure 10-20. Curve & Offset

1. Define the curve by selecting the starting PC point of the arc,
the radius parameters of the curve, the point of tangency and
the direction of turn, relative to the PC Point.
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If needed, select the starting station (chainage) and the number
of subdivisions to divide the curve (Figure 10-20). Tap Next.

On the Sta& Ofst screen (Figure 10-19 on page 10-18), if
needed, set the starting station, station interval, offsets with
respect to the curve at the station, height offsets or a vertical
grade (in percentage) with respect to the height of the curve at
the station, and the starting name for the points calculated. Tap
Calc to compute and save the calculated points.

Road Offset

On the Road Offset screen (Figure 10-21), the Road Offset task
calculates the coordinates of points along a road. The road can be
divided by the interval starting from the station specified.

Select the road/ horizontal / horizontal and vertical alignments
to calculate the offset points. If needed, select the starting
station (chainage). Tap Next.

@ E Road Offset 4
— |el=)®m (B
Road Offset
55 ID+DD.DDD m

Hozom
HT

x m
rfm\/

MNext ==

Figure 10-21. Road Offset

2. On the Sta&Ofst screen (Figure 10-19 on page 10-18), if

needed, set the starting station, station interval, offsets with
respect to the road at the station, height offsets or a vertical
grade (in percentage) with respect to the height of the road at
the station, and the starting name for the points calculated. Tap
Calc to compute and save the calculated points.
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Adjust Points

The Adjust function performs transformation of points and includes
four tasks: Rotate, Translate, Scale, 2D Transform and Traverse

Adjustment.

Rotate

The Rotate task rotates the selected points around one specific point.

1. On the Rotate screen, do the following:

* Select the points for the task. In the Select Points field, tap the By
Range button and enter (set) the range of the point names, or
select points for the scaling task on the map or from the list

(Figure 10-22).

Adjust

©

Rotate

Select Paints

(o] () (B) 2

3 points selected

Rotation Paint 100

Rotation Method Sot. AngleiYs

Rotation Angle |45 °00'o0"

Figure 10-22. Rotate

Enter the Rotation Point (the point at the center of rotation).

3. Specify whether the rotation angle will be input directly to the
Rotation Angle field, or as a difference between the new and old
azimuths (to the Old Bearing/Azimuth and New Bearing/
Azimuth fields).

4. Tap the Calc button to rotate the selected points.

10-20
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Translate

The Translate task moves a group of points together. On the
Translate screen (Figure 10-23), do the following:

1. Select the points for the task. In the Select Points field tap the
By Range button and set the range of points names, or select
points for scaling task on the map or from the list.

@ Select Paoints

st Trarslate =

3 points selected

Translate By IAz,Dist,Ht -
Azirnuth |45 °00'00.0

Hz Dist IEDD.DDD m

Wert Dist [t.000] m

Figure 10-23. Translate

2. Set the method of translation using the Translate By field, to
either Coords/Pts or Az, Dist,Ht.

When the Coords/Pts method is selected, it means that all the
selected points will be moved in the same direction and
distance as between the points (locations), set by the next two
fields: From Pt (From Crd) and To Pt (To Crd). In the first
case, define only the point name. In the second case, the local
coordinates and the height of the location is needed.

In the Az, Dist,Ht method, all the selected points move in a
specified direction by a specified distance. These parameters
are set through the Bearing (Azimuth), Horiz Dist, and Vert
Dist fields.

Tap the Calc button to achieve the result.
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@ The limit for translation of points is 20,000 meters.

Scale

The Scale task scales the distances of a range of points relative to a
Base Point. On the Scale screen (Figure 10-24), do the following:

1. Select the points for the task. In the Select Points field, tap the
By Range button and set the range of the points names, or
select points for the scaling task on the map or from the list

(Figure 10-24).

-\

Adjust Scale

Select Paints

&) =

3 points selected

Ease Point:

Scale Factor

—

100

Figure 10-24. Scale

Enter the Base Point name.
3. Enter the Scale Factor.

Check and enable the Scale Heights box if the height values

should be scaled also.

5. Tap the Calc button to achieve the result.
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2D Transform

The 2D Transform task recomputes the plane coordinates of a set of
points using the transformation parameters defined by pairs of points
known in two systems. On the 2D Transform screen (Figure 10-25),
do the following:

¢ e &

* From Pt 1 E
adiust 2DETr S——— 101 6179436, 409376....
< >
Delete Edit Add

Figure 10-25. 2D Transform

1. Press the Add button to enter pairs of points / plane positions.
for obtaining transformation parameters. The Point Pair Info
screen displays.

oint Pair Info

|& | From et Jio1

& Tapt [0z
=4

Figure 10-26. Point Pair

2. After all necessary pairs are defined, tap Next.
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3. Check the transformation parameters, select points to
transform, either by a range of points, or points from the map/
list, or all points on a layer selected.

4. Tap Calc to perform the two dimensional transformation of
these points (Figure 10-27).

3 &
Transformation YWalue
Qrigin Position
Morth 56179436.478
East 409376,527
Offset
Morth -223.020
East -4.650
Scale Factor 1.000000000
Raotation 0°00'00.00000"

Select Paints

0 Points Selected

Figure 10-27. 2D Transform Parameters

Traverse Adjustment

Traverse adjustment is performed to provide a mathematically closed
figure and at the same time to get the best estimates for positions of
all the traverse stations.

1. On the first Adjustment screen (Figure 10-28), select initial
data for traverse adjustment: the stations on which the traverse
originates and closes, whether to adjust elevations and sideshots
or not, an Earth curvature value, and a job to store adjusted
traverse stations. Then tap the Next button. The second
Adjustment screen displays (Figure 10-29 on page 10-25).
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-

Adijust Traverse
End Point  ET1
Adijust Elevations
Adjust Sideshots
Curyature refraction 0.14 v

Job to store the results
M Iard\TPS\TDpSURV\JDbs\dj.tsj

Figure 10-28. Traverse Adjustment

2. On the next Adjustment screen (Figure 10-29 on page 10-25),
select the method of traverse adjustment to apply (check and
enable either Apply Compass Rule or Apply Angle Balance),
and a technique to close the traverse if it is unclosed.

Apply Angle Balance

Figure 10-29. Adjustment

3. Press the Adjust button to adjust the traverse. The Adjustment
Results screen opens to display the results.

The traverse points adjusted will be saved in the new job as
calculated points.
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Traverse Calculation

This Traverse function is used to calculate Traverse and Sideshot
points, based on horizontal and vertical Offsets, along a direction
defined by an azimuth, or right, left or deflection angles.

On the Traverse Calc screen (Figure 10-30 on page 10-26), select the
initial data for the traverse task and the name and code for the
resulting point (To Point).

J\F ’ Traverse Calc | Results | Map

Traverse From Point  |FTE0E
& | admuth | [22se0000.
vertDst 0510 m

To Paoint IlDDD4

B o o vEHE
EN

l BS Point H Side Shot H Traverse l

Figure 10-30. Traverse Calc

The initial data includes the starting point, the azimuth to the
calculated point, and the horizontal and vertical distance to it. The
azimuth can be entered as is, or it can be computed from the right or
left angles, or deflection entered in this field.

1. Enter Backsight information input with the help of the BS
Point button.

2. To calculate the result point (To Point) without changing the
From Point, tap the SideShot button. The 7o Point is
incremented to the next new point in the database.

3. To calculate the result point (To Point), tap the Traverse button
to change the From Point to the To Point. The To Point changes
to the next new name in the database.
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DTM Volume

This COGO task calculates cut/fill data when computing between two
surfaces.

1. Onthe DTM Volume screen, select two DTM files and tap Cale
(Figure 10-31).

7=

ﬁ —

DTM Yolurnes & DIML lder—
@ ome o (@]

Wazim Moi1om
N N

Figure 10-31. DTM Volume

2. Select the Result tab to view the volume data between the
surfaces. To save the report to a file, tap the To File button.

Cut 0.000 m*~

Fill 19241.01

Area 4686.580
< 4

Figure 10-32. Calculate DTM Volume
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Notes:
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Appendix A

mmGPS Operations

In the event that a point is lost, the resection operation can measure an
unknown point, based on the measurements of three or more
surrounding points. The self-levelling mechanism may also need to be
measured and the transmitter calibrated to ensure correct grade.

The following operations require that the transmitter and sensor have
already been setup, as seen in “Initializing mmGPS+" on page 8-16

Resection

The resection function measures an unknown transmitter location
using the rover and three or more points.

When performing a resection, use the following guidelines to ensure
accurate measurements of the Rover points:

» Take measurements at 3 or more points around the Base
transmitter in a balanced, symmetrical pattern (not clustered in
one area).

* Have the sensor facing towards the transmitter during each
measurement.

* Angle the sensor between 6° higher or lower than the
transmitter’s beam, not straight on.

1. With the controller and sensor connected, tap Setup » Init
mmGPS. The Init mmGPS+ screen displays (Figure A-1 on
page A-2).
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2. Tap the Position tab, select a transmitter, then tap the Resect
button (Figure A-1 on page A-2). The Resect screen displays
(Figure A-2 on page A-2).

/ﬁ\ = _
P 3 r Pos | Sensor
Setup mmGaPs Init
Name |ID | Point
12 1 DRAN
2
3
4
< >
lResectl l Edit l lDeIetel

Figure A-1. Select Transmitter

3. Tap the Sensor tab, then tap the Init Sensor button
(Figure A-2).

EResect mmGP5+ ! b 4
Sensor | Resect | Data

Receiver Port ID -
Transmitter ID |1
Sensor Gain ] v

[ ]known Trans Horz Pos

Firmware Version NfA

Figure A-2. Initialize Sensor

4. 1If Known Trans Horz Pos was enabled, the Known Point screen
displays (Figure A-3 on page A-3). Select the point over which
the transmitter was setup using the map or list icons and tap the

ok [/ ] button.
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Point [TR

Map Icon t— LiSt Icon

Transmitter

Name 21
D 1
Ht 1303 m  [slant v

[]2m Fixed Tripod

Figure A-3. Transmitter Over Known Point
When the sensor is successfully initialized, TopSURYV displays
the setup successful screen. Tap Close to continue.
5. Tap the Resect tab (Figure A-4).
* If using an unknown point, tap Start.

* If using a known point, check and enable the Known Point
box and select a point to occupy by tapping the map or list
icons and enter the antenna’s height. Then tap Start.

EResect mmGP5+ -m
Sensor | Resect | pata

o Fied H o v g
10056 2201 3200 10+3

e

Meas 1

Known Point
[pRAS1

AntHt 2000 m  |Vertic v

Figure A-4. Use Unknown or Known Point
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‘When the sensor receives the transmitter’s beam, the mmGPS
icon displays (Figure A-4 on page A-3).
During the measurement, the Resect tab displays the number of
GPS epochs used in the resection calculation (Figure A-4 on
page A-3).
6. When the desired amount of time has passed, tap the Stop
button.
7. Move to the next point and repeat steps 4 and 5 for three or
more points.

8. Tap the Data tab to view the results (Figure A-5 on page A-4).

* Only after three or more points have been measured will data
display. The first two points will not display any data.

» Tap the Re-Meas button to clear all data and restart he
resection process (Figure A-5 on page A-4).

[ rosec moces EAED
Sensor | Resect | Data ]

.. |HRM... |VRM... |Lat

. 0539 0.012 37.4.

< 4

Figure A-5. Resection Data Results

9. If the resection values are acceptable, tap the Accept button
(Figure A-5) and view the point information for the transmitter
(Figure A-6) on the Add Point screen.

10. Tap the ok [./] button to save the transmitter’s point
information.

 Enter any other desired information (such as, codes or notes).
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« If the transmitter is over a control point, check and enable
Control Point box.

E ,dd Paint - m
Point | Layer/Style | Phato Mote

[®] Foint ITransmitter21

@Code |A—v
B @ B

MNote transmitter
Grid: SK1942-Zone_7 : ...(m)

Narth |E| 178520.589
East |4 15352.220
Ell ht |15?.993

[] control Point

Figure A-6. View Point Information

11. After the resection (Figure A-7), initialize the sensor. See
“Sensor Initialization” on page 8-18 for details.

|

The Sensor must be initialized.

Close

Figure A-7. Initialize Sensor after Resection

After performing a resection, check the results using the Known Point
Offset function. This function also provides an option to adjust the
transmitter’s height using the new offset.
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1.

On the Init mmGPS+ screen, tap the bitmap menu in the
upper-left corner of the screen and select Known Point Offset

(Figure A-8).

b

Field Calibration
Known Point Offset
Advanced Sensor Cptions  pta |
Help

3

4
| aga | [ et | | peete |

Figure A-8. Open Known Point Offset

2. Select the Rover’s known point using the map or list icons,
then tap Start (Figure A-9).

v Point
Transmitter Name 21 v
Point [RSCT-KWN-TS

Height Offset Il].l]l]l] m

Epoch Count

Figure A-9. Select Rover’s Point and Begin Averaging
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When the averaging completes, the screen displays the height
offset for the transmitter’s height (Figure A-10).

Transmitter Name |21

Point [RSCT-KWN-TS
E3lB]
Height Offset [0.06932 m

Epoch Count 1]

Figure A-10. Transmitter’s Height Offset Averaged

3. Tap the ok [./ ] button, then tap Yes at the Warning! screen to
adjust the transmitter height using the results (Figure A-11 on
page A-7). The offset will be automatically added to the
transmitter’s height.

gt |

Do you want to adjust the
Transmitter Height using this
value?

Figure A-11. Adjust Transmitter’s Height

4. When finished, initialize the sensor. See “Sensor Initialization”
on page 8-18 for details.
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Field Calibration

The field calibration function fixes incline error in the self-leveling
mechanism of the transmitter.

1.

At the transmitter, hold the plumb beam key, then tap and
release the power key to put the transmitter into calibration
mode.

With the rover, walk over 30 meters away from the transmitter
and face the sensor towards the transmitter.

Use a bi-pole to ensure the sensor remains steady
throughout the calibration process.

With the controller and sensor connected, tap Setup GPS » Init
mmGPS. The Init mmGPS+ screen displays (Figure A-12 on
page A-8).

On the Init mmGPS+ screen, tap the Help Icon menu in the
upper-left corner of the screen and select Field Calibration
(Figure A-12). The Calibration screen displays (Figure A-13).

b

Field Calibration
Known Point Offset
Advanced Sensor Cptions  pta |
Help

3

4
| aga | [ et | | peete |

Figure A-12. Open Field Calibration
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5. On the Calibration screen, select the transmitter that will be
calibrated from the Transmitter Name drop-down list and tap
Next (Figure A-13).

E Calibration

Set Transmitter to Field
Calibration mode.

Transmitter Name |030021

Figure A-13. Select Transmitter to Calibrate

6. Adjust the height of the sensor so the angle is less than 1°. Once
the Angle is OK, tap Next (Figure A-14 on page A-9).

E Calibration . 4

Adjust the height of the Adjust the height of the

Sensor if required. Sensor if required.

1 Move UP +~ Angle is OK
-2.3847 dms -0.0651 dms

Figure A-14. Check Angle of Sensor

If the sensor experiences excessive movement
@ during any stage of the calibration, an error
message will display. Tap Close.
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7. Tap Calibrate after the auto-levelling process completes
(Figure A-15).

E Calibration dy E Calibration

Face front of Transmitter Getting Data
towards Sensor and wait for
auto-leveling to complete.

-0.0702 dms

Calibrate I

Figure A-15. Begin Field Calibration

8. Turn the transmitter 180° so the back faces the transmitter. Tap
Calibrate (Figure A-16 on page A-10).

E Calibration . E Calibration

Reverse Transmitter so the Getting Data.....
back is facing the Sensor
and wait for auto-leveling to
complete.

-0.0702 dms

Calibrate I

Figure A-16. Turn Transmitter to Back and Collect Data
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9. Turn the transmitter 90° so the left side faces the transmitter.

Tap Calibrate (Figure A-17).
E Calibration .

Face the Left side of
Transmitter towards Sensor
and wait for auto-leveling to
complete.

Calibrate

E Calibration

Getting Data.....

-0.0702 dms

_—

Figure A-17. Turn Transmitter to Left and Collect Data

10. Turn the transmitter 180° so the right side faces the transmitter.
Tap Calibrate (Figure A-18 on page A-11).

Reverse Transmitter so the
Right side is facing the
Sensor and wait for auto-
leveling to complete.

Calibrate

E Calibration .

E Calibration

Getting Data.....

-0.0702 dms

_—

Figure A-18. Turn Transmitter to Right and Collect Data

When the calibration completes, the Update Calib Data screen
displays the offsets (Figure A-19 on page A-12).

If the offsets were outside the tolerance range, TopSURV will
indicate that the transmitter needs to be updated (Figure A-19 on

page A-12).
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11. Disconnect the controller and sensor. At the transmitter,
connect the controller and transmitter.

12. On the Update Calib Data screen, select the Com Port that
connects the controller and transmitter and tap the Update
Data button (Figure A-19 on page A-12).

EUpdate Calib Data .

X and Y offsets were beyond
tolerences. The Transmitter
needs to be updated.

Connect the Controller to
the Transmitter, then click
Update.

Com Port |COM1 v

X -0.0026 dms
Y 0.0018 dms

Update Data

Figure A-19. Field Calibration Results

TopSURYV uploads the calibration data to the transmitter and
automatically turns off the transmitter.

13. When finished, tap Close on the Message screen (Figure A-20).

B oo B po

X and Y offsets were beyond
tolerences. The Transmitter Transmitter Setup Successfully!
needs to be updated.

Connect the Controller to
the Transmitter, then click
Update.

Com Port g i
X -0.0026 d

Y 0.0018 dms

|Retrieving Calibration Data

| Update Data

Figure A-20. Uploading Calibration Data
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14. Initialize the sensor according to “Sensor Initialization” on
page 8-18.

After loading the new calibration data into the
$ . transmitter, re-calibrate to check the system. The
transmitter may need to be calibrated a couple of

times depending on site conditions.

mmGPS Options

When configured for mmGPS, an options menu selection provides
further functionality for applying height differences and selecting
whether or not to use mmGPS and weighted height computations.

1. On the Status screen (Setup » Status), tap the bitmap menu in
the upper-left corner of the screen, and select mmGPS+
Options (Figure A-21). The mmGPS+ Opts screen displays.

Rover Antenna Setup

Reset RTEK
mmGPS+ Options 22:53:50
.~ hnomous

Clear NWRAM
()

Help

East 409404.144
Elht 186.673

4% poor 1.8

H 2.201 Y 3.200 m
Ease Dist

Figure A-21. mmGPS+ Options

2. On the mmGPS+ Opts screen (Figure A-22 on page A-14),
select the following options:

e Select Turn mmGPS+ ON or OFF.
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o Use weighted height computations — check and enable to use

weighted height computations

* Height Difference Limit — enter a value here between the GPS

result and the mmGPS result (Figure A-22).

E mmGPS+ Opts

mmiaP5+ is DISABLED

|Turn mmGPS+ OM

Height Difference Limit

ID.SDD m

Figure A-22. Select mmGPS+ Options

If the difference between the measured GPS height and the
mmGPS height is greater than the entered value, the mmGPS icon
changes (Figure A-23).

A-14

Pos | Sys |PIDts|SVs

&, 13 &, 13 urc 1333114

Fixed
WGS84(m)
Lat 37 : 39: 29.71390 N
Lon 121: 49: 21.14703 W
Ell ht 116.101 =

<% ppop 1.8

H 0.011 ¥ 0.005 m
Base Dist 47.986 m

Figure A-23. mmGPS Icon with Height Difference Limit
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